Contents

Chapter 1  Setting Up Training Manager ........................................1
  About setting up Training Manager ........................................1
  Setting up Training Manager .............................................1
    System requirements for Training Manager for Windows .......... 2
    Setting up Training Manager for Windows ......................... 3
  Uninstalling Training Manager .....................................4
    About uninstalling Training Manager for Windows ............... 4
    Uninstalling Training Manager for Windows ..................... 4
    Checking your system for UCF Compatibility .................... 5

Chapter 2  Understanding the Session Window .............................7
  A quick tour of the Session window .................................7
    Your first look at the Session window ..............................8
  Tools for sharing ................................................................10
    Annotation tools ..........................................................11
    View tools ......................................................................11
  Working with the panels .................................................12
    Panels overview ............................................................12
    Minimizing and restoring panels ....................................13
    Expanding and collapsing panels ...................................15
    Opening and closing panels ..........................................15
    Resetting the panels .....................................................16
Accessing panel options .............................................. 16
Resizing the content viewer and panels areas ..................... 18
Accessing panels in full-screen view ................................. 18
Overview of floating icon tray ....................................... 19
Displaying a panel while in full-screen view ....................... 19
Displaying all panels while in full-screen view .................... 20
Organizing the floating panels ....................................... 20
Sharing documents or software while in full-screen view ....... 21
Understanding panel alerts .......................................... 24
Overview of panel alerts ............................................ 24
Alerts for minimized panels ......................................... 24
Alerts for collapsed panels .......................................... 24

Chapter 3 Assigning Privileges during a Training Session .......... 25
About granting privileges to attendees ............................. 25
Granting attendee privileges during a training session ............ 26
About the Assign Privileges dialog box ............................ 27

Chapter 4 Specifying Sound Preferences for Training Manager .... 29
About specifying sound preferences ................................. 29
Assigning sound alerts to chat messages ........................... 30
Assigning sound alerts to participant actions ....................... 31

Chapter 5 Managing an Integrated Teleconference ................. 33
About managing an integrated teleconference .................... 33
Starting an teleconference during a training session ............. 34
Inviting a participant to join a teleconference ..................... 34
Muting and unmuting participants’ microphones in a teleconference ............... 35

About muting and unmuting participants' microphones in a teleconference .. 36

Muting attendees’ microphones automatically when they join a training session ................................................................. 36

Muting and unmuting a specific participant’s microphone ....................... 37

Muting and unmuting all attendees' microphones simultaneously ............. 38

Chapter 6 Managing an Integrated VoIP Conference ........................... 39

About managing an Integrated VoIP conference ................................................. 39

Setting Integrated VoIP options ............................................................... 40

Starting an Integrated VoIP conference ...................................................... 40

Allowing a participant to speak in an Integrated VoIP conference ............. 42

Understanding the speaker queue for Integrated VoIP ............................ 42

Muting and unmuting a participant’s microphone in an Integrated VoIP conference ......................................................... 43

Ending an Integrated VoIP conference ....................................................... 44

Chapter 7 Participating in a Teleconference ........................................... 45

About participating in a teleconference ...................................................... 45

Joining a teleconference ................................................................. 46

Muting and unmuting your microphone in a teleconference ....................... 47

Asking to speak in a teleconference ....................................................... 48

Determining who is speaking in a teleconference ..................................... 48

Leaving a teleconference ................................................................. 49

Chapter 8 Participating in an Integrated VoIP Conference ....................... 51

About participating in an Integrated VoIP conference .............................. 52
Closing shared documents and presentations ................................. 69
Sharing a whiteboard ........................................................................ 70
About sharing a whiteboard ................................................................. 70
Starting whiteboard sharing ................................................................. 70
Closing a shared whiteboard ............................................................... 71
Navigating presentations, documents, or whiteboards ......................... 71
About navigating shared presentations, documents, or whiteboards .. 71
Navigating slides, pages, or whiteboards using the toolbar .................... 72
Advancing pages or slides automatically ........................................... 73
Performing animations and slide transitions in shared slides ............... 74
Using keyboard shortcuts to control a presentation ............................ 75
Working with pages or slides .............................................................. 76
About working with pages or slides .................................................. 76
Adding new pages or slides ............................................................... 76
Pasting images in slides, pages, or whiteboards .................................. 76
Controlling views of presentations, documents, or whiteboards ............ 77
About controlling views of shared presentations, documents, or whiteboards .......................................................... 77
Magnifying or reducing the view of slides, pages, or whiteboards .......... 78
Controlling full-screen view of slides, pages, or whiteboards ................. 79
Viewing miniatures of slides, pages, or whiteboards ............................. 79
Synchronizing attendees' views of slides, pages, or whiteboards ............ 81
Annotating presentations, documents, or whiteboards ......................... 81
About annotating shared presentations, documents, or whiteboards ....... 82
Drawing annotations on slides, pages, or whiteboards .......................... 82
Typing annotations on slides, pages, or whiteboards ......................... 83
Selecting a color for annotating slides, pages, or whiteboards .............. 83
Making annotations visible on different backgrounds in the content viewer 84
Selecting a font for annotating slides, pages, or whiteboards ................ 84
Clearing annotations on slides, pages, or whiteboards .......................... 84
Undoing and redoing changes in the content viewer ............................. 85
Using pointers on presentations, documents, or whiteboards .................. 86
About using pointers on shared presentations, documents, or whiteboards 86
Using an arrow pointer on slides, pages, or whiteboards ....................... 86
Using a laser pointer on slides, pages, or whiteboards ......................... 87
Clearing pointers on slides, pages, or whiteboards ............................... 87
Renaming and reordering tabs for shared documents, presentations, or whiteboards ......................................................... 88
Renaming the tab for a presentation, document, or whiteboard ............... 88
Reordering the tabs for documents, presentations, and whiteboards ......... 89
Saving, opening, and printing presentations, documents, or whiteboards .. 89
Saving a presentation, document, or whiteboard ................................. 90
Opening a saved document, presentation, or whiteboard ..................... 90
Printing presentations, documents, or whiteboards ............................. 91

Chapter 10 Sharing UCF multimedia ................................................. 93
About sharing UCF multimedia ....................................................... 93
How UCF multimedia sharing works .............................................. 94
System requirements for UCF multimedia ....................................... 95
Supported UCF media file formats .................................................. 96
Sharing UCF multimedia presentations .......................................... 97
Chapter 11   Sharing Software .................................................. 119

About sharing software .................................................. 119
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharing applications</td>
<td>120</td>
</tr>
<tr>
<td>About sharing applications</td>
<td>120</td>
</tr>
<tr>
<td>Starting application sharing</td>
<td>121</td>
</tr>
<tr>
<td>Sharing multiple applications</td>
<td>122</td>
</tr>
<tr>
<td>Stopping application sharing</td>
<td>123</td>
</tr>
<tr>
<td>Sharing your desktop</td>
<td>125</td>
</tr>
<tr>
<td>About sharing your desktop</td>
<td>125</td>
</tr>
<tr>
<td>Starting desktop sharing</td>
<td>125</td>
</tr>
<tr>
<td>Stopping desktop sharing</td>
<td>126</td>
</tr>
<tr>
<td>Sharing a Web browser</td>
<td>126</td>
</tr>
<tr>
<td>About sharing a Web browser</td>
<td>127</td>
</tr>
<tr>
<td>Starting Web browser sharing</td>
<td>127</td>
</tr>
<tr>
<td>Stopping Web browser sharing</td>
<td>127</td>
</tr>
<tr>
<td>Sharing a remote computer</td>
<td>128</td>
</tr>
<tr>
<td>About sharing a remote computer</td>
<td>128</td>
</tr>
<tr>
<td>Starting remote computer sharing</td>
<td>129</td>
</tr>
<tr>
<td>Sharing additional applications on a shared remote computer</td>
<td>130</td>
</tr>
<tr>
<td>Stopping remote computer sharing</td>
<td>131</td>
</tr>
<tr>
<td>Managing a shared remote computer</td>
<td>132</td>
</tr>
<tr>
<td>Controlling views of shared software</td>
<td>136</td>
</tr>
<tr>
<td>About controlling views of shared software</td>
<td>136</td>
</tr>
<tr>
<td>Pausing and resuming software sharing</td>
<td>136</td>
</tr>
<tr>
<td>Controlling full-screen view of shared software</td>
<td>138</td>
</tr>
<tr>
<td>Synchronizing attendees’ views of shared software</td>
<td>139</td>
</tr>
<tr>
<td>Helping attendees to control their views of shared software</td>
<td>139</td>
</tr>
</tbody>
</table>
Returning to the Session window while sharing software ......................... 140
Returning attendees to the software sharing window ......................... 141
Annotating Shared Software ..................................................... 141
About annotating shared software ............................................. 142
Annotating shared software ..................................................... 142
Using annotation tools ......................................................... 143
Clearing annotations and pointers on shared software ..................... 144
Selecting a color for annotating shared software ......................... 145
Letting an attendee annotate shared software ............................... 145
Stopping an attendee from annotating shared software .................. 146
Taking a screen capture of annotations on shared software ............. 147
Stopping annotation mode .................................................... 147
Allowing remote control of shared software ................................ 147
About letting an attendee remotely control shared software ............ 148
Letting an attendee remotely control shared software .................... 148
Automatically letting attendees remotely control shared software ........ 149
Stopping remote control of shared software ................................ 149
Specifying the display mode for shared software ............................ 150
Sharing applications with detailed color ..................................... 151
Tips for Sharing Software ..................................................... 152

Chapter 12  Sharing Web Content .............................................. 155
About sharing Web content ..................................................... 155
Sharing Web content ............................................................ 156
Differences between sharing Web content and sharing a Web browser 156
Chapter 13 Transferring Files During a Training Session ......................... 159
  About transferring files during a training session ............................ 159
  Publishing files during a training session ..................................... 159

Chapter 14 Polling Attendees ......................................................... 161
  About polling attendees .......................................................... 161
  Preparing a poll questionnaire ................................................. 162
    About preparing a poll questionnaire ..................................... 162
    Composing poll questions and answers .................................. 162
    Editing a questionnaire ...................................................... 164
    Displaying a timer during polling ....................................... 165
  Opening a poll ................................................................. 166
  Viewing and sharing poll results ............................................. 166
    Viewing poll results ......................................................... 167
    Sharing poll results with attendees .................................... 167
  Saving and opening poll questionnaires and results ....................... 168
    Saving a poll questionnaire ............................................... 168
    Saving poll results .......................................................... 169
    Opening a poll questionnaire file ....................................... 170
    Opening a poll results file ............................................... 170

Chapter 15 Managing Question-and-Answer Sessions ............................ 173
  About question-and-answer sessions ....................................... 173
  Allowing participants to use Q & A .......................................... 174
  Setting privacy views in Q & A sessions ................................... 175
  Managing questions on your Q & A panel .................................. 176
Working with the tabs on your Q & A panel ........................................ 177
  About the Q & A tabs ................................................................. 177
  Opening a tab ................................................................. 178
  Closing a tab ................................................................. 178
  Assigning a question ............................................................. 179

Answering questions in a Q & A session ........................................ 180
  About answering questions in a Q & A session ............................. 180
  Providing an answer to a question .......................................... 180
  Dismissing a question ........................................................... 182
  Deferring a question ............................................................. 183

Archiving Q & A sessions ................................................................. 184
  About archiving a Q & A session ............................................. 185
  Saving a Q & A session ........................................................... 185
  Saving changes to a saved Q & A session ................................. 186
  Saving a copy of a previously saved Q & A session .................... 186

  Opening a Q & A file .............................................................. 186

Chapter 16   Managing Chat ................................................................. 187
  About managing chat ............................................................ 187
  Granting chat privileges .......................................................... 188
  Overview of chat privileges .................................................... 188

Chapter 17   Using Feedback ................................................................. 191
  About using feedback ............................................................ 191
  Allowing participants to provide feedback .................................. 192
  Viewing a running tally of responses ........................................ 193
Providing feedback ................................................................. 193
Using emoticons in feedback .................................................. 194
Removing feedback ............................................................... 195

Chapter 18 Using Breakout Sessions ........................................ 197

About Breakout sessions ....................................................... 197
Using the Breakout Session window ........................................ 198
  Breakout Session window overview ...................................... 198
  Breakout Session panel overview ........................................ 199
  Breakout Session menus .................................................... 199
Controlling breakout sessions .............................................. 202
  About controlling breakout sessions ................................. 203
  Granting breakout session privileges .................................. 203
  Allowing breakout sessions .............................................. 204
  Creating a breakout session for another participant ............. 206
  Asking all participants to return from a breakout session ...... 207
  Ending all breakout sessions ............................................ 207
  Requesting a breakout session presenter to share content .... 207
  Removing a participant from a breakout session ................. 208
Presenting breakout sessions .............................................. 209
  About presenting a breakout session ............................... 209
  Creating a breakout session .......................................... 210
  Starting a breakout session that was created for you ...... 212
  Joining a breakout session ............................................ 212
  Leaving a breakout session ........................................... 212
  Using Integrated VoIP or teleconferencing in breakout sessions .... 212
Letting more participants join the breakout session ......................... 215
Preventing more participants from joining a breakout session .......... 216
Specifying a number of participants who can join a breakout session in progress ................................................................. 216
Passing the presenter role to another participant ....................... 217
Presenting information in a breakout session ................................. 217
Granting remote control to a participant in a breakout session ........ 218
Ending your breakout session ...................................................... 218
Sharing content from your breakout session in the main session .... 219

Chapter 19 Sending Video ................................................................. 221
About sending live video ............................................................... 221
Setting up video ...................................................................... 221
Sending live video .................................................................... 222
Specifying video camera options ............................................... 223
Securing your privacy in a training session with live video ........... 224

Chapter 20 Information Resources .................................................. 227
Obtaining more information and assistance .................................. 227
Accessing the Support page ....................................................... 228
Attending WebEx training .......................................................... 229
Providing feedback about WebEx documentation ......................... 229

Glossary ...................................................................................... 231

Index .......................................................................................... 243
### About setting up Training Manager

To participate in a training session, you must set up Training Manager software on your computer. Once you schedule, start, or join a training session for the first time, your training session service Web site starts the setup process. However, to save time, you can set up Training Manager at any time before scheduling, starting, or joining a training session.

### Setting up Training Manager

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of setting up Training Manager</td>
<td>About setting up Training Manager on page 1</td>
</tr>
<tr>
<td>set up Training Manager for Windows</td>
<td>Setting up Training Manager for Windows on page 3</td>
</tr>
<tr>
<td>remove Training Manager from your computer</td>
<td>Uninstalling Training Manager on page 4</td>
</tr>
<tr>
<td>make sure your system can handle Universal</td>
<td>Checking your system for UCF Compatibility on page 5</td>
</tr>
<tr>
<td>Communications Format (UCF) media files</td>
<td></td>
</tr>
</tbody>
</table>

### Setting up Training Manager for Windows

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of system requirements</td>
<td>System requirements for Training Manager for Windows on page 2</td>
</tr>
<tr>
<td>set up Training Manager for Windows</td>
<td>Setting up Training Manager for Windows on page 3</td>
</tr>
<tr>
<td>check your system for UCF compatibility</td>
<td>Checking your system for UCF Compatibility on page 5</td>
</tr>
</tbody>
</table>
System requirements for Training Manager for Windows

Review the minimum system requirements for installing Training Manager for Windows:

- Microsoft Windows ME (Millennium Edition), XP, NT, or 2000
- Intel or AMD Processor 400 MHz
- 128 MB RAM (256 MB recommended)
- Microsoft Internet Explorer 6 or later, Mozilla 1.6 or later, Firefox 1.x, or Netscape 7.x or later
- JavaScript and cookies enabled in the browser
- 56K or faster Internet connection

Important: If you want to share a presentation that was created using Microsoft PowerPoint 2002 for Windows XP, an Intel Celeron or Pentium 500 MHz or faster processor is highly recommended.

In most cases, your Web browser is set up properly for Training Manager. However, if you are unsure whether your Web browser’s settings are correctly configured, or you encounter problems when setting up Training Manager, you can set up your Web browser according to the following instructions.

To set up Internet Explorer 6.x:
1. On the Tools menu, choose Internet Options.
   The Internet Options dialog box appears.
2. Click the Security tab.
3. Ensure that the Internet zone is selected.
4. Click Custom Level.
   The Security Settings dialog box appears.
5. In the Reset to drop-down list, ensure that Medium is selected.
   If Medium is not already selected, select it, and then click Reset.
6. Click OK to return to the Security tab.
7. Click OK to close the Internet Options dialog box.

To set up Netscape Navigator 7.x:
1. On the Edit menu, choose Preferences.
2. Click Advanced.
   The Advanced dialog box appears
3. Ensure that the following options are selected:
Setting up Training Manager for Windows

Before installing Training Manager, ensure that your computer meets the minimum system requirements. For details, see System requirements for Training Manager for Windows on page 2.

If you are not using the Windows operating system, please refer to our FAQ, which includes information about setting up Training Manager on other operating systems.

To go to the list of FAQs:

1. On your Training Center Web site, on the left navigation bar, click Assistance > Support.
2. On the Support page, scroll down to the Documentation section and click FAQ (Frequently Asked Questions).
   A list of questions displays, arranged by topic. Look for your information about your operating system under Minimum System Requirements.

To set up Training Manager for Windows:

1. On the navigation bar, expand Set Up, and then click Training Manager.
   The Set Up page appears.
2. Click Set Up.
3. If a security dialog box appears, do one of the following:
   - If you are installing Training Manager on Microsoft Internet Explorer, click Yes.
   - If you are installing Training Manager on Netscape Navigator, click Grant.
   Setup continues. A progress message box appears, indicating the progress of setup.
4. On the Setup Complete page, click OK.
   You can now start, schedule, or join a training session.

Note

- Alternatively, you can download the Training Manager for Windows Installer from the Support page on your Training Center Web site, and then install Training Manager on your Web browser. This option is useful if your system...
Chapter 1: Setting Up Training Manager

does not allow you to install Training Manager directly from the Set Up page.

■ If you or another attendee plans to share Universal Communications Format (UCF) media files during a training session, you can verify that the required components are installed on your system to play the media files. For details, see Checking your system for UCF Compatibility on page 5.

Uninstalling Training Manager

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of removing Training Manager from your computer</td>
<td>About uninstalling Training Manager for Windows on page 4</td>
</tr>
<tr>
<td>remove Training Manager for Windows</td>
<td>Uninstalling Training Manager for Windows on page 4</td>
</tr>
</tbody>
</table>

About uninstalling Training Manager for Windows

You can easily uninstall or remove Training Manager for Windows on your computer.

Uninstalling Training Manager for Windows

1. Do one of the following:
   ■ For Windows 98, 2000, ME, or NT: On your computer's desktop, double-click **My Computer**, and then open the **Control Panel** folder.
   ■ For Windows XP: Click **Start**, and then click **Control Panel**.

2. Double-click **Add/Remove Programs** or **Add or Remove Programs**, depending on your computer's operating system.
   A dialog box appears, showing a list of programs installed on your computer.

3. In the list, select **WebEx**.

4. Click **Add/Remove** or **Change/Remove**, depending on your computer's operating system.
   A message appears, asking you to confirm that you want to remove the software.

5. Click **Yes**.
   The Uninstall WebEx Software dialog box appears.

6. Select **Training Manager**.

7. Click **Uninstall**.

8. Once the software is removed, click **Finish**.
Select an option to restart your computer now or later.

**Checking your system for UCF Compatibility**

If you intend to play or view Universal Communications Format (UCF) media files during the training session, either as a presenter or an attendee, you can verify that the following components are installed on your computer:

- Flash Player, for playing a Flash movie or interactive Flash files
- Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a UCF multimedia presentation or standalone UCF media files.

**To check your system for UCF compatibility:**

1. On the navigation bar, do one of the following:
   - If you are a new training session service user, click **New User?**.
   - If you are already a training session service user, expand **Set Up**, the click **Training Manager**.

2. Click **Verify your rich media players**.

3. Click the links to verify that the required players are installed on your computer.

---

**Note** The option to check your system for required rich media players is available only if your Training Center Web site includes the UCF option.

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Platform</strong></td>
<td>Windows&lt;br&gt;Pentium processor running Windows 2000 or XP</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>128 MB RAM</td>
</tr>
<tr>
<td><strong>Disk space</strong></td>
<td>20 MB free hard drive space (40MB of temporary space for the installation)</td>
</tr>
<tr>
<td><strong>Browser</strong></td>
<td>Internet Explorer 6.0 or later</td>
</tr>
<tr>
<td><strong>Internet Connection</strong></td>
<td>Internet connection that allows full Internet usage (not just a free email service)&lt;br&gt;Minimum requirement: Dial-up 56 kbps&lt;br&gt;Recommended: Broadband connection</td>
</tr>
<tr>
<td><strong>Email program</strong></td>
<td>Microsoft Outlook 2000 SP4 or later&lt;br&gt;Microsoft Outlook Express&lt;br&gt;Using Outlook, you can import email addresses and training session information into Training Center automatically</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Full duplex sound card and a headset</td>
</tr>
</tbody>
</table>
### Component Requirement

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video</strong></td>
<td>At least 1.8 GHz CPU, 800x600 resolution, 256 colors or more, and a Webcam</td>
</tr>
</tbody>
</table>
Understanding the Session Window

The Session window displays the content viewer on the left side, where you share documents, applications, desktops, and other items with attendees. The right side of the Session window contains panels, which you can display or hide as you need them.

This chapter gives you a quick overview of the Session window and the elements that compose it.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about the Session window and the tools for sharing information</td>
<td>A quick tour of the Session window on page 7</td>
</tr>
<tr>
<td>learn how to manipulate the panels</td>
<td>Working with the panels on page 12</td>
</tr>
<tr>
<td>access panels while you are in full-screen view</td>
<td>Accessing panels in full-screen view on page 18</td>
</tr>
<tr>
<td>learn about alerts for panels you have minimized or collapsed</td>
<td>Understanding panel alerts on page 24</td>
</tr>
</tbody>
</table>

A quick tour of the Session window

The Session window provides the online environment where training session participants interact.

In the Session window, you can share documents, presentations, desktops, and Web content, send chat messages, coordinate polls, and perform other training session management tasks.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of the Session window</td>
<td>Your first look at the Session window on page 8</td>
</tr>
</tbody>
</table>
Your first look at the Session window

The following figure shows the basic components of the Session window:

- Sharing icons in the upper left corner provide easy access to the presentations, documents, applications, desktops, or whiteboards that you want to share.

- Documents and whiteboards you have opened appear as viewer tabs at the top of the Session window. To rename or change the order of these tabs, see Renaming and reordering tabs for shared documents, presentations, or whiteboards on page 88.

- You manipulate panels using a mouse click to open, close, and minimize them.

---

### Menu bar

The following table describes what you can do with each menu.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about the tools available in the content viewer</td>
<td>Tools for sharing on page 10</td>
</tr>
<tr>
<td>learn about the annotation tools</td>
<td>Annotation tools on page 11</td>
</tr>
<tr>
<td>learn about the view tools</td>
<td>View tools on page 11</td>
</tr>
</tbody>
</table>
Chapter 2: Understanding the Session Window

Content viewer

The content viewer displays one or more documents, presentations, applications, and whiteboards that you share during a training session. Tabs at the top of the viewer allow you to switch among multiple shared documents, presentations, and whiteboards.

Sharing icons

You can open a document, whiteboard, desktop, or application to share using the sharing icons in the upper left corner:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Provides commands for saving, opening, printing, or transferring files during a training session; and ending or leaving a training session.</td>
</tr>
<tr>
<td>Edit</td>
<td>Provides commands for editing shared content in the content viewer.</td>
</tr>
<tr>
<td>Share</td>
<td>Provides commands for sharing documents, presentations, applications, Web browsers, desktops, multimedia Web content, and whiteboards.</td>
</tr>
<tr>
<td>View</td>
<td>Provides commands for displaying information in the content viewer on a host’s, presenter’s, or attendee’s screen.</td>
</tr>
<tr>
<td>Communicate</td>
<td>Provides commands for setting up a voice conference.</td>
</tr>
<tr>
<td>Participant</td>
<td>Provides commands pertaining to participants, such as inviting a participant to a training session, assigning roles and privileges, controlling participants’ audio, and so on.</td>
</tr>
<tr>
<td>Session</td>
<td>Provides commands pertaining to the training session, such as viewing training session information, restricting access to the training session, and recording the training session.</td>
</tr>
<tr>
<td>Breakout</td>
<td>Provides commands pertaining to breakout sessions, such as starting a breakout session and controlling breakout sessions.</td>
</tr>
<tr>
<td>Help</td>
<td>Provides information about the Training Center service.</td>
</tr>
</tbody>
</table>
Tools for sharing

As you start sharing documents and applications during your training session, tools are available at your fingertips.

In the following figure, the host has opened several presentations to share with training session participants.

You have access to:

- Annotation tools for highlighting and referring to elements in the presentation or application you are sharing
- View tools for displaying document and presentations in different ways, such as showing thumbnails of the pages
- Previous Page and Next Page buttons, for moving around in a document
### Annotation tools

The following figure and table describe what you can do with the annotation tools.

![Annotation tools diagram]

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pointer</strong></td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Lets you type text on shared content. Attendees can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the <strong>Edit</strong> menu, choose <strong>Font</strong>. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td><strong>Rectangle</strong></td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td><strong>Highlighter</strong></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td><strong>Annotation Color</strong></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td><strong>Eraser</strong></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

### View tools

The following figure and table describe what you can do with the view tools.
Chapter 2: Understanding the Session Window

Panels overview

The panels on the right side of the Session window are very flexible. You can open, expand, or close them quickly and easily. You can also minimize all the open panels to icons, providing greater space for sharing documents, applications, and other items with training session participants.
Chapter 2: Understanding the Session Window

Your service selects which panels display initially.

Minimizing and restoring panels

Minimizing and restoring panels has no effect on other participants’ displays.

Note

- If you minimize all open panels using the **Minimize all** command on the **Select Panel** menu, those panels are also minimized for the other participants.

- If you use the **Restore Panels** command after you have minimized panels using the **Minimize all** command, those panels also display for the other participants.

**To minimize a panel:**

Click the **Minimize** icon on the title bar of the panel you want to minimize.
Chapter 2: Understanding the Session Window

The panel no longer displays. It appears as an icon on the icon tray at the top of the panels.

To restore a minimized panel:
Click its icon on the icon tray.

To minimize all panels:
1. On the icon tray, click Panels.

The Select Panel menu appears.

2. On the Select Panel menu, choose Minimize all.
The open panels shrink to icons on the icon tray.

To restore all minimized panels:
The Restore Panels command quickly restores all panels you have minimized using the Minimize all command.

1. In the icon tray, click Panels.

The Select Panel menu displays.

**Expanding and collapsing panels**

Expanding and collapsing panels has no effect on other participants’ displays.

**To collapse a panel:**

Click the icon in the upper left corner of a panel to collapse it. The panel collapses, leaving only the title bar visible.

-In this example, the Polling panel is collapsed.

**To expand a panel:**

If a panel is collapsed (you only can see its title bar), click the icon in the left corner of the title bar to expand it.

**Opening and closing panels**

You can hide a panel completely so it will not display as an icon on the icon tray. If you close a panel, that panel also closes for attendees. It remains closed for all attendees until you open the panel again.

**To close a panel:**

1. On the icon tray above the panels, click Panels. The Select Panel menu displays.
2 On the Select Panel menu, click to remove the check mark next to the panel you want to close.

The panel no longer displays, and it is unavailable as an icon on the icon tray.

If you close the last remaining panel, the large panel area on the right side of the screen disappears. You still can access the panels through the Select Panel menu by clicking the Panels button.

To open a panel:
1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, click to place a check mark next to any panel you want to open.

The panel you selected displays. This panel is now available for all participants.

Resetting the panels

You can return the panels to the display settings that were preset by your service.

1 On the icon tray above the panels, click Panels.

The Select Panel menu displays.

2 On the Select Panel menu, choose Reset to default.

The panels return to the display settings originally selected by your service. The size, order, and location of the panels are reset to their original settings.

Accessing panel options

You can access the options related to any panel by right-clicking its title bar to see a menu of commands. Each panel title bar includes common commands to control the panel, but the following panels have additional options.
Chapter 2: Understanding the Session Window

Right-clicking a participant’s name

You can control some of the actions of an attendee directly from the Participants list. Right-click a participant’s name to see a menu of commands related to the participant.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Options</th>
</tr>
</thead>
</table>
| Participants | **Sound Alerts**: Lets you choose a sound to play when a participant:  
- Joins a training session  
- Leaves a training session  
**Assign Privileges**: Available for only the training session host. Displays the Assign Privileges dialog box, from which you can set privileges for the attendees. |
| Chat | **Sound Alerts**: Lets you choose the kinds of chat messages for which you want a sound to play. Select a sound from the drop-down list or click **Browse** to find a sound in a different location on your computer.  
**Assign Privileges**: Available for only the training session host. Displays the Assign Privileges dialog box, from which you can set privileges for the attendees. |
| Video | **Single point video**: Lets you view one participant video image.  
**Multi-point video**: Lets you view up to four participant video images.  
**Video Options**: Lets you adjust the video frame rate, video resolution, and settings for your video capture device. |

**Right-clicking the participant’s name**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Role To</td>
<td>Select to change the participant’s role to Presenter, Panelist, Attendee, or Host. Options that are not available for a participant will not be selectable.</td>
</tr>
<tr>
<td>Pass Mic</td>
<td>Select to pass the microphone or enable a participant’s microphone during an Integrated VoIP session.</td>
</tr>
<tr>
<td>Chat</td>
<td>Select to open the Chat panel, which will have the participant’s name pre-populated in the Send to box.</td>
</tr>
</tbody>
</table>
Chapter 2: Understanding the Session Window

Resizing the content viewer and panels areas

You can control the size of the content viewer by making the panel area narrower or wider.

To change the size of the content viewer and panels:

Click the dividing line between the content viewer and the panels.

- Drag the line to the left to make the area devoted to the panels wider.
- Drag the line to the right to make the content viewer larger.

For details about hiding, minimizing, and closing the panels in full-screen view, see Accessing panels in full-screen view, next.

Accessing panels in full-screen view

| If you want to get an overview of how to access panels while you are in full-screen view | See Overview of floating icon tray on page 19 |
Chapter 2: Understanding the Session Window

Overview of floating icon tray

While you are viewing or remotely controlling a shared application, desktop, or Web browser, or viewing a shared remote computer, the presenter can switch between a standard window and full-screen view.

In full-screen view, you can access the panels from a floating icon tray located in the lower right corner of your screen.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>display a panel while you are in full-screen view</td>
<td>Displaying a panel while in full-screen view on page 19</td>
</tr>
<tr>
<td>display all the panels while you are in full-screen view</td>
<td>Displaying all panels while in full-screen view on page 20</td>
</tr>
<tr>
<td>organize the floating panels</td>
<td>Organizing the floating panels on page 20</td>
</tr>
<tr>
<td>share documents or software while you are in full-screen view</td>
<td>Sharing documents or software while in full-screen view on page 21</td>
</tr>
</tbody>
</table>

Displaying a panel while in full-screen view

While you are in full-screen view, you can display any panel from a floating icon tray located in the lower right corner of your screen.

**To display a panel while in full-screen view:**

Click its icon on the floating icon tray. For example, to display the Chat panel, click the Chat icon.

The panel “floats” on top of the shared document, presentation, Web browser, or other shared item. You can drag the panel to move it.
Displaying all panels while in full-screen view

You can have all panels float on top of the shared document, presentation, Web browser, or other shared item.

To display all panels while in full-screen view:
1. On the floating icon tray, click the Select Panel button. It is the last button on the floating icon tray.
2. On the Select Panel menu, choose Float All Panels. All panels display, even those you had minimized previously.

What you can do

Resize individual panels using the Resize Control in the bottom right corner of any floating panel.

Organizing the floating panels

As you open the panels to answer a question or chat with a participant, you may find that you need to arrange the panels.

To organize the floating panels:
1. On the floating icon tray, click the Select Panel button. It is the last button on the floating icon tray.
2. On the Select Panel menu, choose Open Right Panel. An empty panel appears on the right side of your screen. The icon tray now resides at the top of the right panel.

What you can do

- Drag any floating panels into this larger panel. Panels resize to fill the space.
Drag any panel out of the larger panel to “float” it.

Switch between full-screen view and standard view.

After you return to standard view, all panels (those that are floating and those that you have minimized) return to their preset locations in the right panel.

Sharing documents or software while in full-screen view

In full-screen view, you have access to sharing and viewing options from the Select Panel menu.

Sharing a document in full-screen view

To display a document:

1. On the floating icon tray, click the Select Panel button. It is the last button on the floating icon tray.

2. On the Select Panel menu, choose Share. You see the list of sharing commands.
Chapter 2: Understanding the Session Window

3 Select **Presentation or Document**.

   The Share Presentation or Document dialog box appears.

4 Select the file that you want to share and click **Open**.

**To resize attendees’ display to match your display:**

1 On the icon tray above the panels, click the **Select Panel** button.

   It is the last button on the floating icon tray.

2 On the **Select Panel** menu, choose **View > Synchronize Views**.

   All attendees’ displays now match your display.

---

**Sharing an application in full-screen view**

**To share an application:**

1 On the floating icon tray, click the **Select Panel** button.

   It is the last button on the floating icon tray.

2 On the **Select Panel** menu, choose **Share > Application**.
Chapter 2: Understanding the Session Window

The Application Share dialog box appears.

3. Select the application you want to share or click New Application to open an application not already running on your desktop.

4. Click Share.

To resize attendees’ display to match your display:

1. On the floating icon tray, click the Select Panel button.
   It is the last button on the floating icon tray.

   All attendees’ displays now match your display.

Sharing your desktop in full-screen view

In full-screen view, you can share your desktop if you have not already done so.

To share your desktop while you are in full-screen view:

1. On the floating icon tray, click the Select Panel button.
   It is the last button on the floating icon tray.

2. On the Select Panel menu, choose Share > Desktop.

To resize attendees’ display to match your display:

1. On the floating icon tray, click the Select Panel button.
   It is the last button on the floating icon tray.

   All attendees’ displays now match your display.
Understanding panel alerts

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of panel alerts</td>
<td>Overview of panel alerts on page 24</td>
</tr>
<tr>
<td>learn about alerts for collapsed panels</td>
<td>Alerts for collapsed panels on page 24</td>
</tr>
<tr>
<td>learn about alerts for minimized panels</td>
<td>Alerts for minimized panels on page 24</td>
</tr>
</tbody>
</table>

Overview of panel alerts

If you have minimized or collapsed the Chat, Q & A, or Participants panels, and any of those panels requires your attention, you see an alert on that panel.

Here are the reasons for seeing alerts:

- A **Raise Hand** indicator appears in your Participants list.
- An attendee sends a chat message.
- An attendee sends a question.

Alerts for minimized panels

If you have minimized a panel, the icon representing that panel blinks for a few seconds and changes color to alert you to a change.

![Chat icon change](image)

Alerts for collapsed panels

If you have collapsed a panel, the **Expand/Collapse** icon blinks for a few seconds and changes color to get your attention to a change.

![Q&A icon change](image)
Assigning Privileges during a Training Session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of privileges</td>
<td>About granting privileges to attendees on page 25</td>
</tr>
<tr>
<td>specify particular privileges for training session attendees</td>
<td>Granting attendee privileges during a training session on page 26</td>
</tr>
<tr>
<td>review specific details about each attendee privilege</td>
<td>About the Assign Privileges dialog box on page 27</td>
</tr>
</tbody>
</table>

About granting privileges to attendees

Once a training session starts, all attendees automatically receive privileges:

- If the host scheduled the training session and specified attendee privileges, attendees receive those privileges.
- If the host scheduled the training session but did not specify attendee privileges, attendees receive the default privileges.
- If the host started an instant training session, attendees receive the default privileges.

You can grant or remove privileges for the following training session activities:

- Document sharing, including privileges for saving, printing, and annotating shared content in the content viewer
- Viewing miniatures, or thumbnails, of pages, slides, or whiteboards in the content viewer
- Viewing any page, slide, or whiteboard in the content viewer, regardless of the
content that the presenter is viewing
- Controlling full-screen view of pages, slides, or whiteboards in the content viewer
- Viewing the participant list
- Chatting with participants
- Recording a training session
- Requesting remote control of shared applications, desktops, or Web browsers
- Contacting the operator for a teleconference privately, if your training service includes the private operator option

Granting attendee privileges during a training session

During a training session, the session host can grant privileges to or remove them from attendees at any time.

To specify attendee privileges during a training session:

1. In the Session window, do one of the following:
   - On the Participant menu, point to Assign Privileges.
   - On the Participants & Communications panel, right-click a participant’s name, and select Assign Privileges.

The Assign Privileges dialog box appears.
2 Specify attendee privileges:

- To grant a privilege to all attendees, select its check box.
- To grant all privileges to attendees, select the All attendee privileges check box.
- To remove a privilege from all attendees, clear its check box.

For a detailed description of the options in the Assign Privileges dialog box, see About the Assign Privileges dialog box on page 27.

3 Click OK.

About the Assign Privileges dialog box

For details about each privilege, review the table below. To access the attendee privileges page:

- On the Participant menu, point to Assign Privileges.
- On the Participants & Communications panel, right-click a participant’s name, and select Assign Privileges.

<table>
<thead>
<tr>
<th>Document</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Save:</td>
<td>Specifies that attendees can save any shared documents, presentations, or whiteboards that appear in the content viewer.</td>
</tr>
<tr>
<td>Print:</td>
<td>Specifies that attendees can print any shared documents, presentations, or whiteboards that appear in the content viewer.</td>
</tr>
<tr>
<td>Annotate:</td>
<td>Specifies that attendees can annotate any shared documents, presentations, or whiteboards that appear in the content viewer, using the toolbar that appears above the viewer. Also allows attendees to use pointers on shared documents, presentations, and whiteboards.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>View</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendee list:</td>
<td>Specifies that attendees can view the names of all other attendees on the Participants &amp; Communications panel. If this option is not selected, attendees can view the names of only the training session host and the presenter on the Participants &amp; Communications panel.</td>
</tr>
<tr>
<td>Thumbnails:</td>
<td>Specifies that attendees can display miniatures of any pages, slides, or whiteboards that appear in the content viewer. This privilege allows attendees to view miniatures at any time, regardless of the content that appears in the presenter’s content viewer. Note—If attendees have this privilege, they can display any page at full size in the content viewer, regardless of whether they also have the Any page privilege.</td>
</tr>
<tr>
<td>Any document:</td>
<td>Specifies that attendees can view any document, presentation, or whiteboard that appears in the content viewer, and navigate to any pages or slides in documents or presentations.</td>
</tr>
<tr>
<td>Any page:</td>
<td>Specifies that attendees can view any pages, slides, or whiteboards that appear in the content viewer. This privilege allows attendees to navigate independently through pages, slides, or whiteboards.</td>
</tr>
</tbody>
</table>
### Training session

- **Record the session:** Specifies that attendees can record all interactions during a training session and play them back at any time.

- **Share documents:** Specifies that all attendees can share documents, presentations, and whiteboards, and copy and paste any pages, slides, and whiteboards in the content viewer.

- **Control shared applications, Web browser, or desktop remotely:** Specifies that all attendees can request that the presenter grant them remote control of a shared application, Web browser, or desktop. If this privilege is cleared, the command to request remote control is unavailable to attendees.

### Communications

**Chat with:**

- **Host:** Specifies that attendees can chat with only the training session host. If an attendee sends a chat message to the host, it appears in only the host’s Chat viewer.

- **Presenter:** Specifies that attendees can chat with only the presenter. If an attendee sends a chat message to the presenter, it appears in only the presenter’s Chat viewer.

- **Panelist:** Specifies that attendees can chat privately with any panelist or all panelists.

- **All attendees:** Specifies that attendees can chat with *either* other attendees *at once*, not including the training session host and the presenter *or* all participants *at once*, including all attendees, the training session host, and the presenter.

### Breakout sessions with:

- **Host:** Specifies that all attendees can join breakout sessions with only the training session host. This privilege is set as a default.

- **Presenter:** Specifies that all attendees can join breakout sessions with only the presenter. This privilege is set as a default.

- **Panelists:** Specifies that attendees can join breakout sessions with any panelist or all panelists. This privilege is set as a default.

- **All attendees:** Specifies that all attendees can join breakout sessions with *either* other attendees, not including the training center host, the presenter, and panelists *or* all participants, including all attendees, the session host, the presenters, and the panelists.

### All attendee privileges

Specifies that attendees have all privileges.
## About specifying sound preferences

During a training session, you can specify sound alerts to play when:

- you receive chat messages
- participants take specific actions, such as joining or leaving the training session

Training Manager saves your sound preferences on your computer. However, if you start or join a training session on another computer, you must specify your preferences again.

---

### If you want to... | See...
---|---
get an overview of specifying sound preferences for Training Manager | About specifying sound preferences on page 29
assign sounds to incoming chat messages | Assigning sound alerts to chat messages on page 30
assign sounds to specific types of actions that participants take during a training session | Assigning sound alerts to participant actions on page 31
Assigning sound alerts to chat messages

You can assign a sound to play when you receive a chat message. Specifically, you choose to play a sound for one of the following occasions:

- if you are not viewing the Chat panel
- for only the first chat message that you receive in a thread
- whenever you receive a chat message

To assign sounds to incoming chat messages:

1. Do either of the following:
   - On the Chat panel, right-click the Chat title bar, and then choose Sound Alerts.
   - In the Session window, on the Edit menu, choose Personal Preferences. The Personal Preferences dialog box appears.

2. Click Communications under Category.

3. Select Receiving a chat message.

4. In the drop-down list, choose the occasion for which you want to assign a sound.

5. Select a sound to play. You can do either of the following:
   - Select a sound in the Play sound drop-down list.
     - This list contains the names of all sound files that reside at the default location on your computer.
   - Click Browse, and then select a sound file that resides in another folder.

6. Optional. To play the currently selected sound, click the button.

7. Click OK.

Note

- The default location on your computer for sound files is standard, and is based on your computer's operating system. On a computer running Windows, the default location is the Media folder.

- You can copy other sound files of the appropriate types to the default location, or any other directory, to make them available in the Personal Preferences dialog box.

- On a computer running Windows, you can play any .wav file.
Assigning sound alerts to participant actions

During a training session, you can assign sounds to play when a participant:

- joins the training session
- leaves the training session
- clicks Raise Hand on the Participants panel
- clicks Ask for Mic on the Participants panel

To assign sounds to participant actions:

1. In the Session window, on the Edit menu, choose Personal Preferences. The Personal Preferences dialog box appears.

2. Do one of the following, as appropriate:
   - To assign a sound to play when a participant asks to speak, if Integrated VoIP is available in the session, or clicks the Raise Hand button, click Communications, and then select the actions.
   - To assign a sound to play when a participant joins or leaves the session, click Join/Leave, and then select the actions.

3. Do one of the following:
   - In the drop-down list for each selected action, choose a sound to play.
     By default, the drop-down list contains the names of all sound files that reside at the default location on your computer.
   - Click Browse, and then select a sound file that resides in another folder.

4. Optional. To play the currently selected sound, click the following button.

5. Click OK.

Note

- The Media folder is the default location on your computer for sound files.
- You can copy other sound files to the Media folder, or any other directory, to make them available in the Personal Preferences dialog box.
- Sound files must have a .wav extension.
Managing an Integrated Teleconference

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing an integrated teleconference</td>
<td>About managing an integrated teleconference on page 33</td>
</tr>
<tr>
<td>start a teleconference after you start a training session</td>
<td>Starting an teleconference during a training session on page 34</td>
</tr>
<tr>
<td>invite a participant to a teleconference during a training session</td>
<td>Inviting a participant to join a teleconference on page 34</td>
</tr>
<tr>
<td>mute or unmute a participant’s microphone</td>
<td>About muting and unmuting participants’ microphones in a teleconference on page 36</td>
</tr>
</tbody>
</table>

About managing an integrated teleconference

If you select an integrated teleconference option when setting up your training session, you can control the conference using the options available in Training Manager. An integrated teleconference can be either a call-in teleconference or call-back teleconference.

You can:

- Start the teleconference
- Invite people to the teleconference, even if they are not attending the online training session
- Mute and unmute other participants’ microphones or your own microphone
- See a unified list of who’s participating in the web meeting and the audio call for added security.
Note If you set up another type of teleconference—such as one that a third-party teleconferencing service provides—you must manage the conference using the options that the other service provides. Because this type of conference is not integrated with your training session service, you cannot manage the teleconference using the options that Training Manager provides.

Starting an teleconference during a training session

If you did not select a teleconferencing option when you set up your training session, you can start a call-in teleconference at any time during the training session.

To start a call-in teleconference during a training session:

1. On the Communicate menu, choose Join Teleconference. The Join Teleconference dialog box appears. For example:

   ![Join Teleconference dialog box](image)

   2. Follow the instructions on the dialog box.
   3. Click OK to close the dialog box.

Inviting a participant to join a teleconference

Host only

If you have set up a call-back teleconference, you can invite people who are not participants in your online event to join the teleconference.

To invite a participant to a teleconference:

1. Do either of the following:
   - On the Participant menu, choose Invite > By Phone.
On the Participants panel, click the **Invite** drop-down list and choose **By Phone**.

The Invite By Phone dialog box appears.

The **Status** box indicates that call status is **Ready**.

2. Enter the participant’s name and phone number.

3. Ensure that the participant’s country code is correct. To select a different country code, click **Country/Region**.

4. Click **Call**.

The teleconferencing service calls the participant. Once the participant joins the teleconference, the **Status** box indicates the status **Connected**.

Once the call connects, the **Conference** button becomes available on the Invite By Phone dialog box, allowing you to invite another participant.

5. Optional. To invite another participant to the teleconference, click **Conference**, and then follow the same steps to call the participant.

6. Once you have finished inviting participants, click **Close**.

### Muting and unmuting participants’ microphones in a teleconference

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of muting and unmuting participants’ microphones in a teleconference</td>
<td>About muting and unmuting participants’ microphones in a teleconference on page 36</td>
</tr>
</tbody>
</table>
Chapter 5: Managing an Integrated Teleconference

About muting and unmuting participants' microphones in a teleconference

In a teleconference, you can control which participants are allowed to speak by muting and unmuting their microphones. You can:

- Mute all attendees' microphones automatically when they join the training session
- Mute or unmute specific participants' microphones
- Mute or unmute all attendees' microphones simultaneously at any time during a training session

If you want to... See...

| mute all attendees' microphones automatically when they join a training session | Muting attendees’ microphones automatically when they join a training session on page 36 |
| mute or unmute a specific participant’s microphone | Muting and unmuting a specific participant’s microphone on page 37 |
| mute or unmute all attendees’ microphones simultaneously at any time during a training session | Muting and unmuting all attendees’ microphones simultaneously on page 38 |

Note: If you have not muted a participant’s microphone, the participant can mute or unmute his or her own microphone independently.

Muting attendees’ microphones automatically when they join a training session

Host and presenter only

In a teleconference, you can automatically mute all attendees’ microphones as they join the training session. You can then allow specific attendees to speak by unmuting their microphones.

To mute all attendees’ microphones when they join the training session:

On the Participant menu, choose Mute Attendees on Entry.

Once an attendee joins the training session, the Muted indicator appears to the left of the attendee’s name on the Participants panel. For example:

[Image of Muted indicator]
Note: Attendees for whom you have muted microphones can request to speak at any time during a training session, by clicking Raise Hand on their Participant panels.

Muting and unmuting a specific participant’s microphone

Host and presenter only

In a teleconference, you can mute or unmute any attendee’s microphone. However, you cannot mute or unmute the host’s microphone or any panelist’s microphone.

To mute or unmute a specific participant’s microphone:

1. On the Participants panel, select one or more participants for whom you want to mute or unmute microphones.
   To select multiple attendees, hold down the Ctrl key on your keyboard.

2. On the Participants panel, do one of the following
   - To mute microphones, click the Mute.
     The Muted indicator appears to the left of each selected participant’s name. For example:

     ![Muted indicator]

   - To unmute microphones, click UnMute.
     The Unmuted indicator appears to the left of each selected participant’s name. For example:

     ![Unmuted indicator]

Note: Attendees for whom you have muted microphones can request to speak at any time during a training session, by clicking Raise Hand on their Participant panels.
Muting and unmuting all attendees' microphones simultaneously

Host and presenter only

During a teleconference, you can mute or unmute all attendees’ microphones simultaneously.

This option does not affect the host’s, the presenter’s, and any panelists’ microphones.

To mute or unmute all attendees’ microphones:

Do one of the following:

- To mute all microphones:
  - using your phone keys, press “##”.
  - on the Participant menu, choose the Mute All.

On the Participant panel, the Muted indicator appears to the left of each attendee’s name. For example:

![Muted indicator](image)

- To unmute microphones:
  - using your phone keys, press “99”.
  - on the Participant menu, choose Unmute All.

On the Participant panel, the Unmuted indicator appears to the left of each attendee’s name. For example:

![Unmuted indicator](image)

Note  Participants for whom you have muted microphones can request to speak at any time during a training session, by clicking Raise Hand on their Participant panels.
Managing an Integrated VoIP Conference

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing an Integrated VoIP conference</td>
<td>About managing an Integrated VoIP conference on page 39</td>
</tr>
<tr>
<td>specify the options you want to use in the Integrated VoIP conference</td>
<td>Setting Integrated VoIP options on page 40</td>
</tr>
<tr>
<td>start an Integrated VoIP conference</td>
<td>Starting an Integrated VoIP conference on page 40</td>
</tr>
<tr>
<td>let a participant speak in an Integrated VoIP conference, by passing the microphone to the participant</td>
<td>Allowing a participant to speak in an Integrated VoIP conference on page 42</td>
</tr>
<tr>
<td>mute and unmute a participant’s microphone, including your own microphone</td>
<td>Muting and unmuting a participant’s microphone in an Integrated VoIP conference on page 43</td>
</tr>
<tr>
<td>end an Integrated VoIP conference</td>
<td>Ending an Integrated VoIP conference on page 44</td>
</tr>
</tbody>
</table>

About managing an Integrated VoIP conference

When setting up a training session, you can use an Integrated VoIP conference (VoIP powered by GIPS) in addition to, or instead of, a teleconference. This option allows participants to speak to each other using voice over IP (VoIP)—an Internet-based telephony service—rather than the telephone system. Consider using an Integrated VoIP conference if:

- Attendees are located a great distance away and do not want to incur long distance phone charges
- Your training session is a presentation rather than a discussion and does not
involve interaction among attendees

You can manage an Integrated VoIP conference by doing the following:

- Set Integrated VoIP options
- Start an Integrated VoIP conference
- Let a participant speak, by passing the microphone to the participant
- Mute and unmute a participant’s microphone
- End an Integrated VoIP conference

**Note** Before using Integrated VoIP:

- Ensure that your computer meets the system requirements. For details, see System requirements for Integrated VoIP on page 52.
- Use the Audio Setup Wizard to fine tune your computer’s settings for Integrated VoIP. For details, see Using the Audio Setup Wizard for Integrated VoIP on page 53.

---

### Setting Integrated VoIP options

**Presenter only**

You can specify personal options for Integrated VoIP, including:

- Whether you want to use speakers and a separate microphone, or a headset with an integrated microphone. For details, see Specifying your speaker and microphone setup on page 55.
- The voice buffer length, with which you can adjust the audio quality that others hear. For details, see Optimizing voice transmission in an Integrated VoIP conference on page 59.

---

### Starting an Integrated VoIP conference

**Presenter only**

Once you start an Integrated VoIP conference, any participant whose computer has a supported sound card can join the conference.

**Note** To start an Integrated VoIP conference, you must have selected the Integrated VoIP option when setting up your training session. Otherwise, Integrated VoIP is unavailable during the training session.
Before starting the conference, use the Audio Setup Wizard to fine tune your computer's settings. For details, see Using the Audio Setup Wizard for Integrated VoIP on page 53.

**To start an Integrated VoIP conference:**

1. On the **Communicate** menu, choose **Integrated VoIP > Start Conference**. The Integrated VoIP Options dialog box appears.

2. Select the options you want, and then click **OK**. For more information, see Setting Integrated VoIP options on page 40. The Volume dialog box appears, in which you can adjust the speaker or microphone volume.

![Volume dialog box](image)

The following also occurs:

- An **Integrated VoIP** indicator appears to the left of your name on the Participants panel. For example:

  ![Participant name with Integrated VoIP indicator](image)

- If you are using a headset, the following appears in the bottom-right corner of your Session window:

  ![Speak Now](image)

- If you are using desktop or laptop speakers, the following appears in the bottom-right corner of your Session window:

  ![Press CTRL to speak](image)

- The **Join Integrated VoIP** message box automatically appears in each participant’s Event window. Participants can then choose to participate in the Integrated VoIP conference.
Allowing a participant to speak in an Integrated VoIP conference

Host and presenter only

Once you start an Integrated VoIP conference, participants can join the conference and listen to Integrated VoIP audio. Up to seven participants can speak at a time.

You can specify which participants can speak, by passing the microphone to a participant.

To allow a participant to speak in an Integrated VoIP conference:

1. On the Participants panel, select the name of the participant whom you want to allow to speak.
2. On the Participant panel, click **Pass Mic**.

The **Integrated VoIP** indicator appears to the left of the participant’s name on the Participants panel. For example:

The participant can now speak until you either pass the microphone to another participant or mute the participant’s microphone.

**Note** A panelist or attendee can request to speak at any time during a training session, by clicking **Ask for Mic** on the Participants panel.

Training Manager then places the panelist or attendee in the speaker queue. For more information, see Understanding the speaker queue for Integrated VoIP on page 42.

Understanding the speaker queue for Integrated VoIP

During an Integrated VoIP conference, a panelist or an attendee can request to speak, by clicking **Ask for Mic** on the Participants panel.

Once a participant requests to speak, Training Manager places the participant in the speaker queue, as indicated by a number to the right of the Integrated VoIP symbol. For example:
The speaker queue lets you keep track of the order in which participants have requested to speak. To let a participant speak, you can pass the microphone to the participant. For details, see Allowing a participant to speak in an Integrated VoIP conference on page 42.

Once you pass the microphone to a participant, Training Manager removes the participant from the speaker queue, and then renumbers the remaining participants. For example, speaker 2 in the queue becomes speaker 1.

**Muting and unmuting a participant’s microphone in an Integrated VoIP conference**

Host and presenter only

In an Integrated VoIP conference, you can mute or unmute a participant’s microphone, if that participant is a current speaker. However, you cannot mute or unmute another panelist’s microphone.

*Note* If a participant is a current speaker in an Integrated VoIP conference and you have not muted his or her microphone, that participant can mute or unmute his or her own microphone independently.

**To mute or unmute a participant’s microphone:**

1. On the Participants panel, select the participant for whom you want to mute or unmute the microphone.

2. On the Participants panel, do one of the following

   - To mute the microphone, click the **Mute**.
     
     The **Muted** indicator appears to the left of the participant’s name. For example:

     ![Muted indicator]

   - To unmute the microphone, click **Unmute**.
     
     The **Unmuted** indicator appears to the left of the participant’s name. For example:
Chapter 6: Managing an Integrated VoIP Conference

Ending an Integrated VoIP conference

Presenter only

You can end an Integrated VoIP conference at any time.

To end an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > End Conference.
Participating in a Teleconference

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of participating in a teleconference</td>
<td>About participating in a teleconference on page 45</td>
</tr>
<tr>
<td>join a teleconference</td>
<td>Joining a teleconference on page 46</td>
</tr>
<tr>
<td>mute or unmute your phone’s microphone</td>
<td>Muting and unmuting your microphone in a teleconference on page 47</td>
</tr>
<tr>
<td>ask to speak in a teleconference</td>
<td>Asking to speak in a teleconference on page 48</td>
</tr>
<tr>
<td>leave a teleconference</td>
<td>Leaving a teleconference on page 49</td>
</tr>
</tbody>
</table>

About participating in a teleconference

Once you join a teleconference, you can communicate with other participants in the teleconference. However, the training session host or presenter can mute your phone’s microphone at any time.

As a participant in a teleconference, you can

- Mute and unmute your phone’s microphone
- Ask to speak, if the host or presenter has muted your microphone
- Determine who is speaking in the teleconference
- Leave the teleconference at any time
Joining a teleconference

Once you join a training session, instructions for joining the teleconference automatically appear on your screen. The instructions differ, depending on whether the host set up a call-back teleconference or a call-in teleconference.

You can also display these instructions at any time during the training session.

Once you join a teleconference, the Teleconference indicator appears to the left of your name on the Participants panel. For example:

![Teleconference indicator](image)

To join a call-back teleconference:

In a call-back teleconference, provide your phone number, and the automated system will call you and add you to the teleconference.

![Join Teleconference dialog](image)

**Tip** If you are unable to join a call-back conference, you can dial the backup call-in number instead. This number appears:

- In your invitation email message, if you received one
- On the Info tab in your Session window
- In the status bar at the bottom of your Session window

To join a call-in teleconference:

In a call-in teleconference, dial the appropriate number to join the teleconference.
Chapter 7: Participating in a Teleconference

Note If the global call-in numbers option is available, a list of international phone numbers appears on the Join Teleconference dialog box. Dial the appropriate number for your location, and then click OK to close the dialog box. For a list of toll-free calling restrictions by country, see www.webex.com/pdf/tollfree_restrictions.pdf.

To display teleconference instructions during a training session:
On the Communicate menu, choose Join Teleconference.

Muting and unmuting your microphone in a teleconference

In a teleconference, you can mute or unmute your microphone at any time. However, if the host or presenter has muted your microphone, you cannot unmute it.

To mute your microphone:
1. On the Participants panel, select your name.
2. Click Mute.

The Muted indicator appears to the left of your name. For example:

![Muted indicator]

To unmute your microphone:
1. On the Participants panel, select your name.
2. Click **UnMute**.

The **Unmuted** indicator appears to the left of your name. For example:

![Unmuted indicator](image)

**Asking to speak in a teleconference**

If the host has muted your microphone during a teleconference, you can ask the host to unmute your microphone so that you can speak. You can cancel a request to speak at any time.

**To ask to speak:**

On the Participants panel, click **Raise Hand**.

![Raise Hand](image)

The **Raised Hand** indicator appears on the Participant panel for the host, presenter, and panelists.

**To cancel a request to speak:**

On the Participants panel, click **Lower Hand**.

![Lower Hand](image)

The **Raised Hand** indicator is removed from the Participant panel for the host and presenter.

**Determining who is speaking in a teleconference**

During a teleconference, you can quickly determine which participants are speaking. When a participant speaks, the **Teleconference** indicator on the Participants panel animates. For example:

![Animated Teleconference indicator](image)
**To ask to speak:**
On the Participants panel, click the **Raise Hand** button.

The **Raised Hand** indicator appears on the Participant panel for the host, presenter, and panelists.

**To cancel a request to speak:**
On the Participants panel, click the **Raise Hand** button again.

The **Raised Hand** indicator is removed from the Participant panel for the host, presenter, and panelists.

---

**Leaving a teleconference**

During a training session, you can leave a teleconference without leaving the training session. You can also rejoin the teleconference at any time.

**To leave a teleconference:**
On the **Communicate** menu, choose **Leave Teleconference**.

**To rejoin a teleconference:**
On the **Communicate** menu, choose **Join Teleconference**.
## Participating in an Integrated VoIP Conference

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of participating in an Integrated VoIP conference</td>
<td>About participating in an Integrated VoIP conference on page 52</td>
</tr>
<tr>
<td>learn about system requirements for Integrated VoIP</td>
<td>System requirements for Integrated VoIP on page 52</td>
</tr>
<tr>
<td>use the Audio Setup Wizard for Integrated VoIP, to fine-tune your computer’s setting and specify the type of speakers and microphone you are using</td>
<td>Using the Audio Setup Wizard for Integrated VoIP on page 53</td>
</tr>
<tr>
<td>join an Integrated VoIP conference</td>
<td>Joining an Integrated VoIP conference on page 53</td>
</tr>
<tr>
<td>adjust speaker or microphone volume for Integrated VoIP</td>
<td>Adjusting speaker or microphone volume for Integrated VoIP on page 55</td>
</tr>
<tr>
<td>specify the type of speaker and microphone setup you are using</td>
<td>Specifying your speaker and microphone setup on page 55</td>
</tr>
<tr>
<td>ask to speak in an Integrated VoIP conference</td>
<td>Asking to speak in an Integrated VoIP conference on page 56</td>
</tr>
<tr>
<td>learn how to use your microphone to speak in an Integrated VoIP conference</td>
<td>Speaking in an Integrated VoIP conference on page 56</td>
</tr>
<tr>
<td>optimize voice transmission to prevent voice delay or “choppiness”</td>
<td>Optimizing voice transmission in an Integrated VoIP conference on page 59</td>
</tr>
<tr>
<td>mute and unmute your microphone during an Integrated VoIP conference</td>
<td>Muting and unmuting your microphone in an Integrated VoIP conference on page 59</td>
</tr>
<tr>
<td>leave an Integrated VoIP conference</td>
<td>Leaving an Integrated VoIP conference on page 60</td>
</tr>
</tbody>
</table>
Chapter 8: Participating in an Integrated VoIP Conference

About participating in an Integrated VoIP conference

Integrated VoIP is a voice-conferencing option VoIP (powered by GIPS) that allows participants to speak to each other using voice over IP (VoIP)—an Internet-based telephony service—rather than the telephone system.

Depending on the option that the training session presenter chose for the Integrated VoIP conference, up to seven participants can speak at a time in the conference. The training session host or presenter determines who can speak by passing the microphone to a participant.

Once you join an Integrated VoIP conference, you can listen to the speaker in the conference. You can also do the following:

- Adjust the volume for your speakers or microphone
- Use the Audio Setup Wizard to fine-tune your computer’s settings for Integrated VoIP and specify the type of speakers and microphone you are using
- Ask the training session host to pass the microphone to you so you can speak
- Speak in the conference, using a microphone either directly attached to your computer or integrated with a headset
- Mute and unmute your microphone, if you are the current speaker
- Leave the conference at any time

Note To participate in an Integrated VoIP conference, you must use a computer that meets the system requirements for Integrated VoIP. For details, see System requirements for Integrated VoIP on page 52.

System requirements for Integrated VoIP

To participate in an Integrated VoIP conference, you must use a computer that meets the following system requirements:

- a supported sound card
  For a list of supported sound cards, refer to the Frequently Asked Questions page on your Training Center Web site.
- speakers or headphones
- a microphone, if you want to speak during the conference
Using the Audio Setup Wizard for Integrated VoIP

Before you participate in an Integrated VoIP conference, you can use the Audio Setup Wizard to:

- ensure that your microphone and speakers are set to their optimal volume levels
- specify whether you are using speakers and a separate microphone, or a headset with an integrated microphone

To use the Audio Setup Wizard for Integrated VoIP:


2. Follow the instructions in the wizard.

Note The Audio Setup Wizard is not available if you are already participating in an Integrated VoIP conference. However, you can temporarily leave the conference to use the wizard, and then rejoin the conference.

Joining an Integrated VoIP conference

When you join a training session that includes an Integrated VoIP conference, the Join Integrated VoIP message automatically appears on your screen:
Chapter 8: Participating in an Integrated VoIP Conference

Click **Yes** to join the conference.

When you join an Integrated VoIP conference:

- The Volume dialog box appears that you can use to adjust the speaker or microphone volume.

- The **Integrated VoIP** indicator appears to the left of your name on the Participants panel. For example:

You cannot speak in the conference until the host passes the microphone to you.

---

**Tip**

- Before joining an Integrated VoIP conference, use the Audio Setup Wizard to fine-tune your computer’s settings for Integrated VoIP. For details, see Using the Audio Setup Wizard for Integrated VoIP on page 53.

- At any time during an Integrated VoIP conference, you can ask the training session host or presenter to pass the microphone to you. For details, see Asking to speak in an Integrated VoIP conference on page 56.
Chapter 8: Participating in an Integrated VoIP Conference

Adjusting speaker or microphone volume for Integrated VoIP

If you are participating in an Integrated VoIP conference, you can adjust the volume for your speakers or microphone at any time.

**To adjust the speaker or microphone volume:**

1. If the Volume dialog box is not already open, on the Communicate menu, choose Integrated VoIP > Volume.
   
   The Volume dialog box appears.

2. To increase or decrease volume, drag the speaker or microphone slider.

3. Optional. To mute your speakers or microphone, select the appropriate Mute check box.

**Tip** Before you join an Integrated VoIP conference, you can use the Audio Setup Wizard to optimize the volume levels for your microphone and speakers. For details, see Using the Audio Setup Wizard for Integrated VoIP on page 53.

Specifying your speaker and microphone setup

You can specify the type of speakers and microphone you are using in an Integrated VoIP conference. You can select one of the following:

- **Desktop speakers (default):** Specifies that you are using speakers that are either attached to or built into your computer, and a separate microphone attached to your computer.
- **Headset:** Specifies that you are using a headset with an integrated microphone.

**To specify your speaker and microphone setup:**

1. On the Communicate menu, choose Integrated VoIP > Options.

   The Integrated VoIP Options dialog box appears.
Chapter 8: Participating in an Integrated VoIP Conference

2 On the Personal Options tab, select your speaker and microphone setup.
3 Click OK.

Asking to speak in an Integrated VoIP conference

During an Integrated VoIP conference, you can indicate to the training session host and presenter that you want to speak. You can cancel a request to speak at any time.

To request to speak:

On the Participants panel, click Ask for Mic.

Training Manager places your request in the speaker queue. A number appears to right of your Integrated VoIP indicator, to indicate your position in the queue. For example:

The number indicates your position in the speaker queue.

To cancel a request to speak:

On the Participants tab, click Ask for Mic again.

The number to the right of your Integrated VoIP indicator is removed.

You are now a current speaker. For more information, see Speaking in an Integrated VoIP conference on page 56.

Speaking in an Integrated VoIP conference

If you are a current speaker in an Integrated VoIP conference, the method by which you speak depends on the speaker setup option that is currently selected for your Integrated VoIP session:

- Desktop speakers (default): If this option is selected, the following appears in the bottom-right corner of your Session window:
Chapter 8: Participating in an Integrated VoIP Conference

Simply speak into your microphone.

- **Headset**: If this option is selected, the following appears in the bottom-right corner of your Session window:

  ![Speak Now](image)

  Press the **Ctrl** key on your keyboard while speaking. Pressing this key mutes your speakers, thereby preventing your voice from echoing in the conference.

---

**Tip**

- You can specify the type of speakers and microphone you are using at any time. For details, see Adjusting speaker or microphone volume for Integrated VoIP on page 55.
- If participants experience voice delay or “choppy” voice transmission while you are speaking, you can optimize your transmission of audio. For details, see Optimizing voice transmission in an Integrated VoIP conference on page 59.

---

### Checking the quality of your VoIP connection

If you are a current speaker in an integrated VoIP conference, you can check the quality of your connection—that is, the quality of your voice transmission to other participants.

You can check your connection on the Session window or on the floating icon tray in full-screen mode.

**To check your VoIP connection on the Meeting window:**

When the Session window is visible, you can check your connection on the status bar. The VoIP indicator shows the following connection states:

**Good connection:**

- ![Connected](image)

  Green indicates that your connection is good. Participants hear little or no delay in your voice transmission.

**Fair connection:**
Chapter 8: Participating in an Integrated VoIP Conference

Poor connection:

Yellow indicates that your connection is fair. Participants might hear some delay in your voice transmission.

To check your VoIP connection in full-screen mode:

When using full-screen mode, you can check your VoIP connection on the floating icon tray. The VoIP indicator shows the following connection states:

Good connection:

Green indicates that your connection is good. Participants hear little or no delay in your voice transmission.

Fair connection:

Yellow indicates that your connection is fair. Participants might hear some delay in your voice transmission.

Poor connection:

Red indicates that your connection is poor. Participants hear significant delay in your voice transmission.
Chapter 8: Participating in an Integrated VoIP Conference

**Tip** Usually, the cause of a fair or poor VoIP connection is a lack of capacity, or “bandwidth,” available for sending voice information over your network or the Internet. To improve your VoIP connection, you can try the following:

- If you are sharing software, pause or stop sharing.
- If you are sending video, close the Video panel.
- Close any other applications on computer that might be using bandwidth for your Internet connection.
- Avoid downloading files on your network or from the Internet while using Integrated VoIP.
- Avoid browsing the Web while using Integrated VoIP.

---

**Optimizing voice transmission in an Integrated VoIP conference**

If you are speaking in an Integrated VoIP conference, you can optimize the transmission of your voice to reduce:

- Voice delay
- Choppiness or “jitter”

**To optimize voice transmission:**

2. On the Personal Options tab, under Voice buffer length, drag the to adjust voice transmission.
3. The faster the transmission, the more likely participants will hear choppiness.
4. Click OK to close the Integrated VoIP Options dialog box.

---

**Muting and unmuting your microphone in an Integrated VoIP conference**

If you are the current speaker in an Integrated VoIP conference, you can mute or unmute your microphone at any time. However, if the host has muted your microphone, you cannot unmute it.

**To mute your microphone:**

1. On the Participants panel, select your name.
Chapter 8: Participating in an Integrated VoIP Conference

2 Click Mute.

The Muted indicator appears to the left of your name. For example:

![Muted indicator]

To unmute your microphone:

1 On the Participants panel, select your name.
2 Click UnMute.

The Unmuted indicator appears to the left of your name. For example:

![Unmuted indicator]

Leaving an Integrated VoIP conference

During a training session, you can leave an Integrated VoIP conference without leaving the training session. You can rejoin the conference at any time.

To leave an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > Leave Conference.

To rejoin an Integrated VoIP conference:

On the Communicate menu, choose Integrated VoIP > Join Conference.
Sharing Presentations, Documents, and Whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sharing presentations, documents, and whiteboards</td>
<td>About sharing presentations, documents, and whiteboards on page 61</td>
</tr>
<tr>
<td>grant sharing privileges to attendees</td>
<td>Granting document, presentation, and whiteboard sharing privileges on page 62</td>
</tr>
<tr>
<td>get an overview of the content viewer sharing tools</td>
<td>Content viewer tools on page 62</td>
</tr>
<tr>
<td>share presentations or documents</td>
<td>About sharing presentations, documents, and whiteboards on page 61</td>
</tr>
<tr>
<td>share a whiteboard</td>
<td>About sharing a whiteboard on page 70</td>
</tr>
<tr>
<td>learn how to share documents and presentations effectively</td>
<td>Tips for sharing documents and presentations on page 68</td>
</tr>
</tbody>
</table>

**About sharing presentations, documents, and whiteboards**

You can share the following types of content during a training session:

- Presentations or documents on your computer
- Whiteboards
- WebEx Universal Communications Format (UCF) multimedia presentations or standalone files

The content that you share appears in the content viewer on all participants’ screens.
Granting document, presentation, and whiteboard sharing privileges

By default, only the presenter can share a document, presentation, or whiteboard during a training session. However, you can allow all attendees to share their own presentations or documents or interact with pages, slides, and whiteboards that others share. You can also remove these sharing privileges from attendees at any time.

To specify attendee privileges for shared content in the content viewer:

1. In the Session window, on the Participant menu, choose Assign Privileges. The Attendee Privileges dialog box appears.

2. Under Document, select or clear the check boxes for any sharing privileges you want to grant to or remove from all attendees:
   - Save
   - Print
   - Annotate

3. Under View, select or clear the check boxes for any sharing privileges that you want to grant to or remove from all attendees:
   - Attendee list
   - Any document
   - Thumbnails
   - Any page

4. Under Training Session, select or clear the check boxes to grant to or remove these privileges from all or selected attendees:
   - Record the session
   - Share documents
   - Control shared applications, or Web browser, or desktop remotely

5. Click Assign.

Content viewer tools

The tools on the content viewer toolbar allow you to share and perform actions on presentations, documents, and whiteboards.
Opening and moving through documents

You can open a document, whiteboard, desktop, or application to share using the sharing icons in the upper left corner:

Move through the pages in a shared document or presentation using the Previous and Next buttons on the selector tool. Click the down arrow button to view a list of all pages or slides in the current document or presentation.

Click the down arrow to view a list of pages or slides
Annotation tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pointer</strong></td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Lets you type text on shared content. Attendees can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the <strong>Edit</strong> menu, choose <strong>Font</strong>. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td><strong>Rectangle</strong></td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td><strong>Highlighter</strong></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td><strong>Annotation Color</strong></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td><strong>Eraser</strong></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

View tools

<table>
<thead>
<tr>
<th>Standard View</th>
<th>Full-Screen View</th>
<th>Zoom In/Zoom Out</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Thumbnails</td>
<td>Synchronize Displays for All</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 9: Sharing Presentations, Documents, and Whiteboards

Sharing presentations or documents

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard View/View Thumbnails</td>
<td>Clicking <strong>Standard View</strong> displays the shared content as you would normally view it. To display thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click <strong>View Thumbnails</strong>. This tool helps you locate a page or slide quickly. Click <strong>Standard View</strong> to return to normal viewing of the shared content.</td>
</tr>
<tr>
<td>Full-Screen View</td>
<td>Displays shared content in a full-screen view. Helps you to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation. Click <strong>ESC</strong> to return to the content viewer.</td>
</tr>
<tr>
<td>Zoom In/Zoom Out</td>
<td>Lets you display shared content at various magnifications. Click this button, and then click the page, slide, or whiteboard to change its magnification. For more magnification options, click the downward-pointing arrow.</td>
</tr>
<tr>
<td>Synchronize Displays for All</td>
<td>For presenters, synchronizes all participants’ displays with your display. Helps to ensure that all participants are viewing the same page or slide, at the same magnification, as in your display.</td>
</tr>
</tbody>
</table>

Sharing presentations or documents

If you want to... | See...
---|---
get an overview of document and presentation sharing | About sharing presentations or documents on page 65
start sharing a document or presentation | Starting document or presentation sharing on page 66
close a shared document or presentation to remove it from the content viewer | Closing shared documents and presentations on page 69

About sharing presentations or documents

Generally, you can share any type of document or presentation that you can print from your computer. Attendees can view the shared document or presentation in their content viewers, without the need for the application with which it was created. Attendees can also view any animation and transition effects on shared Microsoft PowerPoint slides.

Once a training session starts, you can open a document or presentation to share. You do not need to select it or “load” it before the training session.

Document and presentation sharing is ideal for presenting information that you do not need to edit during the training session, such as a slide presentation.
Chapter 9: Sharing Presentations, Documents, and Whiteboards

While sharing a document or presentation, you can:

- Make annotations
- Use a pointer to emphasize text or graphics
- Save it to a file
- Print it
- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
- Synchronize all participants’ displays with the display in your content viewer

At any time during a training session, you can grant attendees privileges that allow them to annotate, save, print, and display different views of shared presentations or documents.

Starting document or presentation sharing

You can share a document or presentation that resides on your computer. Attendees can view a shared document or presentation in their content viewers.

To share a document or presentation:

1. On the Share menu, choose Presentation or Document.
   The Share Presentation or Document dialog box appears.
2. Select the document or presentation that you want to share.
3. Click Open.
   The shared document or presentation appears in the content viewer.
Chapter 9: Sharing Presentations, Documents, and Whiteboards

Tip

For tips that can help you to share documents and presentations more effectively, see Tips for sharing documents and presentations on page 68.

Determining whether participants can view a page or slide

When sharing a document or presentation, you can check the Participant Ready indicator to determine whether the page or slide that is currently displayed in your content viewer is visible to other participants. This indicator is especially useful if you are sharing a UCF media file on a slide, and want to wait until the file loads in all participants' content viewers before you play it.

If the shared page or slide in your content viewer currently appears in a participant’s content viewer, the Participant Ready indicator appears to the left of that participant's name in the participant list. The Participant Ready indicator can appear in different states, each of which indicates the percentage of the content on the shared page or slide that has loaded in the participant's content viewer, as follows:

- 25% of the page or slide has loaded in the participant's content viewer.
Chapter 9: Sharing Presentations, Documents, and Whiteboards

Note
If the Participant Ready indicator does not appear to the left of a participant's name in the participant list, the page, slide, or whiteboard in your content viewer is not displayed in the participant's content viewer. For example, the participant may be viewing another slide in your presentation. In this case, you can synchronize all participant's displays with your display. For details, see Synchronizing attendees' views of slides, pages, or whiteboards on page 81.

Tips for sharing documents and presentations

These tips can help you share documents or presentations more effectively.

■ To import slide presentations quickly:
  □ Limit the number of animations and slide transitions.
  □ Minimize the number of screen shots that you add to slides, especially bitmap graphics. Bitmaps do not compress well.
  □ Limit the number of slides in a presentation to fewer than 30. If you want to share more slides, create a separate presentation file for each set of 20 to 30 slides.
  □ Keep the size of the presentation file smaller than 5MB.

■ To improve the speed at which shared pages or slides appear in attendees' content viewers, save the document or presentation as a .ucf (Universal Communications Format) file before the training session starts. Then share the .ucf file instead of the document or presentation itself. For details, see Saving a presentation, document, or whiteboard on page 90.

■ You can annotate shared presentations or documents in the content viewer; however, you cannot edit them. If you want to edit shared information, you can use application sharing instead.

Choosing an import mode for document or presentation sharing

Before you share a document or presentation, you can choose one of the following import modes:

■ Universal Communications Format (UCF)—The default mode. Lets you display animations and slide transitions in Microsoft PowerPoint presentations. In the UCF mode, Meeting Manager imports documents and presentations
more quickly than it does in the printer driver mode. However, pages or slides may not appear consistently in Meeting Manager across platforms.

- **Printer driver**—Displays shared documents and presentations as they appear when you print them, providing a consistent appearance of pages and slides in Meeting Manager across platforms. However, this mode does not support animations or slide transitions. In this mode, the first page or slide may appear quickly, but the total import time for all pages or slides is usually longer than it is in the UCF mode.

**Note** Changing the import mode does not affect any presentations or documents that you are currently sharing. To apply a new import mode to a shared document or presentation, you must close it first, and then share it again.

**To choose an import mode for shared documents and presentations:**

1. In the Session window, on the Training Session menu, choose Session Options. The Training Session Options dialog box appears, with the Options tab selected by default.

2. Click the Import Mode tab. The Import Mode tab options appear.

3. Select either **Universal Communications Format** or **Printer driver**.

4. Click **OK**.

**Closing shared documents and presentations**

You can close any presentations or documents that you are sharing in your content viewer.

**To close a shared document or presentation:**

1. In the content viewer, select the tab for the document or presentation that you want to close.
2. On the **File** menu, choose **Close**.

If you have not yet saved any annotations that you made on the document or presentation, a message appears, allowing you to save it.

---

### Sharing a whiteboard

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of whiteboard sharing</td>
<td>About sharing a whiteboard on page 70</td>
</tr>
<tr>
<td>start sharing a whiteboard</td>
<td>Starting whiteboard sharing on page 70</td>
</tr>
<tr>
<td>close a shared whiteboard to remove it from the content viewer</td>
<td>Closing a shared whiteboard on page 71</td>
</tr>
</tbody>
</table>

---

### About sharing a whiteboard

Sharing a whiteboard allows you to draw objects and type text that all attendees can see in their content viewers. You can also use a pointer to emphasize text or graphics on a whiteboard.

While sharing whiteboard, you can:
- Display it at various magnifications, in miniature (thumbnails), and in a full-screen view
- Save it
- Print it
- Synchronize attendees’s displays with the display in your content viewer

If you grant annotation privileges to attendees, you and attendees can draw and type on a whiteboard simultaneously. You can also allow attendees to save, print, and display different views of shared whiteboards. For details, see Granting document, presentation, and whiteboard sharing privileges on page 62.

---

### Starting whiteboard sharing

You can share a whiteboard on which you can draw and write. Attendees can view a shared whiteboard in their content viewers.

**To share a whiteboard:**

- On the **Share** menu, choose **Whiteboard**.

---

**Note**

- You can add multiple pages to a shared whiteboard. For details, see Adding new
You can share multiple whiteboards. For each whiteboard that you share, Meeting Manager creates a new Whiteboard tab in the content viewer.

Closing a shared whiteboard

You can close any whiteboards that you are sharing in your content viewer.

To close a shared whiteboard:

1. In the content viewer, select the tab for the whiteboard you want to close.
2. On the File menu, choose Close.

If you have not yet saved any annotations that you made on the whiteboard, a message appears, allowing you to save it.

Navigating presentations, documents, or whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of navigating presentations, documents, or whiteboards</td>
<td>About navigating shared presentations, documents, or whiteboards on page 71</td>
</tr>
<tr>
<td>navigate presentations, documents, or a whiteboard</td>
<td>Navigating slides, pages, or whiteboards using the toolbar on page 72</td>
</tr>
<tr>
<td>automatically advance pages or slides</td>
<td>Advancing pages or slides automatically on page 73</td>
</tr>
<tr>
<td>perform animations and slide transitions in shared PowerPoint slides</td>
<td>Performing animations and slide transitions in shared slides on page 74</td>
</tr>
<tr>
<td>use keyboard shortcuts to navigate a presentation</td>
<td>Using keyboard shortcuts to control a presentation on page 75</td>
</tr>
</tbody>
</table>

About navigating shared presentations, documents, or whiteboards

When sharing a document, presentation, or whiteboard, you can:

- Navigate slides, pages, or whiteboards using the toolbar
- Advance pages or slides automatically, at an interval of time that you specify
- Perform animations and slide transitions in a presentation
- Use keys on your computer’s keyboard to navigate a presentation and display animations on the slides
Navigating slides, pages, or whiteboards using the toolbar

You can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on a tab at the top of the content viewer.

To display pages or slides in the content viewer:

1. In the Session window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.

   If there are more tabs than can appear at one time, click the Next Tab button to cause the next tab to scroll into view.

2. On the toolbar, click a button to change the page or slide you are viewing.

   ■ To display the next page or slide, click the Next button.
   ■ To display the previous page or slide, click the Previous button.
   ■ To display any page or slide, select it in the Go To drop-down list.

   If Microsoft PowerPoint slides are being shared, the drop-down list also displays the title of each slide.

Note

■ Alternatively, you can navigate to different pages or slides in a shared document, presentation, or whiteboard by opening the thumbnail viewer. For details, see Viewing miniatures of slides, pages, or whiteboards on page 79.

■ You can advance pages or slides automatically at a time interval that you specify. For details, see Advancing pages or slides automatically on page 73.

■ You can also use the keys on your computer's keyboard to display different pages or slides and perform animations and slide transitions. For details, see Using keyboard shortcuts to control a presentation on page 75.

■ If your presentation includes animations or slide transitions, you can use the toolbar or keyboard shortcuts to perform them. For details, see Performing animations and slide transitions in shared slides on page 74.
Advancing pages or slides automatically

When sharing a document or presentation in the content viewer, you can automatically advance pages or slides at a specified interval. Once you start automatic page or slide advancement, you can stop it at any time.

To automatically advance pages or slides:

1. In the Session window, in the content viewer, select the tab for the document or presentation for which you want to advance pages or slides automatically.

2. On the **View** menu, choose **Automatically Advance Pages**.

   The Automatically Advance Pages dialog box appears.

3. In the **Advance to next page every** box, specify an interval of time at which to advance pages or slides, by selecting the minutes or seconds, and then doing either of the following:
   - Type a time.
   - Click the **Up** button to increase the number or click the **Down** button to decrease the number.

4. Optional. To restart page or slide advancement once all pages or slides are displayed, select the **Return to beginning and continue advancing pages** check box.

5. Click **Start**.

6. Optional. Close the Automatically Advance Pages dialog box by clicking the **Close** button in the upper-right corner of the dialog box.

   The pages or slides continue to advance at the specified interval.

To stop automatic page or slide advancement:

1. If you closed the Automatically Advance Pages dialog box, on the **View** menu, choose **Automatically Advance Pages**.

   The Automatically Advance Pages dialog box appears.

2. Click **Stop**.
Performing animations and slide transitions in shared slides

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you can perform animations on the slides and slide transitions, just as you can when using the Slide Show option in PowerPoint.

Note To perform animations and slide transitions, you must share the presentation as a Universal Communications Format (UCF) file (.ucf). The UCF import mode automatically converts a PowerPoint file (.ppt) to a UCF file when you share it. For information about choosing an import mode, see Starting document or presentation sharing on page 66.

- If you want to share a presentation that was created using Microsoft PowerPoint 2002 for Windows XP, it is recommended that you use a computer with an Intel Celeron or Pentium 500 MHz or faster processor.
- Alternatively, you can use the keys on your computer's keyboard to perform animations and slide transitions in a PowerPoint slide presentation. For details, see Using keyboard shortcuts to control a presentation on page 75.
- If at least one training session participant is using the Java Meeting Manager, animations and slide transitions are not available during the training session. The training session host can prevent participants from joining a training session using the Java Meeting Manager when scheduling the training session.

To perform slide animations and transitions in a shared presentation:

1. Ensure that the content viewer has input focus by clicking in the viewer.
   The content viewer has input focus if a blue border appears around the outside of the slide in the viewer.

2. On the toolbar, do either of the following:
   - To display the next slide or perform the next animation or slide transition, click the Next button.
   - To display the previous slide or perform the previous animation or slide transition, click the Previous button.
Using keyboard shortcuts to control a presentation

When sharing a document or presentation in the content viewer, you can use the keys on your computer’s keyboard to display pages or slides. If you are sharing a Microsoft PowerPoint slide presentation, you can also use keyboard keys to perform animations on the slides and slide transitions, just as you can when using the Slide Show option in PowerPoint.

**Note** Before using keyboard shortcuts, click in the viewer to set the input focus in the content viewer. A blue border around the shared page or slide indicates that the viewer has input focus.

### Sharing a Presentation

Use these keystrokes to move quickly through your presentation.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the next slide or perform the next animation or slide transition</td>
<td>Space Bar, Page Down, Right Arrow, or Down Arrow</td>
</tr>
<tr>
<td>Display the previous slide or perform the previous animation or slide transition</td>
<td>Page Up, Left Arrow, or Up Arrow</td>
</tr>
<tr>
<td>Display the first slide</td>
<td>Home</td>
</tr>
<tr>
<td>Display the last slide</td>
<td>End</td>
</tr>
</tbody>
</table>

**Note** To perform animations and slide transitions, you must share the presentation as a Universal Communications Format (UCF) file. The UCF import mode automatically converts a PowerPoint file to a UCF file when you share it. For information about choosing an import mode, see Choosing an import mode for document or presentation sharing on page 68.

### Sharing a Document

Use these keystrokes to move quickly through your document.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the next page</td>
<td>Space Bar, or Page Down, Right Arrow, or Down Arrow</td>
</tr>
<tr>
<td>Display the previous page</td>
<td>Page Up, Left Arrow, or Up Arrow</td>
</tr>
<tr>
<td>Display the first page</td>
<td>Home</td>
</tr>
<tr>
<td>Display the last page</td>
<td>End</td>
</tr>
</tbody>
</table>
Chapter 9: Sharing Presentations, Documents, and Whiteboards

Working with pages or slides

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of working with pages or</td>
<td>About working with pages or slides on page 76</td>
</tr>
<tr>
<td>slides</td>
<td></td>
</tr>
<tr>
<td>add new, blank pages or slides in the</td>
<td>Adding new pages or slides on page 76</td>
</tr>
<tr>
<td>content viewer</td>
<td></td>
</tr>
<tr>
<td>paste images that you copy to your</td>
<td>Pasting images in slides, pages, or whiteboards</td>
</tr>
<tr>
<td>computer’s clipboard in slides, pages, or</td>
<td>on page 76</td>
</tr>
<tr>
<td>whiteboards</td>
<td></td>
</tr>
</tbody>
</table>

About working with pages or slides

When sharing a document, presentation, or whiteboard, you can

- Add new, blank pages or slides for annotation
- Paste images that you copy to your computer’s clipboard into a new page or slide in a shared document, presentation, or whiteboard

Adding new pages or slides

When sharing a document, presentation, or whiteboard in the content viewer, you can add a new, blank page or slide for annotation.

To add a new page or slide:

1. In the content viewer, select the tab for the document, presentation, or whiteboard to which you want to add a page or slide.
   
   A new page appears in the content viewer, at the end of the currently selected document, presentation, or whiteboard.

Pasting images in slides, pages, or whiteboards

If you copy any bitmap image to your computer's clipboard, you can paste the image into a new page, slide, or whiteboard in the content viewer.

For example, you can copy an image on a Web page or in an application, then quickly share that image by pasting it in the content viewer.

To paste an image in a page, slide, or whiteboard in the content viewer:

1. In the content viewer, select the tab for the document, presentation, or whiteboard in which you want to paste an image.
   
   The image appears on a new page in the content viewer, at the end of the currently selected document, presentation, or whiteboard.
Note: You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF image in the content viewer. However, you cannot paste other types of images—such as EPS or Photoshop (PSD) images—in the content viewer.

## Controlling views of presentations, documents, or whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview about controlling views presentations, documents, or whiteboards</td>
<td>About controlling views of shared presentations, documents, or whiteboards on page 77</td>
</tr>
<tr>
<td>magnify or reduce the view of slides, pages, or whiteboards</td>
<td>Magnifying or reducing the view of slides, pages, or whiteboards on page 78</td>
</tr>
<tr>
<td>control full-screen view of slides, pages, or whiteboards</td>
<td>Controlling full-screen view of slides, pages, or whiteboards on page 79</td>
</tr>
<tr>
<td>view miniatures, or thumbnails, of slides, pages, or whiteboards</td>
<td>Viewing miniatures of slides, pages, or whiteboards on page 79</td>
</tr>
<tr>
<td>synchronize participants’ views of slides, pages, or whiteboards with your view</td>
<td>Synchronizing attendees’ views of slides, pages, or whiteboards on page 81</td>
</tr>
</tbody>
</table>

### About controlling views of shared presentations, documents, or whiteboards

All shared presentations, documents, or whiteboards appear in the content viewer in the Session window. A tab at the top of the content viewer appears for each document, presentation, or whiteboard that is being shared.

Depending on your role and the privileges that you have, you can do the following when viewing shared content in the content viewer:

- View slides, pages, or whiteboards at various magnifications.
- View slides, pages, or whiteboards in miniature.
- Display a full-screen view of a page, slide, or whiteboard.
- Synchronize all participants’ views of a page or slide with the view that appears in your content viewer.
Magnifying or reducing the view of slides, pages, or whiteboards

You can magnify or reduce any page, slide, or whiteboard that appears in the content viewer, using various methods. Magnifying or reducing content in the content viewer changes only its appearance, not its actual size.

You can:

■ Zoom in to or out from on a page, slide, or whiteboard
■ Adjust the size of a page, slide, or whiteboard to fit the content viewer
■ Adjust the size of a page, slide, or whiteboard to fit it width in the content viewer
■ Turn off the Zoom tool at any time

To zoom in to or out from on a page, slide, or whiteboard:

Do one of the following on the content viewer toolbar:

■ To zoom in or out incrementally, click the downward-pointing arrow to the left of the Zoom In/Zoom Out button, and then choose Zoom In or Zoom Out. To continuing zooming in or out, click the Zoom In/Zoom Out button.

■ To zoom in to a specific area, click the downward-pointing arrow to the right of the Zoom In button, and then drag your mouse to the area. Release your mouse button.

■ To zoom in or out to a preset percentage, click the downward-pointing arrow to the left of the Zoom In/Zoom Out button, and then choose the percentage.

To adjust the size of a page, slide, or whiteboard to fit the content viewer:

1. On the toolbar, click the downward-pointing arrow to the right of the Zoom In/Zoom Out button.

2. On the menu that appears, choose Fit to Viewer.

To adjust the size of a page, slide, or whiteboard to fit its width in the content viewer:

1. On the toolbar, click the downward-pointing arrow to the right of the Zoom In/Zoom Out button.

2. On the menu that appears, choose Fit to Width.
To turn off the zoom tool:

On the toolbar, click the **Zoom In/Zoom Out** button.

**Controlling full-screen view of slides, pages, or whiteboards**

You can maximize the size of a page, slide, or whiteboard in the content viewer to fit your monitor's entire screen. A full-screen view replaces the normal Session window view. You can return to a normal view at any time.

- **Note** If a training session presenter displays a full-screen view of a page, slide, or whiteboard, attendees’ screens automatically display a full-screen view as well. However, attendees can control full-screen view independently in their Session windows.

**To display a full-screen view:**

On the toolbar, click the **Full-Screen View** button.

**To return to a normal view:**

On the floating icon tray, click **Return to Main Window**.

**Viewing miniatures of slides, pages, or whiteboards**

You can view miniatures, or thumbnails, of the shared pages, slides, and whiteboards that appear in the content viewer. Viewing miniatures can help you to quickly locate a shared page or slide that you want to display in the content viewer.

**To view miniatures of slides, pages, or whiteboards:**

1. In the content viewer, select the tab for the document, presentation, or whiteboard for which you want to view miniatures.
2. On the toolbar, click the **View Thumbnails** button.
Miniatures of all pages or slides in the selected document, presentation, or whiteboard appear in the thumbnail viewer, in the left column.

3 Optional. To display any page or slide in the content viewer, double-click its miniature in the thumbnail viewer.

4 Optional. To control the size of the thumbnail viewer, drag the right edge of the viewer to the right or left.

Note Attendees must have both the View thumbnails and View any page privileges to display a miniature of a page or slide at full size in the content viewer.
Chapter 9: Sharing Presentations, Documents, and Whiteboards

To close the thumbnail viewer:

On the toolbar, click the View Thumbnails button again.

Synchronizing attendees' views of slides, pages, or whiteboards

You can synchronize the display of a shared page, slide, or whiteboard in all attendees' content viewers with the display in your viewer. Once you synchronize displays, the page, slide, or whiteboard in attendees' content viewers appears at the same magnification as in your content viewer.

To synchronize attendees' views of slides, pages, or whiteboards:

On the content viewer toolbar, click the Synchronize Displays button.

Annotating presentations, documents, or whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview about annotating presentations, documents, or whiteboards</td>
<td>About annotating shared presentations, documents, or whiteboards on page 82</td>
</tr>
<tr>
<td>draw annotations on slides, pages, or whiteboards</td>
<td>Drawing annotations on slides, pages, or whiteboards on page 82</td>
</tr>
<tr>
<td>type annotations on pages or slides</td>
<td>Typing annotations on slides, pages, or whiteboards on page 83</td>
</tr>
<tr>
<td>select a color for annotating slides, pages, or whiteboards</td>
<td>Selecting a color for annotating slides, pages, or whiteboards on page 83</td>
</tr>
<tr>
<td>make any annotation color visible on either a light or dark background in the content viewer</td>
<td>Making annotations visible on different backgrounds in the content viewer on page 84</td>
</tr>
<tr>
<td>select a font for typing annotations on slides, pages, or whiteboards</td>
<td>Selecting a font for annotating slides, pages, or whiteboards on page 84</td>
</tr>
<tr>
<td>clear, or erase, annotations on slides, pages, or whiteboards</td>
<td>Clearing annotations on slides, pages, or whiteboards on page 84</td>
</tr>
<tr>
<td>undo or redo annotations in the content viewer</td>
<td>Undoing and redoing changes in the content viewer on page 85</td>
</tr>
</tbody>
</table>
Chapter 9: Sharing Presentations, Documents, and Whiteboards

About annotating shared presentations, documents, or whiteboards

You can annotate a shared document, presentation, or whiteboard that appears in the content viewer. When making annotations, you can:

- Draw objects and highlight text or graphics
- Type text
- Select a font for typing
- Select a color for annotations
- Adjust an annotation color so it is visible on either a light or dark background
- Clear or erase annotations
- Undo and redo annotations

Drawing annotations on slides, pages, or whiteboards

Using the drawing tools, you can draw annotations on shared slides, pages, or whiteboards in the content viewer. The drawing tools allow you to highlight text and graphics; draw freehand; and draw lines, arrows, and various shapes.

![Highlighter tool]

To highlight an element on a page, slide, or whiteboard:

1. On the toolbar, click the Highlighter Tool icon.
2. To draw annotations, drag your mouse.
3. Optional. Click the downward pointing arrow next to the Highlighter tool to select a different highlighting tool.

Note You can change your annotation color at any time. For details, see Selecting a color for annotating slides, pages, or whiteboards on page 83.

To turn off the drawing tool:

On the toolbar, click the Highlighter Tool icon.
Typing annotations on slides, pages, or whiteboards

Using the text tool, you can type annotations on shared slides, pages, or whiteboards in the content viewer.

To type annotations on a page, slide, or whiteboard:
1. On the toolbar, click the Text Tool icon.
   Your mouse pointer changes to a cursor.
2. Begin typing in the content viewer.
3. Click outside the box in which you typed the text to send the text to all participants' content viewers.

Note When typing annotations, you can do the following:
- Select a different font. For details, see Selecting a font for annotating slides, pages, or whiteboards on page 84.
- Select a different annotation color. For details, see Selecting a color for annotating slides, pages, or whiteboards on page 83.

To turn off the text tool:
On the toolbar, click the Text Tool icon.

Selecting a color for annotating slides, pages, or whiteboards

You receive a default annotation color when you join a training session. However, you can select a different color for making annotations.

To select a color for annotating a shared page, slide, or whiteboard:
1. On the toolbar, click the Annotation Color Tool icon.
   The Annotation Color palette appears.
2. Select the color that you want to use.
Making annotations visible on different backgrounds in the content viewer

When using annotation tools to annotate a document, presentation, or whiteboard in the content viewer, you can adjust your annotation color so it displays well on either a light or dark background. For example, if you are using a dark annotation color to annotate a dark image on a slide, you can make your annotations visible on the dark image.

To annotate on either a light or dark background in the content viewer:
2. Choose a background:
   - **Light Background**—Makes annotations visible on a light background.
   - **Dark Background**—Makes annotations visible on a dark background.

Selecting a font for annotating slides, pages, or whiteboards

When typing text on a page, slide, or whiteboard in the content viewer, you can select the:

- Font
- Font style
- Text color

To select a font for typing annotations:
1. On the Edit menu, choose **Font**.
   - The Font dialog box appears.
2. Select the font and other options that you want to use.
3. Click **OK**.

Clearing annotations on slides, pages, or whiteboards

You can clear any annotations that you or another attendee makes on a shared page, slide, or whiteboard in the content viewer. You can clear:

- All annotations at once
- Only specific annotations
- If you are the presenter or host, clear all annotation you have made
To clear all annotations on a shared page, slide, or whiteboard:

1. On the toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.
2. Choose Clear All Annotations.

**Note:** Only annotations on the page or slide that currently appears in your content viewer are cleared. Annotations on other pages or slides are not cleared.

If you are the host or presenter, you can clear all the annotations you’ve made.

**To clear all annotations you have added to a shared page, slide, or whiteboard:**

1. On the toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.
2. Choose Clear My Annotations.

**To clear specific annotations on a shared page, slide, or whiteboard:**

1. On the toolbar, click the Eraser Tool icon. Your mouse pointer changes to an eraser.
2. Click the annotation you want to clear.

**To turn off the eraser tool:**

On the toolbar, click the Eraser Tool icon.

**Undoing and redoing changes in the content viewer**

When annotating a page, slide, or whiteboard in the content viewer, you can undo and redo up to ten changes that you made.

**To undo and redo changes in the content viewer:**

1. On the Edit menu, choose Undo.
2. Optional. Repeat step 1 to undo another change.
3. If you decide that you do not want to undo your change, on the Edit menu, choose Redo.
Chapter 9: Sharing Presentations, Documents, and Whiteboards

Using pointers on presentations, documents, or whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview on using pointers on shared presentations, documents, or whiteboards</td>
<td>About using pointers on shared presentations, documents, or whiteboards on page 86</td>
</tr>
<tr>
<td>use an arrow pointer to highlight areas on slides, pages, or whiteboards</td>
<td>Using an arrow pointer on slides, pages, or whiteboards on page 86</td>
</tr>
<tr>
<td>use a laser pointer to highlight areas on slides, pages, or whiteboards</td>
<td>Using a laser pointer on slides, pages, or whiteboards on page 87</td>
</tr>
<tr>
<td>clear a pointer from pages, slides, or a whiteboard</td>
<td>Clearing pointers on slides, pages, or whiteboards on page 87</td>
</tr>
</tbody>
</table>

About using pointers on shared presentations, documents, or whiteboards

When sharing or viewing a document, presentation, or whiteboard, you can use either type of pointer:

- **Arrow pointer**: Shows your assigned annotation color and your name. You can click your mouse to set the pointer at specific location on a page, slide, or whiteboard.

- **Laser pointer**: Shows a red “laser” dot that you can move continuously on a page, slide, or whiteboard, using your mouse.

You can remove or clear your pointer from a page, slide, or whiteboard at any time.

Using an arrow pointer on slides, pages, or whiteboards

When sharing or viewing a page, slide, or whiteboard in the content viewer, you can add an arrow pointer to emphasize text or graphics. Your pointer provides your name and default annotation color.

To use an arrow pointer to a page, slide, or whiteboard:

1. On the toolbar, select the **Pointer Tool** icon.
   Your mouse pointer becomes an arrow.

2. Click the location on the page, slide, or whiteboard at which you want to add a pointer.
3. To move the pointer, click another location on the page, slide, or whiteboard.

**To turn off the pointer tool:**

On the toolbar, click the **Pointer Tool** icon.

---

**Note** When you turn off the pointer tool, your pointer remains on the page, slide, or whiteboard. For instructions on removing, or clearing, your pointer, see Clearing pointers on slides, pages, or whiteboards on page 87.

---

**Using a laser pointer on slides, pages, or whiteboards**

When sharing a page, slide, or whiteboard in the content viewer, you can use a laser pointer tool, which allows you to quickly move a “laser beam” to different areas of the shared content. The laser pointer is useful for guiding attendees from one part of a page or slide to another.

1. On the toolbar, click downward-pointing arrow next to the **Pointer tool** icon.
2. Select the **Laser Pointer**.
   
   Your mouse pointer becomes a red “laser beam.”
3. To move the pointer, move your mouse, without clicking it.

**To turn off the laser pointer tool:**

On the toolbar, click the **Pointer tool** icon.

---

**Clearing pointers on slides, pages, or whiteboards**

You can clear your own pointers on all shared slides, pages, or whiteboards in the content viewer. If you are a presenter, you can also clear all attendees’ pointers.
To clear your own pointer on all shared slides, pages, or whiteboards:

1. On the toolbar, click the downward-pointing arrow to the right of the Eraser Tool icon.
2. Choose **Clear My Pointer**.

### Renaming and reordering tabs for shared documents, presentations, or whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>rename a shared document, presentation, or whiteboard</td>
<td><em>Renaming the tab for a presentation, document, or whiteboard on page 88</em></td>
</tr>
<tr>
<td>reordering the tabs in the content viewer</td>
<td><em>Reordering the tabs for documents, presentations, and whiteboards on page 89</em></td>
</tr>
</tbody>
</table>

### Renaming the tab for a presentation, document, or whiteboard

As you are sharing an item, such as a presentation, in the content viewer, you can easily change its name on the tab. Later, when you end the meeting, you can save the document, presentation, or whiteboard with this new name.

**To rename a tab in the content viewer:**

1. Right click the tab name you want to change.

2. Enter the new name on the tab.

3. Press **Enter** or click outside the tab.

   This tab displays the new name.

**Tip** You can also click the tab name to select it.
Chapter 9: Sharing Presentations, Documents, and Whiteboards

This feature is handy if participants have used the annotation tools to make comments and notes or highlight elements in your document. You can save your document with the annotations as a new document, separate from your original.

Of course, you can still use the **Save As** command on the **File** menu to save the document at the end of your meeting. Changing the name on the tab itself allows others to see the name you are giving the file. Also, you are making the change at the moment that action is meaningful, rather than at the end of the meeting.

### Reordering the tabs for documents, presentations, and whiteboards

The tabs in the content viewer are arranged in the order you open them. That order may not be the most logical way to display them. You can easily move the tabs, so the most current and important items are visible.

**To reorder the tabs in the content viewer:**

1. Right-click any tab.

2. In the Reorder View Tabs dialog box, use the arrows change the order of the tabs. Moving a tab up in the order moves that tab to the left in the content viewer.

3. Click **OK**.

**Tip** To quickly move a tab to the left or right, select the tab and use a drag and drop operation to move it.

### Saving, opening, and printing presentations, documents, or whiteboards

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>save a shared document, presentation, or whiteboard to a file</td>
<td><strong>Saving a presentation, document, or whiteboard</strong> on page 90</td>
</tr>
<tr>
<td>open a saved document, presentation, or whiteboard, either in a training session or outside of a training session</td>
<td><strong>Opening a saved document, presentation, or whiteboard</strong> on page 90</td>
</tr>
<tr>
<td>print a shared document, presentation, or whiteboard that appears in the content viewer</td>
<td><strong>Printing presentations, documents, or whiteboards</strong> on page 91</td>
</tr>
</tbody>
</table>
Saving a presentation, document, or whiteboard

You can save any shared document, presentation, or whiteboard that appears in the content viewer. A saved file contains all the pages or slides in the document, presentation, or whiteboard that is currently displayed in the content viewer, including any annotations and pointers that you or other attendees added to them.

Files that you save are in the Universal Communications Format (UCF), which have a .ucf extension. You can open a .ucf file either in another training session or at any time outside of a training session.

Once you save a new document, presentation, or whiteboard to a file, you can save it again to overwrite the file or save a copy to another file.

To save a new document, presentation, or whiteboard that appears in the content viewer:

   
The Save Document As dialog box appears.
2. Choose a location at which to save the file.
3. Type a name for the file in the File name box.

To save changes to a saved document, presentation, or whiteboard that appears in the content viewer:

   
   Meeting Manager saves the changes to the existing file.

To save a copy of a document, presentation, or whiteboard:

1. On the File menu, choose Save As > Document.
   
The Save Document As dialog box appears.
2. Do either or both of the following:
   
   ■ Type a new name for the file.
   
   ■ Choose a new location at which to save the file.
3. Click Save.

Opening a saved document, presentation, or whiteboard

If you saved a document, presentation, or whiteboard that appeared in the content viewer during a training session, you can do either of the following:

■ Open file in the content viewer during another training session for sharing. Only a presenter or attendees who have the Share documents privilege can open a saved file during a training session.

■ Open the file at any time on your computer's desktop. If you open a saved file on your desktop, it appears in the WebEx Document Manager, a standalone, or
“offline,” version of the content viewer.

A saved document, presentation, or whiteboard is in the saved Universal Communications Format (UCF) and has a .ucf extension.

To open a saved document, presentation, or whiteboard file in the content viewer:

   - The Open Document dialog box appears.
2. Select the document, presentation, or whiteboard file that you want to open.
3. Click Open.

To open a saved document, presentation, or whiteboard on your computer’s desktop:

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document Viewer.

Printing presentations, documents, or whiteboards

You can print any shared presentations, documents, or whiteboards that appear in your content viewer. A printed copy of shared content includes all annotations and pointers that you or other attendees added to it.

To print shared content:

1. In the content viewer, select the tab for the document, presentation, or whiteboard that you want to print.
3. Select the printing options that you want to use, and then print the document.

Note: When printing shared content in the content viewer, Meeting Manager resizes it to fit on the printed page. However, for whiteboards, the Meeting Manager prints only the content that lies within the dashed lines on the whiteboard.
Sharing UCF multimedia

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of UCF multimedia sharing</td>
<td>About sharing UCF multimedia on page 93</td>
</tr>
<tr>
<td>share UCF multimedia presentations</td>
<td>Sharing UCF multimedia presentations on page 97</td>
</tr>
<tr>
<td>share UCF standalone media files</td>
<td>Sharing standalone UCF media files on page 98</td>
</tr>
<tr>
<td>learn more about how UCF sharing works</td>
<td>Guidelines for sharing UCF multimedia on page 101</td>
</tr>
<tr>
<td>learn how to share UCF multimedia effectively</td>
<td>Tips for sharing UCF media files on page 102</td>
</tr>
</tbody>
</table>

About sharing UCF multimedia

During a training session, you can share these types of media files in the content viewer:

- WebEx Recording Format (WRF) files
- Video files
- Audio files
- Flash movie and interactive Flash files
- Web pages

You can share media files in either of two ways:

- **In a Microsoft PowerPoint presentation** — You can share media files that play on Microsoft PowerPoint slides. Using the WebEx Universal Communications Toolkit, a plug-in for Microsoft PowerPoint, you can insert UCF media objects into your slides. Depending on the options you choose in the toolkit, the media object can either
link to a media file that resides on your computer, another computer on your local network, or a remote server

contain a media file as part of your presentation file

You can download the Universal Communications Toolkit from your training session service Web site. For information about using the Universal Communications Toolkit, refer to the guide *Getting Started with WebEx Universal Communications Toolkit*, which is available on your Training Center Web site.

- **As a standalone file**—You can share a media file directly in the content viewer. Training Manager creates a UCF media object for the file automatically, which appears in the content viewer.

A UCF media object contains options and controls that you can use to display or manipulate its associated media file.

For more information about how UCF works, see *Guidelines for sharing UCF multimedia* on page 101.

### How UCF multimedia sharing works

When you share a media file, either as part of a PowerPoint presentation or as a standalone media file, a UCF media object appears in your content viewer. This media object displays the media file and the player controls necessary for playing and manipulating the file.

For a media object to display playback controls for a media file, your computer must have the appropriate player installed on it. Your Training Center software includes a built-in player for some media types; other media types require separate players installed on your computer and all participants' computers. All participants also need the appropriate player to view a media file that you share. For information about which media objects require a separate player, see *System requirements for UCF multimedia* on page 95.

A media object also specifies the location of the media file that is associated with it:

- If you share a multimedia presentation in which you chose to link the media file to a media object, the object specifies the location of the media file. The file can reside on either a local computer or remote server on the Internet.

- If you share a multimedia presentation in which you chose to embed the media file, the object contains the media file itself.

- If you share a standalone media file, which is not part of a PowerPoint presentation, the object specifies the location of the file. The file can reside on a local computer.
Once you start playback of a media file, Training Manager on participants’ computers does one of the following, depending on the type and location of the file:

- Downloads the file and temporarily stores it in its cache.
- Streams the file from the server on which the file resides.

This table shows which types of media files are downloaded or streamed:

<table>
<thead>
<tr>
<th>File Type</th>
<th>If the file resides on a local computer and is either linked to or embedded in the presentation, it is...</th>
<th>If the file resides on a Web or streaming server on the Internet and is linked to the presentation, it is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebEx Recording Format (WRF) file</td>
<td>Streamed</td>
<td>Streamed</td>
</tr>
<tr>
<td>Audio file</td>
<td>Downloaded</td>
<td>Streamed</td>
</tr>
<tr>
<td>Video file</td>
<td>Downloaded</td>
<td>Streamed</td>
</tr>
<tr>
<td>Flash file</td>
<td>Downloaded</td>
<td>Downloaded</td>
</tr>
<tr>
<td>Web page file</td>
<td>Downloaded</td>
<td>Downloaded</td>
</tr>
</tbody>
</table>

**System requirements for UCF multimedia**

Playback of Universal Communications Format (UCF) media files requires an appropriate player on all participants’ computers. Training Manager, your training session service software, includes a built-in player for some media types; other media types require separate players installed on your computer and all participants’ computers.

Before sharing a UCF media file, ensure that both your computer and all participants’ computers have the appropriate media players installed on them. The following table shows the required media player for each type of media file.

<table>
<thead>
<tr>
<th>Media File Type</th>
<th>Required Player</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebEx Recording Format (WRF) file</td>
<td>Built-in</td>
</tr>
<tr>
<td>Audio</td>
<td>Windows Media Player 6.4 or a later version</td>
</tr>
<tr>
<td>Video</td>
<td>Windows Media Player 6.4 or a later version Macromedia Flash Player 5.0 or a later version for QuickTime movies</td>
</tr>
<tr>
<td>Flash</td>
<td>Macromedia Flash Player 5.0 or a later version</td>
</tr>
<tr>
<td>Web page</td>
<td>Microsoft Internet Explorer 6.x or a later version</td>
</tr>
</tbody>
</table>

**Note** Beta versions of media players are not supported.
### Supported UCF media file formats

You can share the following types of media files in the content viewer—either on a slide in a UCF multimedia presentation or as a standalone UCF media file.

<table>
<thead>
<tr>
<th>Media Object</th>
<th>Supported Media Formats</th>
<th>File Name Extensions</th>
<th>Required Player</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebEx Recording</td>
<td>WebEx Recording Format (WRF)</td>
<td>.wrf</td>
<td>Built in</td>
</tr>
<tr>
<td>Audio</td>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>Windows Media Player</td>
</tr>
<tr>
<td></td>
<td>Advanced Streaming Format</td>
<td>.asf</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audio for Windows (WAV)</td>
<td>.wav</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Musical Instrument Digital Interface (MIDI)</td>
<td>.mid, .midi</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Macintosh AIFF Resource</td>
<td>.aif, .aiff</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MP3 (MPEG Audio Layer)</td>
<td>.mp2, .mpv2, .mp3</td>
<td></td>
</tr>
<tr>
<td>UNIX Audio</td>
<td>.au</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound (SND)</td>
<td>.snd</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio Interchange File</td>
<td>.aif, .aiff, .aifc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video</td>
<td>Windows Media Video</td>
<td>.wmv</td>
<td>Windows Media Player</td>
</tr>
<tr>
<td></td>
<td>Advanced Streaming Format</td>
<td>.asf</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audio/Video Interleave (AVI)</td>
<td>.avi</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Moving Picture Experts Group (MPEG)</td>
<td>.mpg, .mpeg, .m1v, .mpa, .mpe</td>
<td></td>
</tr>
<tr>
<td>Video—QuickTime movies</td>
<td>Apple QuickTime</td>
<td>.mov, .qt</td>
<td>Apple QuickTime Player for Windows</td>
</tr>
<tr>
<td>Flash movies and interactive Flash</td>
<td>Macromedia Flash format</td>
<td>.swf</td>
<td>Macromedia Flash Player</td>
</tr>
<tr>
<td></td>
<td>Note Flash files must meet guidelines for UCF. For details, see Guidelines for sharing UCF multimedia on page 101</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web page</td>
<td>Any URL on the Internet or your private intranet</td>
<td>.htm, .asp, .php</td>
<td>Internet Explorer</td>
</tr>
</tbody>
</table>
Sharing UCF multimedia presentations

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of UCF multimedia presentation sharing</td>
<td>About sharing UCF multimedia presentations on page 97</td>
</tr>
</tbody>
</table>

About sharing UCF multimedia presentations

During a training session, you can share a Universal Communications Format (UCF) multimedia presentation that was created using the WebEx Universal Communications Toolkit. The WebEx Universal Communications Toolkit is a plug-in program for Microsoft PowerPoint that can help you to create engaging, content-rich UCF multimedia presentations. Using the toolkit, you can create PowerPoint slides in which you can play or display the following types of media files during an online training session:

- WebEx Recording Format (WRF) files
- Video files
- Audio files
- Flash movie and interactive Flash files
- Web pages

When you play media files in your shared slides during an online training session, playback is synchronized on all participants' computers.

You can download the Universal Communications Toolkit from your Training Center Web site. For information about using the Universal Communications Toolkit, refer to the guide Getting Started with WebEx Universal Communications Toolkit, which is also available on your Training Center Web site.

Important

- If your UCF multimedia presentation contains links to media files, rather than containing them, ensure that the media files reside at the same locations they did when you inserted their objects into your presentation. For example, if you chose an audio file that resides on your computer, ensure that the file is in the same folder path as it was when you inserted its media object.
- All participants have the necessary media player installed on their computers to play the media file. For details, see System requirements for UCF multimedia on page 95.
- Any Flash files that you want to share meet the Flash authoring guidelines. For details, see Guidelines for sharing Flash files on page 102.

To share a UCF multimedia presentation:

1. On the Share menu, choose Presentation or Document.
The Share Presentation or Document dialog box appears.

2 Select the UCF multimedia presentation that you want to share.

The presentation can be a Microsoft PowerPoint file (.ppt) or a presentation saved as a UCF file (.ucf).

3 Click Open.

Note

■ Participants can view a media file only after their computers have either downloaded the file or connected to the server on which the file resides. For information about determining when attendees can view a media file, see Determining when participants are ready to view UCF media files on page 103.

■ While sharing your presentation, you can determine the number of participants’ displays of a media file are synchronized with your display. For details, see Determining the UCF synchronization status of participants on page 104.

■ For tips that can help you to share UCF multimedia presentations more effectively, see Tips for sharing UCF media files on page 102.

Sharing standalone UCF media files

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sharing UCF standalone files</td>
<td>About sharing standalone UCF media files on page 98</td>
</tr>
<tr>
<td>share a UCF standalone file—that is, a WebEx Recording Format (WRF), audio, video, or Flash file</td>
<td>Sharing a standalone UCF media file on page 99</td>
</tr>
</tbody>
</table>

About sharing standalone UCF media files

You can share the following types of Universal Communications Format (UCF) media files in the content viewer during an online training session:

■ WebEx Recording Format (WRF) files
■ Video files
■ Audio files
■ Flash movie and interactive Flash files

For details of the file types that you can share in a training session, see Supported UCF media file formats on page 96.
When you share a media file, Training Manager automatically creates a UCF media object, which appears in the content viewer. The media object links to the media file and provides a window in which the file appears. The object also contains options and controls for displaying or manipulating the file.

When you play media files during an online training session, playback is synchronized on all participants' computers.

**Sharing a standalone UCF media file**

During an online training session, you can share a media file directly in the content viewer, and play back the media, using the built-in controls for the media object that appears in the content viewer.

---

**Important** Before sharing a media file, ensure that all participants have:

- The necessary media player installed on their computers to play the media file. For details, see System requirements for UCF multimedia on page 95.
- Any Flash files that you want to share meet the Flash authoring guidelines. For details, see Guidelines for sharing UCF multimedia on page 101.

---

**To share a UCF standalone media file:**

1. On the **Share** menu, choose **Presentation or Document**. The Share Presentation or Document dialog box appears.
2. Select the media file that you want to share.
3. Click **Open**.

---

**Note**

- Participants can view a media file only after their computers have either downloaded the file or connected to the server on which the file resides. For information about determining when attendees can view a media file, see Determining when participants are ready to view UCF media files on page 103.
- While sharing a media file, you can determine the number of participants' displays of the media file are synchronized with your display. For details, see Determining the UCF synchronization status of participants on page 104.
- For tips that can help you to share UCF media files more effectively, see Tips for sharing UCF media files on page 102.
Controlling playback of media files

When you display a media object on a shared slide you have a set of tools at your fingertips to control the display.

The table below describes these controls and tools.

<table>
<thead>
<tr>
<th>Control</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Properties]</td>
<td>Properties</td>
<td>Displays the Object Properties dialog box, on which you can view the object’s title and its associated media file’s size, duration, and location.</td>
</tr>
<tr>
<td>![Full-screen playback]</td>
<td>Full-screen playback</td>
<td>Displays the media object’s player window in a full-screen view, in which all playback controls are hidden. Not available for audio objects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To return to the content viewer, press the Esc key on your computer’s keyboard. Participants can also press Esc at any time to return to the content viewer.</td>
</tr>
<tr>
<td>![Attendee Statistics]</td>
<td>Attendee Statistics</td>
<td>Indicates how many participants’ displays of the media object are not synchronized with your display and the reasons why the displays are not synchronized.</td>
</tr>
<tr>
<td>![Play]</td>
<td>Play</td>
<td>Starts playback of the media file.</td>
</tr>
<tr>
<td>![Pause]</td>
<td>Pause</td>
<td>Pauses playback of the media file.</td>
</tr>
<tr>
<td>![Stop]</td>
<td>Stop</td>
<td>Stops playback of the media file. Subsequently clicking Play starts playback from the beginning of the file.</td>
</tr>
<tr>
<td>![Attendee Progress indicator]</td>
<td>Attendee Progress indicator</td>
<td>Indicates how many participants’ computers have downloaded the media file or connected to the Web or streaming server on which the file resides. If you start playback before all participants’ computers have downloaded the file or connected to the server, playback will not be synchronized on all participants’ screens. Click the indicator to toggle between it and the Elapsed Time and Duration indicator or the Playback Status indicator.</td>
</tr>
<tr>
<td>![Playback Status indicator]</td>
<td>Playback Status indicator</td>
<td>Available for Flash files only. Indicates the status of playback—that is, whether the Flash file is playing, paused, or stopped. Click the indicator to toggle between it and the Attendee Progress indicator.</td>
</tr>
</tbody>
</table>
Guidelines for sharing UCF multimedia

<table>
<thead>
<tr>
<th>Control</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Elapsed Time and Duration indicator" /></td>
<td>Elapsed Time and Duration indicator</td>
<td>Indicates the elapsed time during playback and the total duration of the object, in hours, minutes, and seconds. Not available for interactive Flash objects. Click the indicator to toggle between it and the Attendee Progress indicator.</td>
</tr>
<tr>
<td><img src="image" alt="Mute" /></td>
<td>Mute</td>
<td>Mutes audio during playback. If the object does not include audio, this button is not available. <strong>Important</strong> Muting audio turns off all audio from your computer’s sound card. Thus, audio in any other objects or applications is also muted until you unmute audio for the object.</td>
</tr>
<tr>
<td><img src="image" alt="Unmute" /></td>
<td>Unmute</td>
<td>Unmutes audio during playback.</td>
</tr>
<tr>
<td><img src="image" alt="Volume slider" /></td>
<td>Volume slider</td>
<td>Indicates the current volume level during playback. Drag the slider to adjust the playback volume.</td>
</tr>
<tr>
<td><img src="image" alt="Location slider" /></td>
<td>Location slider</td>
<td>Indicates the current location during playback. Drag the slider to move playback forward or backward. Not available for Flash objects.</td>
</tr>
<tr>
<td><img src="image" alt="Flash Player menu" /></td>
<td>Flash Player menu</td>
<td>Right-click a Flash object to display this menu, which provides all Flash Player controls. Available for Flash objects only.</td>
</tr>
</tbody>
</table>

Guidelines for sharing UCF multimedia

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get general guidelines for sharing UCF multimedia</td>
<td>General guidelines for sharing UCF multimedia on page 101</td>
</tr>
<tr>
<td>get guidelines for sharing Flash files</td>
<td>Guidelines for sharing Flash files on page 102</td>
</tr>
</tbody>
</table>

General guidelines for sharing UCF multimedia

If you want to share a UCF multimedia presentation in which you have created links to media files rather than embedded the files into the presentation, it is best to stream any audio or video files if they are larger than 5M B. Otherwise, the file may take an extended period of time to download to participants' computers. To stream a media file, it must reside on a Web or streaming server that is on the Internet. For more information about streamed files, see How UCF multimedia sharing works on page 94.
If you want to share one of the following types of standalone media files, and the file resides on your computer or another local computer on your network, ensure that the file is not larger than 5MB:

- Audio
- Video
- Flash

**Guidelines for sharing Flash files**

If you share a Flash file in the content viewer—either on a slide in a UCF multimedia presentation or as a standalone UCF media file—ensure that the file meets the following guidelines:

- If the Flash file will reside on a Web server, ensure that you specify any links, or “jumps” to other files—such as audio, video, or Flash files—using absolute links, not relative ones. An absolute link is a complete URL, such as http://www.mycompany.com/flash/file1.swf. In contrast, a relative link shows the path through the folder hierarchy from the main Flash file to the linked file, such as ../flash/file1.swf. If you specify relative links to files, attendees cannot view the content of those files.

- Ensure that any links that you embed in Flash content open files directly in the Flash Player window. A link to content that appears outside of the Flash Player will not appear on participants’ screens. For example, if you specify a link to a Web page in your Flash file, and the Web page opens in a browser window, the page will not appear on participants’ screens.

- Do not set the Flash file to automatically change the size of or close the Flash Player window.

- Do not embed Flash commands in Flash content itself. For example, do not create a button in Flash content that will pause or stop playback. If you use embedded commands, playback on participants’ screens will not be synchronized with the playback on your screen.

**Tips for sharing UCF media files**

The following tips can help you to share UCF multimedia presentations or standalone UCF media files more effectively:

- To ensure that participants have the appropriate players installed on their computers, you can do any of the following:
  - Request that participants install the players before the training session.
  - List the player requirements on the first slide in your presentation.
  - When scheduling the training session, select the option that requests invited attendees to run a system test before joining the training session.
- Use the content viewer annotation tools to provide additional interaction to
your presentation. However, note that you cannot annotate directly on media objects on a slide.

- If the entire media file is not visible in the UCF object window—for example, a WebEx Recording or a Web page—display the object in a full-screen view. See Controlling full-screen playback of shared UCF media files on page 112.

- When sharing any media file that includes audio—including WebEx Recording (WRF), video, or Flash files—ensure that all participants’ microphones on their phones are muted. Otherwise, participants will hear an echo in their phones. If you are using WebEx integrated teleconferencing, you can mute all participants’ microphones, using the command on the Participant menu.

- If you are using WebEx integrated teleconferencing, you can automatically mute all participants’ microphones by selecting the Mute all attendees automatically when playback begins check box in the Object Properties dialog box. You can select this option only when inserting or editing the object, using the Universal Communications Toolkit.

Determining when participants are ready to view UCF media files

When sharing a UCF multimedia presentation or standalone UCF multimedia file in the content viewer, start playback of the media file only after all participants’ computers have downloaded the media or have connected to the Web or streaming server on which the file resides; otherwise playback will not be synchronized on all participants’ screens.

To determine whether participants are ready to view a shared UCF media file:

On the Object Control Panel, check the Attendee Progress indicator.

The Attendee Progress indicator indicates how many participants’ computers have downloaded the media file or connected to the Web or streaming server on which the file resides.

**Tip** You can quickly determine whether a UCF media file has loaded in each participant’s content viewer by checking the Participant Ready indicator ☑️, which appears in the participant list. For details, see Determining whether participants can view a page or slide.
Determining the UCF synchronization status of participants

When sharing a UCF multimedia presentation or standalone UCF multimedia file in the content viewer, you can determine how many participants' displays of a media file are synchronized with your display, and, if any displays are not synchronized, the reasons why they are not synchronized.

To obtain the synchronization status of participants:

1. On the Object Control Panel, click the Attendee Statistics button.
   The Attendee Statistics dialog box appears.

2. Click OK to close the dialog box.

Tip You can quickly determine whether a UCF media file has loaded in each participant’s content viewer by checking the Participant Ready indicator, which appears in the participant list. For details, see Determining whether participants can view a page or slide on page 67.
Viewing the properties of a UCF object

When sharing a UCF media file, you can view the following properties of its UCF media object in the content viewer:

- Title
- Location of the file, if applicable
- Duration of playback, if applicable
- Size of the file
- Whether playback is set to start automatically once the slide on which the file appears is loaded on all participants’ computers
- Whether the file automatically appears in a full-screen display
- Whether all participants’ microphones are automatically muted when you begin playback

To view the properties of a UCF media object:

1. On the Object Control Panel, click the Properties button. The Object Properties dialog box appears.
2. Click OK or Cancel to close the Object Properties dialog box.

Note: You cannot edit the properties of a UCF media object in the content viewer. For information on editing the properties of a UCF media object, refer to Getting Started with WebEx Universal Communications Toolkit.

About the UCF Object Properties dialog box

The UCF Object Properties dialog box lets you view the settings for a UCF object in the content viewer.

To access this dialog box:

Share a UCF media file and then click the Properties button on the object in which it appears in the content viewer.
## Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video Object</strong></td>
<td></td>
</tr>
<tr>
<td>■ Title</td>
<td>Give a name or title to this media file.</td>
</tr>
<tr>
<td>■ Location</td>
<td>Provide the location of the video object. You can enter a URL, if the object resides on the Internet. If you are storing the object on your PC, enter the path and file name.</td>
</tr>
<tr>
<td>■ Format</td>
<td>View the format of the media file.</td>
</tr>
<tr>
<td>■ Duration</td>
<td>Check the length of time required to play back the file. This information is not available for Web page and interactive Flash objects.</td>
</tr>
<tr>
<td>■ Size</td>
<td>Check the size of the media file. This information is not available for Web page objects or any objects for which you chose a media file that resides on a remote server.</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td></td>
</tr>
<tr>
<td>■ Start playback automatically on slide display when all attendees are ready</td>
<td>Automatically start playback of the media file once you display the slide on which it appears and all participants have downloaded the file, if necessary. This option is not available for Web page objects. You set select this option only when using the Universal Communications Toolkit.</td>
</tr>
<tr>
<td>■ Full-screen display</td>
<td>Automatically display the slide in a full-screen view on your screen and all participants’ screens once you display the slide. This option is not available for audio, Flash, and Web page objects. You set select this option only when using the Universal Communications Toolkit.</td>
</tr>
<tr>
<td>■ Mute all attendees automatically when playback begins</td>
<td>Automatically mute all participants’ phone microphones once the media file starts to play. Applies only if you use integrated teleconferencing. This option is not available for Web page objects. You set select this option only when using the Universal Communications Toolkit.</td>
</tr>
</tbody>
</table>
Controlling playback of UCF WebEx files

| If you want to...          | See...                                                         |
|-----------------------------|                                                               |
| start playback of a shared UCF media file | Starting playback of shared UCF media files on page 108 |
| pause playback of a shared UCF media file  | Pausing and resuming playback of shared UCF media files on page 108 |
| stop playback of a shared UCF media file   | Stopping playback of shared UCF media files on page 109         |
| control full-screen playback of a shared UCF media file | Controlling full-screen playback of shared UCF media files on page 112 |
| move to another location in a shared UCF media file | Moving to another location in a shared UCF media file on page 110 |
| adjust the volume in a shared UCF media file  | Adjusting the volume in a shared UCF media file on page 110     |
| mute and unmute audio in a shared UCF media file | Muting and unmuting audio in a shared UCF media file on page 111 |

About controlling playback of WebEx Recording (WRF), audio, video, and Flash files

When you share a UCF media file, either on a slide in a UCF multimedia presentation or as a standalone UCF media file, its UCF media object includes playback controls in the content viewer. Depending on the type of media file you are sharing, you can:

- Start, pause, and stop playback
- Quickly move forward or backward in the media file
- Adjust the volume for, mute, and unmute audio that the file plays
- Control full-screen playback

This figure shows the control panel for WebEx Recording (WRF), audio, video, and Flash objects.

This figure shows the control panel for Web page objects.
Chapter 10: Sharing UCF multimedia

Starting playback of shared UCF media files

When sharing a UCF multimedia presentation or standalone UCF multimedia file in the content viewer, you can start playback of the following types of media files once all the participants' computers have downloaded the file:

- WebEx Recording
- Audio
- Video
- Flash

Caution: If you start playback before all participants' computers have downloaded the media file or connected to the Web or streaming server on which the file resides, playback will not be synchronized on all participants' screens.

To start playback of a shared UCF media file:

1. On the Object Control Panel, check the Attendee Statistics button.
2. Make sure that all participants' computers have finished downloading or connecting to the streaming server before starting playback.
3. Click the Play button.

Note: For a shared UCF Flash file, you can also start playback from the Flash Player menu. For more information, refer to Displaying the Flash Player menu for a shared UCF Flash file on page 112.

Pausing and resuming playback of shared UCF media files

When sharing a UCF multimedia presentation or standalone UCF multimedia file in the content viewer, you can pause playback of the following types of media files:

- WebEx Recording (WRF)
- Audio
- Video
- Flash
To pause playback of a shared UCF media file:
During playback of a media file, on the **Object Control Panel**, click the **Pause** button.

To resume playback of a shared UCF media file:
Click the **Play** button.

**Note**  For a shared UCF Flash file, you can also pause playback using the Flash Player menu. For more information, refer to Displaying the Flash Player menu for a shared UCF Flash file on page 112.

---

**Stopping playback of shared UCF media files**
When sharing a UCF multimedia presentation or standalone UCF multimedia file in the content viewer, you can stop playback of the following types of media files:

- WebEx Recording (WRF)
- Audio
- Video
- Flash

**To stop playback of a shared UCF media file:**
During playback of a media file, on the **Object Control Panel**, click the **Stop** button.

**Note**  For a shared UCF Flash file, you can also stop playback from the Flash Player menu. For more information, refer to Displaying the Flash Player menu for a shared UCF Flash file on page 112.
Moving to another location in a shared UCF media file

When sharing a UCF multimedia presentation or standalone UCF media file in the content viewer, you can fast forward or rewind playback of the following types of media files:

- WebEx Recording (WRF)
- Audio
- Video

To move to another location in a shared UCF media file:

1. On the **Object Control Panel**, drag the **Location Slider** to the specified location. The **Elapsed Time** indicator indicates the new position in the media file.
2. Click the **Play** button to resume playback.

Adjusting the volume in a shared UCF media file

When sharing a UCF multimedia presentation or standalone UCF media file in the content viewer, you can adjust the volume for playback of the following types of media files:

- WebEx Recording (WRF)
- Audio
- Video
- Flash

To adjust the volume in a shared UCF media file:

On the **Object Control Panel**, drag the **Volume Slider** to the specified location.
Chapter 10: Sharing UCF multimedia

Note Adjusting the volume in a shared UCF media file does not affect the volume on other synchronized computers.

Muting and unmuting audio in a shared UCF media file

When sharing a UCF multimedia presentation or standalone UCF media file in the content viewer, you can mute and unmute audio for the following types of media files:

- WebEx Recording (WRF)
- Audio
- Video
- Flash

Important Muting audio turns off all audio from your computer's sound card. Thus, audio in any other objects or applications is also muted until you unmute audio for the object.

To mute audio in a shared UCF media file:
On the Object Control Panel, click the Mute button.
All audio from your computer's sound card is muted.

To unmute audio in a shared UCF media file:
On the Object Control Panel, click the Unmute button.
All audio from your computer's sound card resumes.

Note Muting or unmuting audio in a shared UCF media file does not mute audio on other synchronized computers.
Controlling full-screen playback of shared UCF media files

When sharing a UCF multimedia presentation or standalone UCF multimedia file in the content viewer, you can display playback of the media file in full-screen mode on all participants' computers. In full-screen mode, you can control playback of the following types of media files using your computer's keyboard:

- WebEx Recording (WRF)
- Video
- Flash

To control full-screen playback of a shared UCF multimedia file:

1. On the Object Control Panel, click the Full-screen Playback button.
   The shared UCF media file switches to full-screen view.
2. Optional. Press Ctrl+P or Enter to play, pause, or resume playback.
3. Optional. Press Ctrl+S to stop playback.
4. Optional. Press Esc to quit full-screen view.

Tip If you are sharing a UCF multimedia presentation, you can automatically display playback of a UCF media file in a full-screen view on your screen and all participants' screens. To do so, you must use the Universal Communications Toolkit to select the Full-screen display check box in the Object Properties dialog box when creating your UCF multimedia presentation. For more information, refer to Getting Started with WebEx Universal Communications Toolkit.

Displaying the Flash Player menu for a shared UCF Flash file

When sharing a Flash file—either in a UCF multimedia presentation or as a standalone UCF media file in the content viewer—you can use the commands on the Flash Player menu to control playback or display of the file.

To display the Flash Player menu for a shared UCF Flash file:

Right-click the window in which the a shared Flash file appears.

The Flash Player menu appears, providing all Flash Player controls.
Chapter 10: Sharing UCF multimedia

Note The Flash Player menu does not appear on any other synchronized computers' screens.

Displaying a different page in a shared Web page object

If you share a Web page in a UCF multimedia presentation in the content viewer, you can display a different Web page on all participants' computers.

To display a different page in a shared Web page object:

2. In the Title text box, type the title of the new Web page.
3. In the Location text box, type the URL, or address, of the new Web page.
4. Click OK. The new Web page is displayed on all synchronized computers.

Tip

- In the Web Page Properties dialog box, the drop-down list box contains a list of
all addresses that you typed.

- When viewing a Web page object during a training session, participants can click any links on the page to view pages in the object window on the slide. However, you can return all participants to the original page that you inserted into the slide by clicking the Properties button, then typing the page's URL in the Location box.

Controlling full-screen view of UCF Web pages

**Controlling full-screen view of UCF Web pages**

If you share a Web page, either in a UCF multimedia presentation or directly in the content viewer, you can display the Web page in full-screen mode on all participants' computers.

![Full-screen Playback button](image)

**To control full-screen view of a shared UCF Web page:**

1. On the **Object Control Panel**, click the **Full-screen Playback** button.
   - The shared UCF Web page object switches to full-screen view on all participants' computers.

2. Optional. Press **Esc** to quit full-screen view.

Displaying a different page in a shared Web page object

Solving common problems with UCF media files

The following are common problems that you might encounter when sharing UCF multimedia presentations or standalone UCF media files. Click a link for detailed information.

- Shared UCF media file takes too long to download to participants' computers.
- Participants not viewing or hearing a shared UCF media file in synchronization.
- Media files in a UCF multimedia presentation do not appear in the content viewer.
- Attendees unable to share UCF media files when allowed to share presentations or documents.
- Computer does not play sound after volume is muted for a UCF multimedia object.
- Recording of shared UCF multimedia presentation or standalone media file does
not show video during playback.

- Participants cannot see all parts of shared Flash file.
- Participants hear echo of the media file’s audio in their phones.
- Recording of shared UCF multimedia presentation or standalone media file does not show video during playback.

**Shared UCF media file takes too long to download to participants' computers.**

If you are sharing an audio or video file that resides on your computer or another local computer, Training Manager on each participant's computer must download the entire file before playback begins in his or her content viewer. However, if the file resides on a Web or streaming server on the Internet, Training Manager can stream the file, allowing participants to view or hear the media much more quickly.

For audio and video files, it is best to stream them if they are larger than 5MB.

For more information about downloaded and streamed files, see Guidelines for sharing UCF multimedia on page 101.

- **Participants not viewing or hearing a shared UCF media file in synchronization.**

Ensure that start playback of the media file only after all participants have downloaded the file or connected to the Web server on which the file resides. You can determine when participants are ready to view or hear the media. For details, see Determining when participants are ready to view UCF media files on page 103.

- **Media files in a UCF multimedia presentation do not appear in the content viewer.**

  - **Solution 1:** To share a UCF multimedia presentation, which contains inserted media objects, you must use the Universal Communications Format (UCF). For details about selecting an import mode, see Choosing an import mode for document or presentation sharing on page 68.

  - **Solution 2:** You might have changed the location of the media file since you saved the UCF multimedia presentation. Using the WebEx Universal Communications Toolkit, edit the properties of the inserted object to correct the path to the file. For instructions, refer to Getting Started with WebEx Universal Communications Toolkit.

  - **Solution 3:** If at least one participant is using the Java Training Manager, UCF multimedia is not available. To share UCF multimedia, ensure that no participants are using the Java Training Manager. The training session host can prevent participants from joining a training session using the Java Training Manager when scheduling the training session.

- **Attendees unable to share UCF media files when allowed to share presentations or documents.**
Chapter 10: Sharing UCF multimedia

If an attendee with the Share documents privilege or a presenter who is not also the training session host cannot share a UCF multimedia presentation or standalone UCF media file, the training session host may not have selected the option to allow attendees to share UCF multimedia when scheduling the training session. Normally, this option is selected by default.

- **Computer does not play sound after volume is muted for a UCF multimedia object.**

  If you mute volume for a UCF multimedia object, all audio from your computer’s sound card is muted. To unmute audio, click the Unmute button on the Playback Control Panel. For more information, refer to Muting and unmuting audio in a shared UCF media file on page 111.

- **Recording of shared UCF multimedia presentation or standalone media file does not include audio.**

  To record audio in a shared UCF multimedia presentation or standalone media file, using WebEx Recorder, you must use an audio input device that sends bidirectional audio signals to and from your computer’s sound card and your phone. For details, refer to the WebEx Recorder and Player User’s Guide.

- **Participants cannot see all parts of shared Flash file.**

  Ensure that the Flash file meets the Flash file guidelines for UCF. For details, see Guidelines for sharing UCF multimedia on page 101.

- **Participants hear echo of the media file’s audio in their phones.**

  When sharing any slide that includes audio—including an audio WebEx Recording (WRF), video, or Flash object—ensure that all participants’ microphones on their phones are muted. Otherwise, participants will hear an echo in their phones. If you are using integrated teleconferencing, you can mute all participants’ microphones, using the command on the Participant menu.

- **Recording of shared UCF multimedia presentation or standalone media file does not show video during playback.**

  If you want to use WebEx Recorder to record a shared UCF multimedia presentation or standalone media file that includes video, you must ensure that hardware acceleration—also called video overlay—is turned off on your computer’s video card. To turn off hardware acceleration, you can use Windows Media Player. Refer to Windows Media Player Help for instructions on using the hardware acceleration option.

**Converting document or presentation files to UCF**

Once you share a document or presentation in a training session, Training Manager automatically converts it to the Universal Communications Format (UCF). During the training session, you can save the shared document or presentation to a UCF file, which has a .ucf extension.
You may want to convert a document or presentation file to UCF before you share it in a training session for the following reasons:

- You can share the document or presentation much more quickly, because Training Manager does not need to convert it to UCF when loading it into the content viewer. Thus, you can improve the performance of document or presentation sharing by converting the document or presentation to UCF before you share it with attendees in a training session.
- If you are the training session host, when scheduling a training session, you can select a UCF file to share automatically once a participant joins the training session.

**To convert any document or presentation to UCF:**

1. Before the training session in which you want to share a document or presentation with attendees, start a “practice” training session.
2. On the Share menu, choose Share Presentation or Document, and share the document or presentation.
3. Once the document or presentation is loaded in the content viewer, on the File menu, choose Save to save the document or presentation as a .ucf file on your computer.
4. Later, start your actual training session and share the .ucf file that you saved in your practice training session.

**To convert Microsoft PowerPoint presentations to UCF:**

1. Install the WebEx Universal Communications Toolkit, which is a plug-in for Microsoft PowerPoint.
2. Using the toolkit in Microsoft PowerPoint, save the presentation as a UCF file.

**Note** The WebEx Universal Communications Toolkit is available on your Training Center Web site. For more information about using the toolkit refer to the guide Getting Started with WebEx Universal Communications Toolkit, which is also available on your site.
## Sharing Software

### If you want to... | See...
--- | ---
get an overview of sharing software | *About sharing software* on page 119
share applications | *About sharing applications* on page 120
share your entire computer’s desktop | *About sharing your desktop* on page 125
share a Web browser | *About sharing a Web browser* on page 127
share a remote computer | *About sharing a remote computer* on page 128
control attendees’ views of shared software | *Controlling views of shared software* on page 136
annotate shared software, and let attendees annotate the shared software | *Annotating Shared Software* on page 141
let attendees control the software that you share | *Allowing remote control of shared software* on page 147
learn how to share software effectively | *Tips for Sharing Software* on page 152

### About sharing software

You can share the following software during a training session:

- Applications on your computer
- Your computer’s desktop
- Your Web browser
- Applications or the desktop on a remote computer, if you installed the Access Anywhere Agent on the computer
Attendees can view all actions that you take with the shared software. You can also:

- Control attendees' views of the shared software
- Annotate the software
- Let an attendee annotate the software
- Let an attendee control the software remotely

**Note**  You cannot annotate or let an attendee remotely control a shared remote computer.

---

### Sharing applications

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of</td>
<td>About sharing applications on page 120</td>
</tr>
<tr>
<td>application sharing</td>
<td></td>
</tr>
<tr>
<td>start sharing an</td>
<td>Starting application sharing on page 121</td>
</tr>
<tr>
<td>application</td>
<td></td>
</tr>
<tr>
<td>share multiple</td>
<td>Sharing multiple applications on page 122</td>
</tr>
<tr>
<td>applications simultaneously</td>
<td></td>
</tr>
<tr>
<td>stop sharing an</td>
<td>Stopping application sharing on page 123</td>
</tr>
<tr>
<td>application</td>
<td></td>
</tr>
<tr>
<td>control views of shared</td>
<td>Controlling views of shared software on page 136</td>
</tr>
<tr>
<td>applications</td>
<td></td>
</tr>
<tr>
<td>annotate a shared</td>
<td>About annotating shared software on page 142</td>
</tr>
<tr>
<td>application</td>
<td></td>
</tr>
<tr>
<td>let an attendee annotate a</td>
<td>Letting an attendee annotate shared software on page 145</td>
</tr>
<tr>
<td>shared application</td>
<td></td>
</tr>
<tr>
<td>let an attendee remotely</td>
<td>About letting an attendee remotely control shared software on page 148</td>
</tr>
<tr>
<td>control a shared</td>
<td></td>
</tr>
<tr>
<td>application</td>
<td></td>
</tr>
<tr>
<td>share graphics-intensive</td>
<td>Specifying the display mode for shared software on page 150</td>
</tr>
<tr>
<td>applications</td>
<td></td>
</tr>
<tr>
<td>learn how to share</td>
<td>Tips for Sharing Software on page 152</td>
</tr>
<tr>
<td>applications effectively</td>
<td></td>
</tr>
</tbody>
</table>

### About sharing applications

Use application sharing to show all training session attendees one or more applications on your computer. Use application sharing for demonstrating software or editing documents during a training session.

Attendees can view the shared application, including all your mouse movements, in a sharing window on their screens. Attendees need not run the application that you are sharing on their computers.
When sharing an application, you can:

- Control attendees’ view of the application
- Annotate the application
- Let an attendee control the application remotely
- Let an attendee annotate the application remotely

**Starting application sharing**

You can share any application on your computer with training session attendees.

**To share an application:**

1. On the **Share** menu, choose **Application**.
   
The Share Application dialog box appears, showing a list of all applications currently running on your computer.

![Select Application dialog box](image)

2. Do one of the following:
   
   - If the application you want to share is currently running, select it in the list, and then click **Share**.
   
   - If the application you want to share is not currently running, click **New Application**. The New Application dialog box appears, showing a list of all applications on your computer. Select the application, and then click **Share**.
   
   Your application appears in a sharing window on attendees’ screens.

**Tip** For tips that can help you to share applications more effectively, see **Tips for Sharing Software** on page 152.
Chapter 11: Sharing Software

Sharing multiple applications

If you are already sharing an application, you can share additional applications simultaneously. Each application that you share appears in the same sharing window on attendees’ screens.

To share an additional application:

1. Do one of the following:
   - On the icon tray, click the Select Panel button.
   - On the title bar of the application that you are currently sharing, click the Sharing menu.
   - In the lower-right corner of your computer’s desktop, click the Sharing menu.

2. On the menu that appears, choose Share Application.
   The Share Application dialog box appears, showing a list of all applications that are currently running on your computer.

3. Do one of the following:
If the application you want to share is currently running, select it in the list, and then click **Share**.

If the application you want to share is not currently running, click **New Application**. The New Application dialog box appears, showing a list of all applications on your computer. Select the application, and then click **Share**. Your application appears in a sharing window on attendees’ screens.

**Important** If you close the Share Application dialog box, all application sharing stops. Instead, minimize the dialog box to continue sharing the current application.

**Tip** Alternatively, you can share multiple applications by sharing your computer’s desktop. For details, see About sharing your desktop on page 125.

### Stopping application sharing

You can stop sharing an application at any time. Once you stop sharing an application, attendees can no longer view it.

If you are sharing multiple applications simultaneously, you can stop sharing either a specific application or all applications at once.

**To stop sharing a specific application when sharing multiple applications:**

1. On the title bar of the application that you are currently sharing, on the **Sharing** menu, choose **Share Application**.

The Share Application dialog box appears. A check mark appears to the left of each application that you are currently sharing. For example:
2 In the list of applications, select the application that you no longer want to share to highlight it.

3 Click **Stop Sharing**.

**To stop all application sharing:**

1 Do either of the following:

   - On the title bar of the application that you are currently sharing, click the **Sharing** menu.

   - In the lower-right corner of your computer’s desktop, click the **Sharing** menu.

2 On the menu that appears, choose **Exit Application Sharing**.

**Tip** You can temporarily pause application sharing, rather than stopping application sharing. For details, see Pausing and resuming software sharing on page 136.
Sharing your desktop

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of desktop sharing</td>
<td>About sharing your desktop on page 125</td>
</tr>
<tr>
<td>start sharing your desktop</td>
<td>Starting desktop sharing on page 125</td>
</tr>
<tr>
<td>stop sharing your desktop</td>
<td>Stopping desktop sharing on page 126</td>
</tr>
<tr>
<td>control views of a shared desktop</td>
<td>About controlling views of shared software on page 136</td>
</tr>
<tr>
<td>annotate a shared desktop</td>
<td>About annotating shared software on page 142</td>
</tr>
<tr>
<td>let an attendee annotate a shared desktop</td>
<td>Letting an attendee annotate shared software on page 145</td>
</tr>
<tr>
<td>let an attendee remotely control a shared desktop</td>
<td>About letting an attendee remotely control shared software on page 148</td>
</tr>
<tr>
<td>share graphics-intensive applications during desktop sharing</td>
<td>Specifying the display mode for shared software on page 150</td>
</tr>
<tr>
<td>learn how to share desktops effectively</td>
<td>Tips for Sharing Software on page 152</td>
</tr>
</tbody>
</table>

About sharing your desktop

Use desktop sharing to show all training session attendees your entire computer desktop—including any applications, windows, and file directories that are currently open. Use desktop sharing to share several applications simultaneously or to share other areas of your computer, such as your file directories.

Attendees can view your shared desktop, including all your mouse movements, in a sharing window on their screens.

When sharing your desktop, you can:

- Control attendees’ view of your desktop
- Annotate your desktop
- Let an attendee control your desktop and all applications remotely
- Let an attendee annotate your desktop remotely

Starting desktop sharing

You can share your computer's desktop with training session attendees.

To share your desktop:

On the Share menu, choose Desktop.

Your desktop appears in a sharing window on attendees’ screens.
Chapter 11: Sharing Software

**Note** If your desktop has any background images or patterns, or wallpaper, your Training Manager software may remove them from attendees’ views to improve the performance of desktop sharing.

**Tip** For tips that can help you to share your desktop more effectively, see Tips for Sharing Software on page 152.

**Stopping desktop sharing**

You can stop desktop sharing at any time.

**To stop desktop sharing.**

1. Do either of the following:
   - On the title bar of any open window, click the **Sharing** menu.
   - In the lower-right corner of your computer’s desktop, click the **Sharing** menu.

2. On the menu that appears, choose **Exit Desktop Sharing**.

**Tip** You can temporarily pause desktop sharing, rather than stopping desktop sharing. For details, see Pausing and resuming software sharing on page 136.

**Sharing a Web browser**

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Web browser sharing</td>
<td><em>About sharing a Web browser on page 127</em></td>
</tr>
<tr>
<td>start sharing a Web browser</td>
<td><em>Starting Web browser sharing on page 127</em></td>
</tr>
<tr>
<td>stop sharing a Web browser</td>
<td><em>Stopping Web browser sharing on page 127</em></td>
</tr>
<tr>
<td>control views of a shared Web browser</td>
<td><em>About controlling views of shared software on page 136</em></td>
</tr>
</tbody>
</table>
Chapter 11: Sharing Software

**About sharing a Web browser**

Use Web browser sharing to show all training session attendees all Web pages that you access in your browser. Use Web browser sharing to show attendees Web pages on the Internet, your organization's private intranet, or your computer.

Attendees can view your Web browser, including your mouse movements, in a sharing window on their screens.

When sharing your Web browser, you can:

- Control attendees' views of your browser
- Annotate your browser
- Let an attendee control your browser remotely.
- Let an attendee annotate your browser remotely

**Starting Web browser sharing**

You can share a Web browser with training session attendees.

**To share a Web browser:**

1. On the **Share** menu, choose **Web Browser**.
   
   Your default Web browser opens.

2. Go to a Web page in your browser.

**Note** Attendees can view any new Web browser windows that you open. Thus, attendees can view several Web pages simultaneously.

**Stopping Web browser sharing**

You can stop sharing a Web browser at any time.

**To stop Web browser sharing:**

1. Do either of the following:

---

**If you want to...** | **See...**
--- | ---
annotate a shared Web browser | *About annotating shared software on page 142*
let an attendee annotate a shared Web browser | *Letting an attendee annotate shared software on page 145*
let an attendee remotely control a shared Web browser | *About letting an attendee remotely control shared software on page 148*
learn how to share Web browsers effectively | *Tips for Sharing Software on page 152*
On the title bar of the browser that you are sharing, click the **Sharing** menu.

In the lower-right corner of your computer’s desktop, click the **Sharing** menu.

2. On the menu that appears, choose **Exit Web Browser Sharing**.

**Tip** You can temporarily pause Web browser sharing, rather than stopping Web browser sharing. For details, see Pausing and resuming software sharing on page 136.

---

**Sharing a remote computer**

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of remote computer sharing</td>
<td>About sharing a remote computer on page 128</td>
</tr>
<tr>
<td>start sharing a remote computer</td>
<td>Starting remote computer sharing on page 129</td>
</tr>
<tr>
<td>stop sharing a remote computer</td>
<td>Stopping remote computer sharing on page 131</td>
</tr>
<tr>
<td>control views of a shared remote computer</td>
<td>About controlling views of shared software on page 136</td>
</tr>
<tr>
<td>manage settings on a remote computer while sharing it</td>
<td>About managing a shared remote computer on page 132</td>
</tr>
</tbody>
</table>

**About sharing a remote computer**

Use remote computer sharing to show all training session attendees a remote computer. Depending on how you set up the remote computer, you can show the entire desktop or just specific applications. Use remote computer sharing to show attendees an application or file that is available only on a remote computer.

Attendees can view your remote computer, including all your mouse movements, in a sharing window on their screens.
You can share a remote computer during a training session for which you are the presenter, if:

- You have installed the Access Anywhere Agent on the remote computer
- You logged in to your Training Center Web site before joining the training session, if you are not the original training session host

For information about setting up a computer so you can access it remotely, refer to the Access Anywhere User’s Guide.

Starting remote computer sharing

If you have already set up a computer for Access Anywhere, you can share the computer during a training session.

To share a remote computer:

   The Access Anywhere dialog box appears.

2. Under Remote Computers, select the computer that you want to share.

3. Under Applications, select an application that want to share.
   If you set up the remote computer so you can access its entire desktop, the option Desktop appears under Applications.

4. Click Connect.
   Depending on the method of authentication that you specified when setting up the computer for Access Anywhere, one of the following occurs:
   - If you chose access code authentication, a dialog box appears, in which you must provide the access code that you specified when setting up the remote computer.
If you chose phone authentication, you receive a phone call at the number that you specified when setting up the remote computer.

Do one of the following:

- If you chose access code authentication, type your access code in the box, and then click **OK**.
- If you chose phone authentication, provide your pass code by following the voice instructions.

---

**Note**

- If you are not the original training session host, you must log in to your Training Center Web site before joining a training session in which you want to share a remote computer. If you are already in a training session, but did not log in to your site, you must leave the training session, log in to your site, and then rejoin the training session.
- If a password-protected screen saver is running on the remote computer, your training session service automatically closes it once you provide your access code or pass code.
- If the remote computer is running Windows NT or 2000, and you must log in to the computer, send a **Ctrl+Alt+Del** command to the computer.
- If you set up the remote computer so you can access multiple applications, you can share additional applications simultaneously.

---

**Sharing additional applications on a shared remote computer**

While sharing a remote computer on which you have specified that you can access only specific applications rather than its entire desktop, you can share additional applications on the remote computer. Training Session attendees can view all shared applications simultaneously.

**To share an additional application on a shared remote computer:**

1. On the title bar of the Access Anywhere window, on the **Access Anywhere** menu, choose **Share Remote Application**:

   ![Access Anywhere](image)

   The Select Application dialog box appears.
2 In the list, select the remote application that you want to share.

3 Click **OK**.

### Stopping remote computer sharing

You can stop sharing a remote computer during a training session at any time. Once you stop sharing a remote computer, the Access Anywhere Server disconnects your local computer from the remote computer. The remote computer remains logged into the Access Anywhere Server, so you can access it again at any time.

**Before you stop remote computer sharing:**

To ensure your privacy and the security of your remote computer, do one of the following:

- Close any applications that you started during the sharing session.
- If the remote computer is running Windows NT or 2000, and you have administrator rights on the computer, log off from or lock the computer. To access these options on the computer, send a `Ctrl+Alt+Del` key combination to the remote computer. For details, see Sending a `Ctrl+Alt+Del` command to a shared remote computer on page 135.
- Specify a screen saver password, and set the screen saver to appear after short period of inactivity—for example, 1 minute.
- Shut down the computer, if you do not plan to access it again remotely.

**To stop remote computer sharing:**

1 On the title bar of the Access Anywhere window, click the **Access Anywhere** menu.
Chapter 11: Sharing Software

2  Do one of the following

- If you are sharing the remote computer’s entire desktop, choose **Stop Remote Desktop Sharing**.
- If you are sharing an application on the remote computer, choose **Stop Remote Application Sharing**.

**Managing a shared remote computer**

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing a shared remote computer</td>
<td>About managing a shared remote computer on page 132</td>
</tr>
<tr>
<td>reduce the screen resolution on a shared remote computer so you can view its contents without scrolling</td>
<td>Reducing the screen resolution for a shared remote computer on page 133</td>
</tr>
<tr>
<td>adjust the size of the view of a shared remote computer, including zooming in to and out from the view and scaling the view to fit the sharing window</td>
<td>Adjusting the size of the view of a shared remote computer on page 133</td>
</tr>
<tr>
<td>lock a shared remote computer’s keyboard and mouse</td>
<td>Disabling and enabling the keyboard and mouse during on a shared remote computer on page 134</td>
</tr>
<tr>
<td>make the screen on a shared remote computer blank, so no one at the computer’s location can view it</td>
<td>Hiding the contents on a shared remote computer’s screen on page 134</td>
</tr>
<tr>
<td>send a Ctrl+Alt+Del command to a Windows 2000 or NT computer, to display the Windows Security dialog box</td>
<td>Sending a Ctrl+Alt+Del command to a shared remote computer on page 135</td>
</tr>
<tr>
<td>display an application window that is hidden behind another window on a shared remote computer</td>
<td>Bringing an application to the front on a shared remote computer on page 135</td>
</tr>
</tbody>
</table>

**About managing a shared remote computer**

While sharing a remote computer during a training session, you can manage the remote computer by setting options and sending commands.

**Options that you can set:**

- Disable or enable the keyboard and mouse on the remote computer.
- Reduce the screen resolution on the remote computer to match that of your computer, or restore the resolution on the remote computer.
- Adjust the size of the view of the remote computer that appears in the sharing window, including zooming in to and out from the view and scaling the view to fit the sharing window.
- Hide or display the contents on the remote computer’s screen at the remote location.
Chapter 11: Sharing Software

Note  Any changes that you make to options affect the remote computer only during the current sharing session. The changes do not affect the default options that you set for the remote computer in the Access Anywhere Agent preferences.

Commands that you can send:

■ A Ctrl+Alt+Del key combination, which allows you to access options to log in to, log out from, lock, or unlock a Windows NT or 2000 computer.

■ A command to bring remote applications to the front of your screen, if they are either behind other applications or minimized.

Reducing the screen resolution for a shared remote computer

While sharing a remote computer, you can reduce the screen resolution on the remote computer. This option helps to prevent the need to scroll while viewing the desktop or applications on the remote computer. The reduced screen resolution also appears in all attendees' sharing windows. You can return a remote computer's screen resolution to its original setting at any time during a remote access session.

To reduce the screen resolution on a remote computer:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, choose Remote Computer > Reduce Screen Resolution to Match This Computer.

A check mark next to the command indicates that the screen resolution is reduced. If no check mark appears, the screen resolution is at its original setting.

Note  ■ If you reduce the screen resolution a remote computer during a sharing session, the Access Anywhere Agent restores the resolution to its original setting once you end the session.

■ You can specify whether or not the remote computer's screen resolution is reduced automatically once you connect to the computer remotely. For details, refer to the Access Anywhere User’s Guide.

Adjusting the size of the view of a shared remote computer

While sharing a remote computer, you can adjust the size of the shared view by doing any of the following:

■ Select a preset percentage at which to view the remote computer.

■ Zoom in to and out from the remote computer in increments.

■ Scale the remote computer view to fit the sharing window in which it appears.
To adjust the size of the view of a shared remote computer:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, choose View, and then choose a display option.

Disabling and enabling the keyboard and mouse during on a shared remote computer

While sharing a remote computer, you can disable the keyboard and mouse on the remote computer, thereby preventing anyone from using the computer while you are accessing it remotely. You can re-enable a remote computer's keyboard and mouse at any time.

To disable or enable a remote computer's keyboard and mouse:


A check mark next to the command indicates that the keyboard and mouse are disabled. If no check mark appears, the keyboard and mouse are enabled.

Note

- If you disable a remote computer's keyboard and mouse during a sharing session, the Access Anywhere Agent re-enables them once you end the session.
- You can specify whether or not the remote computer's keyboard and mouse are disabled automatically once you connect to the computer remotely. For details, refer to the Access Anywhere User's Guide.

Hiding the contents on a shared remote computer's screen

While sharing a remote computer, you can make a remote computer's screen blank, thereby preventing anyone at the remote computer's location from viewing the contents of the screen. If the contents on a remote computer's screen are hidden, you can display them at any time.
To hide or display the contents on a remote computer's screen:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, choose **Remote Computer > Make Screen Blank**.

A check mark next to the command indicates that the contents on the remote computer’s screen are not visible. If no check mark appears, the contents on the remote computer's screen are visible.

**Note**

- If you make a remote computer's screen blank during a sharing session, the Access Anywhere Agent displays the contents on the screen once you end the session.
- You can specify whether or not a remote computer's screen becomes blank automatically once you connect to the computer remotely. For details, refer to the Access Anywhere User’s Guide.

**Sending a Ctrl+Alt+Del command to a shared remote computer**

While sharing a remote computer that is running Windows NT or 2000, you can send an **Ctrl+Alt+Del** command to the computer to access options that let you:

- Log in to the computer
- Log out from the computer
- Lock the computer
- Unlock the computer

To send a Ctrl+Alt+Del command to a shared remote computer:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, choose **Remote Computer > Send Ctrl+Alt+Del**.

**Bringing an application to the front on a shared remote computer**

While sharing a remote computer, you can restore a remote application that is minimized, or display a remote application that is behind another window that you cannot control. This option is available only if you set up a remote computer so you can access specific applications rather than the entire desktop.

To bring a remote application to the front:

On the title bar of the Access Anywhere window, on the Access Anywhere menu, choose **Remote Computer > Bring Shared Application to Front**.

The application that you are accessing remotely appears in the Access Anywhere window.
Chapter 11: Sharing Software

Controlling views of shared software

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of controlling views of shared software</td>
<td>About controlling views of shared software on page 136</td>
</tr>
<tr>
<td>pause and resume software sharing</td>
<td>Pausing and resuming software sharing on page 136</td>
</tr>
<tr>
<td>control full-screen view of shared software</td>
<td>Controlling full-screen view of shared software on page 138</td>
</tr>
<tr>
<td>synchronize attendees’ views of shared software with your view</td>
<td>Synchronizing attendees’ views of shared software on page 139</td>
</tr>
<tr>
<td>help attendees control and adjust their views of shared software</td>
<td>Helping attendees to control their views of shared software on page 139</td>
</tr>
<tr>
<td>display the Session window while sharing software</td>
<td>Returning to the Session window while sharing software on page 140</td>
</tr>
<tr>
<td>return attendees to a view of shared software</td>
<td>Returning attendees to the software sharing window on page 141</td>
</tr>
</tbody>
</table>

About controlling views of shared software

You can control attendees’ views of the following types of shared software:

- Applications
- Desktop
- Web browser
- Remote computer

While sharing software, you can control attendees’ views by doing any of the following:

- Temporarily pause, and then resume software sharing
- Display shared software in a full-screen view
- Synchronize all attendees’ views of shared software
- Display the Session window on attendees’ screens and hide the sharing window
- Return attendees from the Session window to their sharing windows

Pausing and resuming software sharing

While sharing software, you can temporarily pause sharing to freeze attendees’ views of the following types of shared software:

- Application
- Desktop
- Web browser
Chapter 11: Sharing Software

If you want to return attendees to the Session window while sharing software, pausing shared software conserves resources on your computer and bandwidth for your Internet connection. This option is also useful if you do not want attendees to see certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

**To pause software sharing:**

1. Do either of the following:
   - In the title bar of a window that you are sharing, click the **Sharing** menu.
   - In the lower-right corner of your desktop, click the **Sharing** menu.

2. On the menu that appears, choose **Pause Sharing**.
   
The **Sharing** menu on the title bar of shared windows indicates that sharing is paused.

**To resume software sharing:**

1. Do either of the following:
   - In the title bar of a window that you are sharing, click the **Sharing** menu.
   - In the lower-right corner of your desktop, click the **Sharing** menu.

2. On the menu that appears, choose **Resume Sharing**.
Controlling full-screen view of shared software

You can switch attendees' views of the following types of shared software between a standard window and a full-screen view:

- Application
- Desktop
- Web browser
- Remote computer

A full-screen view of shared software fits attendees' entire screens and does not include a title bar or scroll bars.

Attendees can override your setting to control full-screen view or to zoom in or out on the shared software on their computers.

To display shared software in a full-screen view:
1. Do either of the following:
   - In the title bar of a window that you are sharing, click the **Sharing** menu.
   - In the lower-right corner of your desktop, click the **Sharing** menu.

2. On the menu that appears, choose **Views > Show Full-Screen View for Attendees**.

To display shared software in a standard window:
1. Do either of the following:
   - In the title bar of a window that you are sharing, click the **Sharing** menu.
   - In the lower-right corner of your desktop, click the **Sharing** menu.

If you are sharing a remote computer, the **Access Anywhere** menu appears instead of the **Sharing** menu.
2 On the menu that appears, choose Views > Restore View for Attendees.

**Synchronizing attendees’ views of shared software**

While sharing the following types of software, you can synchronize all attendees’ views of the software with your view:

- Application
- Desktop
- Web browser

Synchronizing views of shared software ensures that the sharing window appears as the active window on attendees’ screens. For example, if an attendee has minimized the sharing window, or moved another window on top of it, the sharing window becomes the active window when you synchronize views.

**Note** Synchronizing views has no effect on the size in which the shared software appears on attendees’ screens. Attendees can control the size of their views independently.

**To display shared software in a full-screen view:**

1 Do either of the following:

- In the title bar of a window that you are sharing, click the Sharing menu.
- In the lower-right corner of your desktop, click the Sharing menu.

2 On the menu that appears, choose Views > Synchronize Views.

**Helping attendees to control their views of shared software**

When you are sharing software, attendees can control the size in which the shared software appears on their screens. For example, if an attendee cannot see all of the shared software, he or she can reduce the size of their view.
To control their views of shared software, attendees can:

- Display the shared software in a full-screen view or a standard window. A full-screen view of a shared application or desktop fits your entire screen and does not include a title bar or scroll bars.
- Zoom in or out on the shared software by preset percentages.
- Scale, or resize, a shared desktop or application to fit the sharing window (viewer) or the width of their computer screens.

**To help attendees to control their views of shared software:**

1. Tell attendees to do either of the following:
   - On the icon tray, click the **Select Panel** button.
   - In the title bar of the sharing window, click the **Sharing** button.

2. On the menu that appears, choose **View**, then choose an option for viewing the shared desktop or application.

**Returning to the Session window while sharing software**

When sharing the following types of software, you can return to the Session window at any time without stopping your sharing session:

- Application
- Web browser
- Remote computer

You can quickly return to your sharing session at any time, without having to restart it.

When sharing your desktop, you can also return to the Session window; however, your desktop sharing session stops automatically. To return to desktop sharing, you must start desktop sharing again.

**To display the Session window on attendees’ screens while sharing software:**

On the floating icon tray, click the **Return to Session Window** icon.
If you are sharing your desktop, click the **Exit and Return to Session Window** icon.

---

**Returning attendees to the software sharing window**

If you are viewing the Session window while sharing one of the following types of shared software, you can return attendees to the sharing window at any time:

- Application
- Web browser
- Remote computer

You cannot return to a desktop sharing session from the Session window. If you share your desktop and then return to the Session window, desktop sharing automatically stops. However, you can start sharing your desktop again.

**To display the software sharing window on attendees’ screens:**

In the Session window, on the **Share** menu, do one of the following, as appropriate:

- To return attendees to a shared application, choose the application.
- To return attendees to a shared Web browser, choose **Web browser**.
- To return attendees to a shared remote computer, choose **Remote Computer**.

---

### Annotating Shared Software

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of annotating shared software</td>
<td>About annotating shared software on page 142</td>
</tr>
<tr>
<td>make annotations and use pointers on shared software</td>
<td>Annotating shared software on page 142</td>
</tr>
<tr>
<td>remove, or clear, annotations and pointers</td>
<td>Clearing annotations and pointers on shared software on page 144</td>
</tr>
<tr>
<td>change the color with which you are annotating shared software</td>
<td>Selecting a color for annotating shared software on page 145</td>
</tr>
<tr>
<td>let an attendee annotate shared software remotely</td>
<td>Letting an attendee annotate shared software on page 145</td>
</tr>
<tr>
<td>Save annotations on shared software</td>
<td>Taking a screen capture of annotations on shared software on page 147</td>
</tr>
</tbody>
</table>
Chapter 11: Sharing Software

About annotating shared software

You can annotate the following types of shared software during a training session, using a highlighter or another annotation tool:

- Application
- Desktop
- Web browser

You can:

- Make annotations by highlighting areas on the software, drawing lines and shapes, and typing text, and using pointers
- Clear annotations at any time
- Change the color that you are using to make annotations
- Let one or more attendees annotate the shared software
- Take a screen capture of all your annotations and pointers on the shared software and save it to a file

All training session participants can see your annotations in their sharing windows. When you are sharing software, an attendee can request that you let him or her annotate the software.

Annotating shared software

When sharing any of the following types of shared software, you can make annotations on the software.

- Application
- Desktop
- Web browser

Attendees can see all your annotations.

To annotate shared software:

1. Do either of the following:
   - In the title bar of a window that you are sharing, click the Sharing menu.
   - In the lower-right corner of your desktop, click the Sharing menu.
2 On the menu that appears, choose **Start Annotation**.

The Tools panel appears.

![Tools panel](image)

The **Annotating** menu also appears on your screen.

![Annotating menu](image)

3 Select a tool for making annotations.

4 For details about annotation tools, see Using annotation tools on page 143.

---

**Note**

- You can let one or more attendees annotate the shared software. For details, see Letting an attendee annotate shared software on page 145.

- Once you or an attendee makes annotations, you can save an image of the software, including the annotations. For details, see Taking a screen capture of annotations on shared software on page 147.

---

**Using annotation tools**

The Tools panel provides a variety of tools for annotating shared software.

![Tools panel with annotations](image)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pointer</strong></td>
<td>Lets you point out text and graphics on shared software. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Lets you type text on shared content. Attendees can view the text once you finish typing it and click your mouse in the content viewer, outside the text box.</td>
</tr>
</tbody>
</table>
Clearing annotations and pointers on shared software

If you or participants have annotated shared software, you can clear:

- All annotations that all participants have made
- All annotations that only you have made
- All pointers that participants have added
- Only your pointer
- Specific annotations that any participant has made

**To clear annotations or pointers:**

1. On the Tools panel, click the downward-pointing arrow to the right of the **Eraser** button.

2. Choose an option to clear annotations or pointers.
**To clear specific annotations:**

1. On the Tools panel, click the **Eraser** button.

   ![](image1.png)

   Your mouse pointer changes to an eraser.

2. On the shared software, click the annotations that you want to clear.

**To turn off the eraser tool:**

On the Tools panel, click the **Eraser Tool** button.

---

**Selecting a color for annotating shared software**

If you are annotating shared software, you can select a different color for making annotations.

**To select a color for annotating shared software:**

1. On the Tools panel, click the downward-pointing arrow to the right of the **Annotation Color** button.

   ![](image2.png)

   The Annotation Color palette appears.

2. Click the color that you want to use.

   **Note** Once you join a training session, you receive a default annotation color, which appears to the right of your name on the **Participants** tab.

---

**Letting an attendee annotate shared software**

You can let one or more training session attendees annotate the following types of shared software:

- Application
- Desktop
- Web browser

You can let multiple attendees annotate shared software simultaneously.
To grant annotation control to an attendee, you must start annotation mode. For details, see Annotating shared software on page 142.

**To let an attendee annotate shared software:**

1. Click the **Annotating** menu.

2. On the menu that appears, do one of the following:
   - To let only specific attendees annotate shared software, choose **Allow to Annotate > [name of the attendee]**. To let another attendee also annotate the software simultaneously, repeat this step.
   - To let all attendees annotate the software simultaneously, choose **Allow to Annotate > All Attendees**.

**Note**

- If an attendee is remotely controlling shared software, the attendee cannot annotate it until you start annotation mode.
- You can stop an attendee from annotating shared software at any time. For details, see Stopping an attendee from annotating shared software on page 146.
- If an attendee requests to annotate shared software, a request message appears next to your mouse pointer. On the **Allow to Annotate** menu, the name of the attendee who requested annotation appears on an orange background.

**Stopping an attendee from annotating shared software**

If a training session attendee is annotating shared software, you stop the attendee from making annotations.

**To stop an attendee annotating shared software:**

1. Click the **Annotating** menu.

2. On the menu that appears, choose **Allow to Annotate**.

   On the menu that appears, a check mark appears next to the name of any attendee who can annotate the shared software.

3. Choose the name of the attendee to cancel the selection.
Chapter 11: Sharing Software

Taking a screen capture of annotations on shared software

If you or an attendee makes annotations on shared software, you can save an image of the shared software, including all annotations and pointers, to a WebEx Universal Communications Format (.ucf) file. You can open a .ucf file on your computer desktop or in the content viewer in a training session.

To take a screen capture of annotations on shared software:

1. On the Tools panel, click Screen Capture button.

   ![Screen Capture Button]

   The Save As dialog box appears.

2. Choose a location at which to save the file, and then click Save.

   Note: The file you save is an image of your entire desktop.

Stopping annotation mode

To stop making annotations on shared software and return your mouse to a normal pointer, you must stop annotation mode.

To stop annotation mode:

1. Click the Annotating menu.

   ![Annotating Menu]

2. On the menu that appears, choose Stop Annotation.

Allowing remote control of shared software

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get an overview of letting an attendee remotely control shared software</td>
<td>About letting an attendee remotely control shared software on page 148</td>
</tr>
<tr>
<td>Let an attendee remotely control shared software</td>
<td>Letting an attendee remotely control shared software on page 148</td>
</tr>
<tr>
<td>Automatically let attendees remotely control shared software</td>
<td>Automatically letting attendees remotely control shared software on page 149</td>
</tr>
<tr>
<td>Stop an attendee from remotely controlling shared software</td>
<td>Stopping remote control of shared software on page 149</td>
</tr>
</tbody>
</table>
Chapter 11: Sharing Software

About letting an attendee remotely control shared software

While sharing the following types of shared software, you can let an attendee control it remotely:

- Application
- Desktop
- Web browser

An attendee who has remote control of shared software can interact with it completely. While an attendee is remotely controlling your shared software, your mouse pointer is inactive. At any time, however, you can take back control of a shared application and regain the use of your mouse pointer.

While you are sharing software, any attendee can send a request to control the software remotely. You can then grant control to the attendee. Alternatively, you can automatically grant control of shared software to any attendee who requests remote control.

You can stop an attendee from remotely controlling shared software at any time.

Caution: An attendee who has remote control of your desktop can run any programs and access any files on your computer that you have not protected with a password.

Letting an attendee remotely control shared software

If you are sharing software, you can let an attendee control it remotely.

To let an attendee remotely control shared software:

1. Do either of the following:
   - In the title bar of a window that you are sharing, click the Sharing menu.
   - In the lower-right corner of your desktop, click the Sharing menu.

2. On the menu that appears, choose Allow to Control Remotely > [name of attendee].
Automatically letting attendees remotely control shared software

While sharing software, you can automatically grant control of the software to an attendee who requests control. In this case, an attendee who requests remote control automatically takes control of the software that you are sharing. While automatic remote control is turned on, any attendee can take control away from any other attendee by requesting remote control.

To automatically let attendees control shared software:

1. Do either of the following:
   - In the title bar of a window that you are sharing, click the Sharing menu.
   - In the lower-right corner of your desktop, click the Sharing menu.

2. On the menu that appears, choose Accept Control Requests Automatically.

To stop letting attendees control shared software automatically:

1. Do either of the following:
   - On the title bar of a window that you are sharing, click the Sharing menu.
   - In the lower-right corner of your computer’s desktop, click the Sharing menu.

2. On the menu that appears, choose to Accept Control Requests Automatically to cancel the selection.

Stopping remote control of shared software

While an attendee is remotely controlling a shared application, desktop, or Web browser, you can take back control of the shared software at any time. You can do either of the following:

- Take back remote control of shared software temporarily, allowing an attendee to take control at any time.
- Prevent an attendee from further controlling shared software.

To take back control a shared software temporarily:

On your computer’s desktop, click your mouse.
You can now control the shared software.
The attendee who was controlling the shared software can take back control at any time by clicking his or her mouse.

To prevent an attendee from further controlling a shared software:

1. On your computer's desktop, click your mouse.
   You can now control the shared software.
2. Do either of the following:
   - In the title bar of a window that you are sharing, click the Sharing menu.
   - In the lower-right corner of your desktop, click the Sharing menu.
3. On the menu that appears, choose Allow to Control Remotely.
   A menu appears, containing a list of all attendees in the training session. A check mark appears to the left of the attendee who has remote control.
4. Choose the attendee's name to cancel the selection.

Specifying the display mode for shared software

When sharing an application, desktop, or Web browser, you can choose a display mode that provides one of the following:

- Better performance and imaging for most applications (the default mode)
- Better performance and imaging for graphics-intensive applications

“Performance” refers to the “speed” at which images appear on attendees' screens, and “imaging” refers to the quality and clarity of the images.

To choose a display mode software sharing:

1. If you are currently sharing software, stop your sharing session.
2. On the Session menu, choose Session Options.
   The Training Session Options dialog box appears.
3. Click the Display Mode tab.
4. Under Display mode, select one of the following:
   - Better for most applications
   - Better for complex graphics
Chapter 11: Sharing Software

5 Click **OK** or **Apply**.

**Tip**

- Choose a display mode that best suits your needs during a training session. For example, if you want attendees to view details in complex graphics, choose the **Better for complex graphics** mode. Otherwise, choose the **Better for most applications mode**, which provides high-quality imaging and faster software sharing.

- If you are sharing software images for which the representation of color and color gradients must be fully accurate on participants’ screens, you can turn on True Color mode. For details, see **Sharing applications with detailed color** on page 151.

---

**Sharing applications with detailed color**

By default, Training Manager sends images of shared software using 16-bit color mode, which is the equivalent of your computer’s “High Color” (16-bit) setting. This mode provides an accurate representation of color for most shared applications. However, if your shared application contains detailed color images—such as color gradients—the color may not appear accurately on participants’ screens. For example, color gradients may appear and color “bands.”

If the accuracy and resolution of color in a shared application is important, you can turn on True Color mode in Training Manager. Using this mode, however, may affect the performance of application sharing.

When using True Color mode, you can select one of the following options:

- Better imaging (no image compression)
- Better performance (some image compression)

“Performance” refers to the “speed” at which images appear on attendees’ screens, and “imaging” refers to the quality of the color in shared images.

---

**Note** Before turning on True Color mode, ensure that your monitor display is set to True Color (either 24- or 32-bit color). For more information about setting options for your monitor, refer to Windows Help.

---

**To turn on True Color mode:**

1 If you are currently sharing an application, stop your sharing session.

2 On the **Session** menu, choose **Session Options**.
   The Training Session Options dialog box appears.
3. Click the **True Color Mode** tab.
4. Select **Enable True Color mode**.
5. Select one of the following options:
   - Better imaging
   - Better performance
6. Click **OK** or **Apply**.

## Tips for Sharing Software

The following tips can help you to share software more effectively:

- **Application sharing only**: To save time during a training session, ensure that any applications you intend to share are open on your computer. At the appropriate time during the training session, you can then quickly begin sharing an application, without waiting for the application to start.

- **If attendees cannot see all of the shared software without scrolling their sharing windows**, they can adjust their views of the shared software. They can reduce the size of the shared software in decrements, or scale it to fit inside their sharing windows. For details, see **Helping attendees to control their views of shared software** on page 139.

- **To improve the performance of software sharing**, close all applications that you do not need to use or share on your computer. Doing so conserves processor usage and memory on your computer, thus helping to ensure that Training Manager can send images of shared software quickly during a training session. Also, to ensure that a maximum amount of bandwidth is available for software sharing, close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.

- **If you are sharing a graphics-intensive application**, you can usually improve performance by changing the display mode. For details, see **Specifying the display mode for shared software** on page 150.

- **If you are sharing an application for which the rendering of color on participants’ screen is important**, you can improve color quality by turning on True Color mode. For details, see **Sharing applications with detailed color** on page 151.

- **Application and Web browser sharing only**: Avoid covering a shared application or Web browser with another window on your computer’s desktop. A crosshatched pattern appears in attendees’ sharing windows where the other window is covering the shared application or browser.

- **Application and Web browser sharing only**: If you want to switch your display between shared software and the Session window, you can pause software sharing before you return to the Session window, and then resume sharing once...
you return to the shared application. Pausing software sharing conserves processor usage and memory on your computer while you view the Session window. For details, see Pausing and resuming software sharing on page 136.

Because software sharing requires additional bandwidth during a training session, it is recommended that you use a dedicated, high-speed Internet connection when sharing software. However, if attendees are using dial-up Internet connections, they may notice a delay in viewing or controlling shared software. If you want to share a document, such as a Microsoft Word or Excel document, you can improve the training session experience for these attendees by using document sharing instead of application sharing.
Sharing Web Content

If you want to... | See...
---|---
get an overview of sharing Web content | About sharing Web content on page 155
share Web content with training session participants | Sharing Web content on page 156
understand the differences between sharing a browser and sharing Web content | Differences between sharing Web content and sharing a Web browser on page 156

**About sharing Web content**

You can share Web content that resides on:

- The public Internet or Web
- Your company’s intranet
- Your computer or another computer on your private network

Web content includes:

- Web pages, including pages that contain embedded media files, such as Flash, audio, or video files
- Standalone media files, such as Flash, audio, or video files

The Web content that you share opens in the content viewer on each participant’s screen. If you share a Web page, participants view and interact independently with the content on the page. If the page contains links to other pages, they can also navigate independently to those pages.

If you use Web content sharing, then, participants can experience audio and video effects on a Web page. However, unlike Web browser sharing, this option does not allow you to guide participants to other Web pages. For more information, see Differences between sharing Web content and sharing a Web browser on page 156.
Important  If you share content that requires a media player, participants can view and interact with the content only if the appropriate player is installed on their computers.

Sharing Web content

You can share a Web page that contains multimedia effects. The page opens in the content viewer on each participant’s screen.

To share Web content:

   
The Share Web Content dialog box appears.

2. In the Address box, enter the address, or URL, at which the content resides. Or, if you have previously shared the content, select it in the drop-down list.

3. In the Type box, select the type of Web content that you want to share.

4. Click OK.

Tip  You can copy a URL from any source, such as another browser window, and then paste it in the Address box.

Differences between sharing Web content and sharing a Web browser

Training Center provides two options for sharing Web-based information. You can share Web content or share a Web browser with training session participants. Choose the feature that better suits your needs.
<table>
<thead>
<tr>
<th>Sharing option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser sharing</td>
<td>■ Lets you guide participants to various Web pages and sites on the Web.</td>
<td>■ Does not display media effects or transmit sounds on Web pages.</td>
</tr>
<tr>
<td></td>
<td>■ Lets you grant attendees control of your Web browser.</td>
<td>■ Does not let participants interact with Web pages independently.</td>
</tr>
<tr>
<td></td>
<td>■ Lets you and other participants annotate Web pages.</td>
<td></td>
</tr>
<tr>
<td>Web content sharing</td>
<td>■ Displays Web pages, and lets participants experience media effects on Web pages, including video and sound.</td>
<td>Does not let you guide participants to other Web pages.</td>
</tr>
<tr>
<td></td>
<td>■ Lets participants interact with Web pages independently in their content viewers.</td>
<td></td>
</tr>
</tbody>
</table>
Transferring Files During a Training Session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of transferring files during a training session</td>
<td>About transferring files during a training session on page 159</td>
</tr>
<tr>
<td>publish files during a training session</td>
<td>Publishing files during a training session on page 159</td>
</tr>
</tbody>
</table>

About transferring files during a training session

During a training session, you can publish files that reside on your computer. Training Session attendees can then download the published files to their computers or local servers. Publishing files is useful if you want to provide attendees with a document, a copy of your presentation, an application, and so on.

Files that you publish reside only on your computer—not on a server. Thus, your published files are always protected from unauthorized access during a training session.

Publishing files during a training session

During a training session, you can publish files that reside on your computer, and training session attendees can download the files to their computers or local servers.

To publish files during a training session:

1. In the Session window, on the File menu, choose Transfer.

   The File Transfer window appears.
2 Click Share File.
   The Open dialog box appears.

3 Select the file that you want to publish.

4 Click Open.
   The file appears in the File Transfer window.
   The file is also now available in each attendee's File Transfer window.

5 Optional. Publish additional files that you want attendees to download.

Note  The number of attendee Session windows in which the File Transfer window is open, including your own, appears in the lower-right corner of the File Transfer window.

To stop publishing files during a training session:

   In the title bar of the File Transfer window, click the Close button.
   Training Manager closes the File Transfer window in each attendee's Session window.
Polling Attendees

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of polling attendees</td>
<td>About polling attendees on page 161</td>
</tr>
<tr>
<td>prepare a poll questionnaire</td>
<td>Preparing a poll questionnaire on page 162</td>
</tr>
<tr>
<td>take a poll during a training session</td>
<td>Viewing poll results on page 167</td>
</tr>
<tr>
<td>view or share poll results during a training session</td>
<td>Viewing and sharing poll results on page 166</td>
</tr>
<tr>
<td>save or open poll questionnaires or results</td>
<td>Saving and opening poll questionnaires and results on page 168</td>
</tr>
</tbody>
</table>

About polling attendees

During a training session, you can poll attendees by presenting them with a questionnaire on which they can select multiple-choice answers. Taking a poll can be useful for gathering feedback from attendees, allowing attendees to vote on a proposal, testing attendees' knowledge of a topic, and so on.

To take a poll, you must first prepare a poll questionnaire. You can prepare a questionnaire at any time during a training session. Or, to save time during a training session, you can prepare a questionnaire before a training session’s starting time, save it, and then open it for use during the training session.

Once you close a poll, you can view the results and share them with attendees. You can also save the results of a poll for viewing outside of a training session.
Chapter 14: Polling Attendees

Preparing a poll questionnaire

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of preparing a poll questionnaire</td>
<td>About preparing a poll questionnaire on page 162</td>
</tr>
<tr>
<td>compose a questionnaire</td>
<td>Composing poll questions and answers on page 162</td>
</tr>
<tr>
<td>edit your poll questions or answers</td>
<td>Editing a questionnaire on page 164</td>
</tr>
<tr>
<td>display a timer when a poll is in progress</td>
<td>Displaying a timer during polling on page 165</td>
</tr>
</tbody>
</table>

About preparing a poll questionnaire

On the Polling panel, you can prepare a poll questionnaire that includes multiple-answer, single-answer, and text questions. Once you complete a questionnaire, you can open the poll at any time during a training session.

Composing poll questions and answers

You can create a questionnaire at any time after you start a training session. The following figure shows a portion of the Polling panel, which offers the tools you use to compose a questionnaire.

Tip  To save time during a training session, you can prepare a poll questionnaire before attendees join a training session, save it, and then open it for use during the training session.

To compose a questionnaire:

1. Click the Polling tab.
Chapter 14: Polling Attendees

The Polling panel appears.

2 Under Question Type, select the type of question you want to compose by doing one of the following:
   - To compose a multiple-answer question, select Multiple choice, and then choose Multiple Answers in the drop-down list.
   - To compose a single-answer question, select Multiple choice, and then choose Single Answer in the drop-down list.
   - To compose a text question, select Short answer.

3 Click New.

4 Type a question in the Poll Questions box that appears.

5 In the Answer section, click Add.
   An answer box appears below the question.
6 Type an answer to the question in the box that appears. To type another answer, click Add once you finish typing an answer.

The question and answers appear in the Poll Questions area.

7 To add questions, repeat steps 2 to 7.

The following figure shows an example of a poll questionnaire.

---

**Editing a questionnaire**

You can change the type of a question and edit, rearrange, or delete the questions and answers.

**To change the type of a question:**

1 Select the question by clicking it, and then select the new type of question in the Question section.

For more information about the different types of questions, see Composing poll questions and answers on page 162.

2 Click Change Type.
To edit any question or answer that you typed:

1. Select the question or answer by clicking it, and then click the **Edit** icon.

2. Make your changes.

To delete a question or an answer:

Select the question or answer by clicking it, and then click the **Delete** icon.

To rearrange questions or answers:

Select the question or answer by clicking it, and then click the **Move Up** or **Move Down** icon, as appropriate.

To delete an entire questionnaire:

Click **Clear All**.

If you have not saved the questionnaire, a message box appears, asking whether you want to save it or not.

Displaying a timer during polling

You can specify that a timer displays for attendees and yourself when a poll is in progress.

**To display a timer:**

1. Click **Options**.

2. In the dialog box that appears, select **Display**, and then type the length of time in the **Alarm:** box.
Chapter 14: Polling Attendees

3 Click **OK**.

### Opening a poll

Once you finish preparing a poll questionnaire, you can open the poll.

If you prepared your questionnaire in advance and saved it, you must first open it on the **Polling** panel. For details, see Opening a poll questionnaire file on page 170.

**To open a poll:**

1. Open the **Polling** panel.
2. Click **Open Poll**.

   The questionnaire appears on attendees’ **Polling** panels. Attendees can now fill out the questionnaire.

As attendees answer the questions, you can watch the polling status on your **Polling** panel. The following figure shows an example.

<table>
<thead>
<tr>
<th>Polling status</th>
<th>Value</th>
<th>Time limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not started</td>
<td>2/3 (67%)</td>
<td>10:00</td>
</tr>
<tr>
<td>In progress</td>
<td>0/3 (0%)</td>
<td></td>
</tr>
<tr>
<td>Finished</td>
<td>1/3 (33%)</td>
<td></td>
</tr>
<tr>
<td>Remaining time</td>
<td>4:54</td>
<td></td>
</tr>
</tbody>
</table>

Click one of these three buttons to view each attendee’s polling status.

3 Click **Close Poll** when the time is up.

   If you specify a timer and the poll times out, the poll automatically closes.

   Attendees can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with attendees. For details, see Viewing and sharing poll results on page 166.

### Viewing and sharing poll results

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>view and understand poll results</td>
<td>Viewing poll results on page 167</td>
</tr>
<tr>
<td>share poll results with attendees after you close a poll</td>
<td>Sharing poll results with attendees on page 167</td>
</tr>
</tbody>
</table>
# Viewing poll results

Once you close a poll, you can view the complete results of the poll and share them with attendees.

The following figure shows an example of your **Polling panel** after you close a poll. The **Results** column indicates the percentage of attendees who chose each answer. The **Bar Graph** column provides a graphic representation of each percentage in the **Results** column.

<table>
<thead>
<tr>
<th>Poll Questions</th>
<th>Results</th>
<th>Bar Graph</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is your favorite color?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. Pink</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>b. Black</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>c. Green</td>
<td>0/4(0%)</td>
<td></td>
</tr>
<tr>
<td>d. Blue</td>
<td>0/4(0%)</td>
<td></td>
</tr>
<tr>
<td>e. Other</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>2. What do you enjoy doing in your free time?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. Reading</td>
<td>3/4(75%)</td>
<td></td>
</tr>
<tr>
<td>b. Watching movies</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>c. Traveling</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>d. Sports</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>e. Other</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>3. Please give us feedback about...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

- Training Manager bases the percentage of attendees who chose each answer on the total number of attendees in the training session, not the total number of attendees who filled out the questionnaire.

- The results of a poll are anonymous—that is, they do not indicate which attendees chose which answer.

## Sharing poll results with attendees

After you close a poll, you can share the poll results with attendees.

**To share the results of a poll:**

1. In the **Share with attendees** section on your Polling panel, select **Poll results**.
2. Click **Apply**.
Chapter 14: Polling Attendees

The results of the poll appear in the attendees’ Polling panels, just as they appear in your Polling panel.

Saving and opening poll questionnaires and results

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>save a poll questionnaire to a file</td>
<td>Saving a poll questionnaire on page 168</td>
</tr>
<tr>
<td>save poll results to a file</td>
<td>Saving poll results on page 169</td>
</tr>
<tr>
<td>open a poll questionnaire during a training session</td>
<td>Opening a poll questionnaire file on page 170</td>
</tr>
<tr>
<td>open poll results on your computer</td>
<td>Opening a poll results file on page 170</td>
</tr>
</tbody>
</table>

**Saving a poll questionnaire**

Once you create a poll questionnaire, you can save it as an .atp file. You can open the file for use in any training session. For more information about preparing a poll questionnaire, see Composing poll questions and answers on page 162.

If you make changes to a poll questionnaire after you save it, you can either save the changes to the same file or save a copy of the questionnaire to another file.

**To save a new poll questionnaire:**

1. On the File menu, choose Save > Poll Questions.
   The Save Poll Questions As dialog box appears.
2. Choose a location at which to save the file.
3. Type a name for the file.
4. Click Save.
   Training Manager saves the poll questionnaire to a file at the location you specified. Poll questionnaire file names have an .atp extension.

**To save changes to a poll questionnaire that you previously saved:**

On the File menu, choose Save > Poll Questions.
Training Manager saves the changes to the existing poll questionnaire file.

**To save a copy of a poll questionnaire:**

1. On the File menu, choose Save As > Poll Questions.
   The Save Poll Questions As dialog box appears.
2. Do either or both of the following:
   - Type a new name for the file.
   - Choose a new location at which to save the file.
3 Click **Save**.

Training Manager saves the poll questionnaire to a file at the location you specified. The names of poll questionnaire files have an `.atp` extension.

**Saving poll results**

If you conduct a poll and then share its results, you can save the results to a `text` or `.txt` file.

Once you save poll results to a file, you can save changes to the poll results or save a copy of the results to another file.

**Tip** Training Center automatically saves poll results every two minutes to the WebEx folder in the My Documents folder on your computer. If you ever lose your poll results, you can easily recover them in the designated folder. Training Center saves both group and individual results.

**To save new poll results:**

1. Close the poll if you have not done so.
2. On the **File** menu, choose **Save > Poll Results**.
   
   The Save Poll Results As dialog box appears.
3. Choose a location at which to save the file.
4. Type a name for the file.
5. Click **Save**.

Training Manager saves the poll results to a file at the location you specified. The names of poll results files have a `.txt` extension.

**To save changes to poll results that you previously saved:**

On the **File** menu, choose **Save > Poll Results**.

Training Manager saves the changes to the existing poll results file.

**To save a copy of a poll results:**

1. On the **File** menu, choose **Save As > Poll Results**.
   
   The Save Poll Results As dialog box appears.
2. Do either or both of the following:
   
   - Type a new name for the file.
   - Choose a new location at which to save the file.
3. Click **Save**.
Chapter 14: Polling Attendees

Training Manager saves the poll results to a file at the location you specified. The names of poll results files have a `.txt` extension.

Opening a poll questionnaire file

If you saved a poll questionnaire to a file, you can display the questionnaire during a training session by opening the file.

**Note** You can open a poll questionnaire file, which has an `.atp` extension, only when a training session is in progress.

To open a poll questionnaire file:

   The Open Poll Questions dialog box appears.
2. Select the poll questionnaire file that you want to open.

   **Note** The names of poll questionnaire files have an `.atp` extension.

3. Click Open.
   The poll questionnaire appears on your Polling panel. You can now open the poll to training session attendees.

Opening a poll results file

If you saved poll results to a file, you can open the file on your computer.

To open a poll results file on your computer:

Double-click the saved file, which has a `.txt` extension.

The poll results file opens in your default text editor.

For each question, the poll results show the number and percentage of attendees who chose each answer and the total number of attendees in the training session.

The following figure shows an example of poll results in the text format.
1. How helpful was the presentation?
   a. Very helpful 2/4 (50%)
   b. Somewhat helpful 2/4 (50%)
   c. Not helpful 1/4 (25%)

2. How was the speed of the presentation?
   a. Too fast 2/4 (50%)
   b. Just right 2/4 (50%)
   c. Too slow 0/4 (0%)

3. How clear were the slides?
   a. Very clear 3/4 (75%)
   b. Somewhat clear 1/4 (25%)
   c. Not clear 0/4 (0%)
Managing Question-and-Answer Sessions

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Q &amp; A sessions</td>
<td>About question-and-answer sessions on page 173</td>
</tr>
<tr>
<td>allow participants to use Q &amp; A sessions</td>
<td>Allowing participants to use Q &amp; A on page 174</td>
</tr>
<tr>
<td>protect the privacy of panelists and attendees during a training session</td>
<td>Setting privacy views in Q &amp; A sessions on page 175</td>
</tr>
<tr>
<td>get an overview of managing the questions and answers in the queue</td>
<td>Managing questions on your Q &amp; A panel on page 176</td>
</tr>
<tr>
<td>use the tabs on your Q &amp; A panel</td>
<td>Working with the tabs on your Q &amp; A panel on page 177</td>
</tr>
<tr>
<td>assign a question to a subject matter expert in your team</td>
<td>Assigning a question on page 179</td>
</tr>
<tr>
<td>answer questions in a Q &amp; A session</td>
<td>Answering questions in a Q &amp; A session on page 180</td>
</tr>
<tr>
<td>archive Q &amp; A sessions</td>
<td>Archiving Q &amp; A sessions on page 184</td>
</tr>
</tbody>
</table>

About question-and-answer sessions

During a question-and-answer (Q & A) session, you can respond to questions that attendees ask during the training session. A Q & A session not only provides instant text messaging similar to that in Chat, but also does the following:

- provides a more formal procedure for asking and answering questions in text format
- automatically groups questions to help you manage the queue, such as quickly
identifying questions that you have or have not answered

- displays visual cues for the status of questions
- lets you assign questions to the appropriate domain expert on your team
- allows you to quickly send a standard response to questions for which you cannot or do not want to answer immediately

You can save the questions and answers in a Q & A session to either a text (.txt) file or a comma-separated/comma-delimited values (.csv) file for future reference.

Tip: If you use Q & A during a training session, WebEx recommends that a panelist (the host or presenter) monitors the Q & A panel at all times during the training session.

Allowing participants to use Q & A

Host only

To use Q & A during a training session, ensure that the Q & A option is turned on. You can also turn it off at any time, if necessary.

To turn on Q & A during a training session:

1. In the Session window, on the Session menu, choose Session Options. The Training Session Options dialog box appears.

2. On the Communications tab, select Q & A.
3. Click Apply > OK.

To turn off Q & A during a training session:

1. In the Session window, on the Session menu, choose Session Options.
Chapter 15: Managing Question-and-Answer Sessions

The Training Session Options dialog box appears.

2. On the **Communications** tab, clear **Q & A**.

3. Click **Apply > OK**.

### Setting privacy views in Q & A sessions

**Host only**

To protect the privacy of panelists and attendees during a training session, you can specify to hide or show the following information when questions and answers are published on attendees’ Q & A panels:

- Names of attendees who send questions
- Names of panelists who send answers
- Time stamps for questions and answers respectively

**Note** The names of attendees and panelists and time stamps are always visible on panelists’ Q & A panels.

**To set privacy views:**

1. Right-click the title bar of your Q & A panel, and then choose **Attendee Options**.
2. In the dialog box that appears, select any of the options that you want attendees to see, and then click **OK**.

Managing questions on your Q & A panel

The tabs and visual cues on your Q & A panel allow you to manage the questions you receive in the queue in the following ways:

- Identify the status of questions and answers—answered, unanswered, assigned, private, dismissed, or deferred—and address questions that need your attention.
- Assign questions to the appropriate expert on your team in the training session.
- Get an idea of the interactions between the panelists and attendees who ask questions.
Chapter 15: Managing Question-and-Answer Sessions

Working with the tabs on your Q & A panel

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of the tabs on your Q &amp; A panel</td>
<td>Working with the tabs on your Q &amp; A panel on page 177</td>
</tr>
<tr>
<td>open a tab</td>
<td>Opening a tab on page 178</td>
</tr>
<tr>
<td>close a tab</td>
<td>Closing a tab on page 178</td>
</tr>
<tr>
<td>assign a question to another panelist</td>
<td>Assigning a question on page 179</td>
</tr>
</tbody>
</table>

About the Q & A tabs

Your Q & A panel consists of four tabs. The All tab displays by default. The following table describes what each tab displays.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Displays ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>all questions and answers—unanswered, answered, private, deferred, and dismissed—in the queue</td>
</tr>
<tr>
<td>Unanswered</td>
<td>questions that have not been answered by a panelist</td>
</tr>
<tr>
<td>Answered</td>
<td>questions that have been answered by a panelist and answers</td>
</tr>
</tbody>
</table>
Chapter 15: Managing Question-and-Answer Sessions

<table>
<thead>
<tr>
<th>Tab</th>
<th>Displays ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Q &amp; A</td>
<td>questions that</td>
</tr>
<tr>
<td></td>
<td>■ attendees specifically send to you by your name</td>
</tr>
<tr>
<td></td>
<td>■ other panelists assign to you</td>
</tr>
<tr>
<td></td>
<td>■ attendees send to All Panelists and that you have answered</td>
</tr>
<tr>
<td></td>
<td>■ attendees send to Host&amp;Presenter, Host, or Presenter, if you are the host or presenter</td>
</tr>
</tbody>
</table>

### Opening a tab

When you open the Q & A panel, the All tab appears by default.

**To open other tabs on the Q & A panel:**

1. Right-click the All tab.
2. Choose Open Tab > the tab you want to open.
3. If you want to open one more tab, right-click any of the open tab, and then choose Open Tab > the tab you want to open.

### Displaying hidden tabs

The Q & A panel cannot display all open tabs at one time unless you expand the panels to the left.

**To display a hidden tab on the Q & A panel:**

Click the downward arrow, and then choose the tab you want to display.

The following figure shows an example.

### Closing a tab

You can close all the tabs, except the All tab, on your Q & A panel.
To close a tab on the Q & A panel:

Do one of the following:

- Right-click the tab that you want to close, and then choose Close Tab.
- Click the Close button on the upper-right corner of the tab you want to close.

Note: Closing a tab does not remove the information on the tab. You can view the information on that tab by opening it again. For details, see Opening a tab on page 178.

Assigning a question

You can assign questions to yourself or another panelist. The questions appear on the designated panelists' My Q & A tab, with the assigned text next to them.

To assign a question:

From any of the tabs on which you received the question, right-click the question, and then choose Assign to > the person you want to assign it to.

Note:

- To assign multiple questions at the same time, hold down the Ctrl key while selecting the questions.
- If an assigned question is answered, the assigned text still displays.
- The assigned text does not display on attendees' Q & A panels.
Chapter 15: Managing Question-and-Answer Sessions

Answering questions in a Q & A session

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of answering questions</td>
<td>About answering questions in a Q &amp; A session on page 180</td>
</tr>
<tr>
<td>provide an answer to a question</td>
<td>Providing an answer to a question on page 180</td>
</tr>
<tr>
<td>dismiss a question</td>
<td>Dismissing a question on page 182</td>
</tr>
<tr>
<td>defer a question</td>
<td>Deferring a question on page 183</td>
</tr>
</tbody>
</table>

About answering questions in a Q & A session

During a Q & A session, you can provide an answer to a question; or defer or dismiss a question. You can respond to a question from any of the four tabs on which you receive the specific question. For more information about each of the tabs, see About the Q & A tabs on page 177.

Tip: If a question shows as assigned on the All tab, you can check whether this question has been assigned to you on your My Q & A tab.

Providing an answer to a question

During a Q & A session, you can provide an answer to a question—publicly or privately.

Providing a public answer

Your answer to a question appears on all participants’ Q & A panels, unless you choose to send your answer privately. For more information about private answers, see Answering a question privately on page 182.

To provide a public answer during a Q & A session:

1. On your Q&A panel, select the question from any of the tabs on which you received the question.
   
   The following figure shows an example.
2 Type your answer in the text box.

To edit your answer before sending it, highlight the text you want to edit and then right-click your mouse. The menu that appears provides editing commands. The following figure shows an example.

3 When you finish typing your answer, click Send.

The answer appears on all panelists' and attendees' Q & A panels.

**Answering indicator**

When a panelist is typing an answer to a question that no one else has responded to yet, an in-progress indicator displays under that question for all participants. The following figure shows an example.
Answering a question privately

If you send your answer privately, the following participants can see the private answer:

- the attendee who sent you the question
- all panelists

To answer a question privately:

1. On your Q&A panel, select the question from any of the tabs on which you received the question, and then click **Send Privately**.

2. In the dialog box that appears, type your answer in the text box.

3. If you want to save the answer you typed as the standard private answer for all panelists to use, click **Save**.

4. Click **Send**.

Dismissing a question

In a Q & A session, you can dismiss a question using a standard or customized answer. The standard answer reads: Thank you for your question. The information that you requested cannot be provided by any of the panelists.
If you dismiss a question, the following participants can see the Dismiss answer:
- the attendee who sent the question
- all panelists

**To dismiss a question during a Q & A session:**

1. From any of the tabs where you received the question, right-click the question, and then choose **Dismiss**.

   **Tip** To dismiss multiple questions at one time, hold down the **Ctrl** key while selecting the questions, right-click your mouse, and then choose **Dismiss**.

   The Respond Privately dialog box appears, containing the standard Dismiss answer.

   2. Optional. To customize the standard answer, click **Custom**, and then edit the text in the text box.

   3. Optional. To save your customized answer as the standard Dismiss answer for all panelists to use, click **Save**.

   4. Click **Send**.

   5. Click **Yes** in the confirmation message box.

**Deferring a question**

In a Q & A session, you can defer a question using a standard or customized answer. The standard answer reads: Thank you for your question. Your question was deferred but will remain in the queue. A panelist will answer your question at a later time.
Chapter 15: Managing Question-and-Answer Sessions

If you defer a question, the following participants can see the Defer answer:
- the attendee who sent the question
- all panelists

To defer a question during a Q & A session:

1. From any of the tabs where you received the question, right-click the question, and then choose **Defer**.

   **Tip** To defer multiple questions at one time, hold down the **Ctrl** key while selecting the questions, right-click your mouse, and then choose **Defer**.

   The Respond Privately dialog box appears, containing the standard Defer answer.

   ![Respond Privately dialog box](image)

   2. Optional. To customize the standard answer, click **Custom**, and then edit the text in the text box.

   3. Optional. To save your customized answer as the standard Defer answer for all panelists to use, click **Save**.

   4. Click **Send**.

Archiving Q & A sessions

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of saving your Q &amp; A sessions</td>
<td><em>About archiving a Q &amp; A session</em> on page 185</td>
</tr>
<tr>
<td>save your Q &amp; A sessions</td>
<td><em>Saving a Q &amp; A session</em> on page 185</td>
</tr>
<tr>
<td>save additional changes to a Q &amp; A session that you</td>
<td><em>Saving changes to a saved Q &amp; A session</em></td>
</tr>
<tr>
<td>saved previously</td>
<td>on page 186</td>
</tr>
</tbody>
</table>
Chapter 15: Managing Question-and-Answer Sessions

### About archiving a Q & A session

At any time during a training session, you can save the questions and answers on the All tab on your Q & A panel to a .txt or .csv (comma-separated/comma-delimited values) file. If there are updates in the Q & A session, you can save them to the existing file.

Once you save a new Q & A session to a file, you can also save a copy to another file.

### Saving a Q & A session

At any time during a training session, you can save the questions and answers on the All tab on your Q & A panel to a .txt or .csv file.

**Note**  
Training Manager automatically saves Q & A sessions every two minutes to the WebEx folder in the My Documents folder on the host’s and presenter’s computers.

**To save a Q & A session:**

1. In the Session window, on the File menu, choose **Save > Questions and Answers**.

**Note**  
If there are no questions or answers on your Q & A panel, the Save option is unavailable.

The Save Questions and Answers As dialog box appears.

2. Choose a location at which to save the file.

3. Type a name for the file.

4. In the **Save as type** box, select **Text Files (*.txt)** or **CSV** (comma-separated/comma-delimited values).

5. Click **Save**.

Event Manager saves the file at the location and format that you chose.

To review the content of an archived Q & A session, open the .txt file in a text editor or the .csv file in a spreadsheet program, such as Microsoft Excel.
Saving changes to a saved Q & A session

If you have previously saved a Q & A session, and there are additional changes in the Q & A session, you can save the updates to the existing file.

To save changes in an existing Q & A file:

In the Session window, on the File menu, choose Save > Questions and Answers.

Note: If there are no changes on the All tab on your Q & A panel, the Save option is unavailable.

Event Manager saves the changes to the existing Q & A file.

Saving a copy of a previously saved Q & A session

If you have previously saved a Q & A session, and you want to save another copy of the session, you can do so by following these steps:

1. In the Session window, on the File menu, choose Save As > Question and Answers.

   The Save Questions and Answers As dialog box appears.

2. Do any or all of the following:
   - Type a new name for the file.
   - Choose a new location at which to save the file.
   - Choose a different format for the file.

3. Click Save.

   Event Manager saves the file with any additional changes in the Q & A session.

Opening a Q & A file

The Q & A files that you saved during a training session have either a .txt or .csv extension.

To view a .txt file, open it in a text editor, such as Notepad.

To view a .csv file, open it in a spreadsheet program, such as Microsoft Excel.
Managing Chat

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing chat</td>
<td>About managing chat on page 187</td>
</tr>
<tr>
<td>grant chat privileges</td>
<td>Granting chat privileges on page 188</td>
</tr>
</tbody>
</table>

About managing chat

During a training session, you can manage chat by granting chat privileges or removing them from an individual attendee or all attendees.

By default, only the presenter and panelists have all chat privileges and can chat with all participants publicly or privately. However, you can allow all attendees or individual attendees to communicate freely during a training session. You can also remove chat privileges from attendees at any time.

Tip You can designate a participant as a chat moderator to ensure that attendees receive timely answers to their questions and to minimize interruptions. The moderator can answer attendees’ questions via chat messages. At the beginning of the training session, instruct attendees to use chat to ask questions and to direct their questions to the chat moderator.
Granting chat privileges

At any time during a training session, you can specify that all attendees or individual attendees can send chat messages to

- All Attendees or all participants
- Only the training session host
- Only the presenter
- Only the panelists
- Any other attendee, privately

You can also remove chat privileges at any time.

To specify chat privileges for attendees during a training session:

1. Do either of the following:
   - On the Chat panel, right-click the Chat title bar, and then choose Attendee Privileges.
   - In the Session window, on the Participant menu, choose Assign Privileges.

   The Assign Privileges dialog box appears.

2. Under Communications, select any of the check boxes for the chat privileges you want to grant to all attendees.

   For details about each chat privilege, see Overview of chat privileges on page 188.

3. Click Assign.

**Note** The training session host and the presenter always have all chat privileges, regardless of the chat privileges that other participants have.

Overview of chat privileges

To set chat privileges, in the Session window, on the Participant menu, choose Assign Privileges. Then look under Communications.
### Chat with

**Host**—Selected by default, if the host did not specify privileges when scheduling a training session. Specifies that attendees can chat with only the training session host. If an attendee sends a chat message to the host, it appears in only the host's chat viewer.

**Presenter**—Selected by default, if the host did not specify privileges when scheduling a training session. Specifies that attendees can chat with only the presenter. If an attendee sends a chat message to the presenter, it appears in only the presenter's chat viewer.

**Panelist**—Specifies that attendees can chat privately with any panelist or all panelists.

**All attendees**—Specifies that attendees can chat with either
- other attendees at once, not including the training session host, the presenter, and all other panelists, or
- all participants at once, including all attendees, the training session host, the presenter, and all other panelists.

### Breakout sessions with

**Host**—Specifies that all attendees can join breakout sessions with only the training session host. This privilege is set as a default.

**Presenter**—Specifies that all attendees can join breakout sessions with only the presenter. This privilege is set as a default.

**Panelists**—Specifies that attendees can join breakout sessions with any panelist or all panelists. This privilege is set as a default.

**All attendees**—Specifies that attendees can join breakout sessions with either
- other attendees, not including the session host, the presenter, and all other panelists, or
- all participants, including all attendees, the host, the presenter, and all other panelists.
Chapter 16: Managing Chat
Using Feedback

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using Feedback</td>
<td>About using feedback on page 191</td>
</tr>
<tr>
<td>allow participants to use Feedback options</td>
<td>Allowing participants to provide feedback on page 192</td>
</tr>
<tr>
<td>view a running tally of responses</td>
<td>Viewing a running tally of responses on page 193</td>
</tr>
<tr>
<td>provide feedback</td>
<td>Providing feedback on page 193</td>
</tr>
<tr>
<td>use emoticons in feedback</td>
<td>Using emoticons in feedback on page 194</td>
</tr>
<tr>
<td>remove responses from the Participants panel</td>
<td>Removing feedback on page 195</td>
</tr>
</tbody>
</table>

About using feedback

Feedback is a feature that allows the presenter to pose a question at any time—either verbally during a teleconference or Integrated VoIP conference, or in a chat message—and receive instant feedback from other participants.

As the host, you can:

- allow attendees to provide feedback
- respond to the presenter’s verbal request for feedback
- provide unsolicited feedback
- view the results on the Feedback palette
Chapter 17: Using Feedback

As the presenter, you can:

- pose a question and request feedback
- share the feedback results with all participants
- clear the feedback results
- view the results on the Feedback palette

As a participant, you can:

- click the **Raise Hand** button if the presenter asks for a show of hands in response to a question or if you have a question
- select **Yes** or **No** in response to a question
- select **Go Faster** or **Go Slower** to request that the presenter speed up or slow down his or her pacing
- select **Applause** or **Laughter** to express your emotions

**Allowing participants to provide feedback**

You can allow participants to use the Feedback options during a training session.

**To allow participants to use the Feedback options:**

1. On the **Session** menu, select **Session Options**.
   
   The Training Session Options dialog box appears.

2. Select the **Feedback** check box.
3. Click **Apply**, and then click **OK**.
   
   A Feedback column appears on the Participants panel.
Viewing a running tally of responses

You can view a running tally of responses from attendees during a training session.

**To view a running tally of responses:**

On the **Participants** panel, click the **Feedback** icon .

The Feedback palette appears.

Your Feedback palette displays a running tally of responses. See the following figure for an example.

On the Participants panel, a response indicator appears to the right of the name of each participant who has responded to a presenter’s question.

<table>
<thead>
<tr>
<th>Current Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of 2 Participant(s)</td>
</tr>
<tr>
<td>Yes: 1</td>
</tr>
<tr>
<td>No: 1</td>
</tr>
</tbody>
</table>

Providing feedback

You can provide feedback from the **Participants** panel.

The following table shows the types of feedback you can provide during a training session:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Feedback Icon]</td>
<td>click if the presenter asks for a show of hands in response to a question or if you have a question</td>
</tr>
<tr>
<td>![Yes Icon]</td>
<td>click to indicate yes in response to a question</td>
</tr>
</tbody>
</table>
Chapter 17: Using Feedback

Your Feedback palette displays a running tally of responses. On the Participants panel, a response indicator appears to the right of the name of each participant who has responded to a presenter’s question.

Using emoticons in feedback

You can use emoticons to express your feelings or status from the Participants panel by using the emoticons drop-down menu.

To use emoticons:

1. Click the Emoticons button on the Participants panel.

   The Emoticons palette appears.

2. Select one of the following emoticons from the palette.

<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🙊</td>
<td>click to indicate no in response to a question</td>
</tr>
<tr>
<td>🕍</td>
<td>click to indicate to the presenter to slow down his or her pacing</td>
</tr>
<tr>
<td>🕍</td>
<td>click to indicate to the presenter to speed up his or her pacing</td>
</tr>
<tr>
<td>🎉</td>
<td>click to open the Emoticons palette on which you can use an emoticon to express yourself</td>
</tr>
<tr>
<td>🙊</td>
<td>click the icon to display a running tally of responses</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🙌</td>
<td>applaud the presenter</td>
</tr>
<tr>
<td>🙌</td>
<td>approve the presenter</td>
</tr>
<tr>
<td>🤔</td>
<td>indicate you are taking a rest or break or would like to take a break</td>
</tr>
<tr>
<td>🙋</td>
<td>indicate you are not available</td>
</tr>
<tr>
<td>💡</td>
<td>indicate you have an idea</td>
</tr>
</tbody>
</table>
Chapter 17: Using Feedback

Removing feedback

You can remove all the feedback at any time during a training session.

To remove feedback (erase all responses):

1. On the Session menu, select Session Options.
   The Training Session Options dialog box appears.

2. Remove the check next to the Feedback check box.

3. Click Apply, and then click OK.
   The Feedback column is no longer showing and all feedback is cleared.
Using Breakout Sessions

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of breakout sessions</td>
<td>About Breakout sessions on page 197</td>
</tr>
<tr>
<td>use the Breakout Sessions window</td>
<td>Using the Breakout Session window on page 198</td>
</tr>
<tr>
<td>use the breakout sessions menus</td>
<td>Breakout Session menus on page 199</td>
</tr>
<tr>
<td>control breakout sessions</td>
<td>Controlling breakout sessions on page 202</td>
</tr>
<tr>
<td>present a breakout session</td>
<td>Presenting breakout sessions on page 209</td>
</tr>
</tbody>
</table>

About Breakout sessions

A breakout session is a private content sharing session that includes two or more participants. Breakout sessions allow participants to brainstorm and collaborate in small, private groups that can include presenters or other students, away from the main training session. In a breakout session, small groups interact within a main Breakout Session window using much of the same features, such as sharing whiteboards and applications, as in the main training session. Multiple breakout sessions can occur at once. For more information about the Breakout Session window, see Using the Breakout Session window on page 198.

Only those who are participating in a breakout session can view shared content. You can view a list of current breakout sessions in the main Session window on the Breakout Sessions panel.

In a breakout session, the participant who starts and conducts the breakout session is designated as the presenter of the breakout session. The Presenter’s icon appears next to the presenter’s name on the Breakout Session’s Participant’s panel.

For participants to start and join breakout sessions, the presenter must first allow breakout sessions for the training session. Then the host, the presenter, or an attendee who has breakout session privileges can create a breakout session.
Chapter 18: Using Breakout Sessions

Using the Breakout Session window

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of Breakout Session window</td>
<td>Breakout Session window overview on page 198</td>
</tr>
<tr>
<td>get an overview of Breakout Session panels</td>
<td>Breakout Session panel overview on page 199</td>
</tr>
<tr>
<td>get an overview of Breakout Session menus</td>
<td>Breakout Session menus on page 199</td>
</tr>
</tbody>
</table>

Breakout Session window overview

The Breakout Session window appears in the main session window once you start or join a breakout session. It provides the ability for you to share documents or presentations, applications, whiteboards, or your desktop during a breakout session.

When you are viewing the Breakout Session window, the words Breakout Session appears on the Breakout Session Quick Start and Info tabs, and on the title bar of the window. The Breakout Session window has its own menus and toolbar. It also has a Breakout Session panel that allows you to view the presenter and participants of the breakout session. You can also chat with the other breakout session participants using the Chat box on the Breakout Session panel.
Breakout Session panel overview

The Breakout Session panel appears on the right side of the Breakout Session Manager window during a breakout session. It allows you to view the presenter and participants of the breakout session. You can also chat with the other breakout session participants using the Chat box on the Breakout Session panel.

When an application, desktop, Web browser, or document is shared in a breakout session, the Breakout Session panel appears on each participant’s desktop as a floating panel. You can then access the Sharing menu by clicking the Sharing button on the title bar of the Breakout Session Manager window or any shared window.

Breakout Session menus

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about Breakout Session File menu</td>
<td>Breakout Session File menu on page 200</td>
</tr>
</tbody>
</table>
### Chapter 18: Using Breakout Sessions

<table>
<thead>
<tr>
<th><strong>If you want to...</strong></th>
<th><strong>See...</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about Breakout Session Edit menu</td>
<td>Breakout Session Edit menu on page 200</td>
</tr>
<tr>
<td>learn about Breakout Session Share menu</td>
<td>Breakout Session Share menu on page 201</td>
</tr>
<tr>
<td>learn about Breakout Session View menu</td>
<td>Breakout Session View menu on page 201</td>
</tr>
<tr>
<td>learn about Breakout Session Communicate menu</td>
<td>Breakout Session Communicate menu on page 201</td>
</tr>
<tr>
<td>learn about Breakout Session Participant menu</td>
<td>Breakout Session Participant menu on page 202</td>
</tr>
</tbody>
</table>

**Breakout Session File menu**

The **File** menu in the Breakout Session window is similar to the **File** menu in the main Session window. You can add whiteboard pages, open and close files, save documents and chats, print, end the breakout session (if you are the presenter of that session), or leave the breakout session (if you are a participant). You cannot end a training session, and you cannot transfer files or upload files to My WebEx using the **File** menu in a breakout session.

**Breakout Session Edit menu**

The **Edit** menu in the Breakout Session window is similar to the **Edit** menu in the main Session window. Using the **Edit** menu, you can edit and annotate shared content in the content viewer. The **Find** command and the **Preferences** command are not available on the **File** menu in a breakout session.
Breakout Session Share menu

Share

- Presentation or Document...
- Application...
- Desktop...
- Whiteboard
- Web Content in Page...
- Web Browser

The **Share** menu in the Breakout Session window works the same way as the **Share** menu in the main Session window.

Breakout Session View menu

View

- Full Screen  Alt+Enter
- Thumbnails
- Zoom In  Ctrl++
- Zoom Out  Ctrl+-
- Zoom By
- Fit in Viewer
- Fit to Width  Ctrl+Shift+1-W
- Automatically Advance Pages...
- Synchronize for All
- Close QuickStart
- Show QuickStart to all participants

The **View** menu in the Breakout Session window works the same way as the **View** menu in the main Session window. The only difference is that the **Panels** command refers to viewing the **Breakout Session panel** only.

Breakout Session Communicate menu

Communicate

- Join Teleconference...
- Audio Setup Wizard...
- Integrated VoIP
Chapter 18: Using Breakout Sessions

The **Communicate** menu in the Breakout Session window is similar to the **Communicate** menu in the main Session window. The only differences are that you cannot open chat or feedback from the **Communicate** menu in a breakout session. Depending on your role and privileges during a breakout session, the **Communicate** menu provides commands to

- join, leave, or switch to a teleconference— all participants
- start or end an Integrated VoIP conference— current presenter of breakout session
- run the Audio Setup Wizard— all participants
- join an Integrated VoIP conference— all participants
- adjust volume in an Integrated VoIP conference— all participants
- mute or unmute your microphone in an Integrated VoIP conference— all participants

**Breakout Session Participant menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pass Microphone</td>
<td>Ctrl+Alt+M</td>
</tr>
<tr>
<td>Mute</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Unmute</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Mute All</td>
<td></td>
</tr>
<tr>
<td>Unmute All</td>
<td></td>
</tr>
<tr>
<td>Pass Presenter Role</td>
<td></td>
</tr>
<tr>
<td>Limit Attendance...</td>
<td></td>
</tr>
<tr>
<td>Expel from Breakout Session</td>
<td></td>
</tr>
</tbody>
</table>

The **Participant** menu in the Breakout Session window is similar to the **Participant** menu in the main Session window. Using the **Participant** menu, you can make a participant the current speaker, mute and unmute microphones, pass the presenter role to another participant, limit attendance to the breakout session, and expel a participant from a breakout session (training session presenter only). Breakout session participants are limited to muting themselves and asking for the microphone.

**Controlling breakout sessions**

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of control breakout sessions</td>
<td>About controlling breakout sessions on page 203</td>
</tr>
</tbody>
</table>
Chapter 18: Using Breakout Sessions

About controlling breakout sessions

During a training session, depending on your role and privileges, you can control breakout sessions by doing the following:

- Specify breakout session privileges for attendees.
- Allow participants to start their own breakout sessions.
- Create a breakout session for another participant.
- Ask panelists and participants to return from their breakout sessions.
- End all of the breakout sessions at once.
- Request a breakout session presenter to share content.
- Remove a participant from a breakout session.

Granting breakout session privileges

At any time during a training session, you can specify that attendees can start breakout sessions with

- all attendees or all participants
- only the training session host
- only the presenter
- any other attendee, privately

You can also remove breakout session privileges at any time.

To specify privileges for attendees during a breakout session:

1. In the Session window, on the Participant menu, choose Assign Privileges. The Assign Privileges dialog box appears.
2 Under Communications, select the check box next to Breakout sessions with:
Then select the check boxes for the breakout session privileges that you want to grant to all attendees:

- Host
- Presenter
- Panelists
- All attendees

3 Click OK.

Note The training session host and the presenter always have all breakout session privileges, regardless of the breakout session privileges that other attendees have.

Allowing breakout sessions

As a presenter, you can allow panelists or participants to start their own breakout sessions.

To allow breakout sessions:
Do one of the following:

- In the Session window, on the Breakout menu, choose Allow Breakout Sessions.
Chapter 18: Using Breakout Sessions

- On the Breakout Sessions panel, select **Allow Breakout Sessions**.

- In the Session window, on the **Session** menu, choose **Session Options**. On the **Communications** tab in the Training Session Options dialog box, select **Breakout sessions**. Then click **OK**.

  The green indicator on the Breakout Sessions panel indicates that breakout sessions are allowed.

  The Breakout menu displays the breakout session options for all participants.

**Note**

When a participant who has already joined the main teleconference session (WebEx integrated call-in or call-back teleconference only) joins a breakout session, he or she is switched from the main session teleconference to the breakout session teleconference automatically. Participants cannot join a teleconference in the main session while connected to a breakout session teleconference.

If teleconferencing is not available or has not been started for the main session before the breakout session is started, teleconferencing for breakout sessions is disabled also.

When a participant who is in the breakout session teleconference leaves a breakout session, he or she disconnects from the breakout session teleconference automatically. The participant returns to the main teleconference by selecting **Join Teleconference** on the Communicate menu.
Creating a breakout session for another participant

For host, panelists, or training session presenters only

As the training session presenter or panelist, you can create a breakout session and select another participant as the breakout session presenter.

To create a breakout session for another participant:

1. In the Breakout Session window, select the name of the participants whom you want to invite to the breakout session. To select more than one participant, hold down the Shift key while you select participants.

2. Do either of the following:
   - On the Breakout menu, point to Create Breakout Session.
   - On the Breakout Session panel, click Create Session.

   The Create Breakout Session dialog box appears.

3. In the Topic box, type a topic name.

   Optional for the host, presenter, and panelists only: To include yourself in the breakout session, select the Include myself into this session check box.

4. Under Participants, select the check box next to the participant for whom you are creating a breakout session.

5. In the Presenter drop-down list, select the participant whom you want to be the presenter for the session.
6 Optional. To allow participants to join the breakout session without an invitation, under Participants, select the check box next to Let others join the breakout session without invitation.

7 Optional. To limit the number of participants for the breakout session, under Participants, select the check box next to Limit number of participants who can join this session. Then, in the box, type or select a number of participants.

8 Click Create.
   The participant whom you selected to present receives an invitation to start the breakout session now or wait until later.

Asking all participants to return from a breakout session

As the presenter, you can ask panelists and participants to return from their breakout sessions.

To ask all to return from breakout sessions:

In the Session window, on the Breakout menu, choose Ask All to Return.

All participants in breakout sessions receive a message asking them to return to the main training session. They can choose to leave the session or continue.

Ending all breakout sessions

As the presenter, you can end all of the breakout sessions at once.

To end all breakout sessions:

In the Session window, on the Breakout menu, choose End All Sessions.

All participants receive a message that their breakout session will end in 30 seconds.

Requesting a breakout session presenter to share content

As the training session presenter, you can request a breakout session presenter to share his or her shared content in the main training session. Before a breakout session presenter can share content in the main session, you must end all the breakout sessions.

To request a breakout session presenter to share content:

1 In the Session window, on the Breakout menu, choose Share Breakout Session Content.
   The Share Breakout Session Content dialog box appears. The names of the breakout sessions and the names of the last presenters of the breakout sessions appears in a list.
Chapter 18: Using Breakout Sessions

2 Select the name of the presenter in the list whom you want to request to share breakout session content.

3 Click OK.

The last presenter receives instructions for sharing content from the breakout session in the main training session.

Removing a participant from a breakout session

As the original presenter of a training session, you can remove a participant from a breakout session. Removing a participant from a breakout session does not remove him or her from the main training session.

To remove a participant from a breakout session:

1 In the Breakout Session window, in the participant list on the Breakout Session panel, select the name of the participant whom you want to remove from the breakout session.

2 On the Participant menu, choose Expel from Breakout Session.

A confirmation message appears, in which you can verify that you want to remove the participant from the breakout session.

3 Click Yes.

The participant is removed from the breakout session.
Presenting breakout sessions

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of presenting a breakout session</td>
<td>About presenting a breakout session on page 209</td>
</tr>
<tr>
<td>create a breakout session</td>
<td>Creating a breakout session on page 210</td>
</tr>
<tr>
<td>start a breakout session that was created for you</td>
<td>Starting a breakout session that was created for you on page 212</td>
</tr>
<tr>
<td>leave a breakout session</td>
<td>Leaving a breakout session on page 212</td>
</tr>
<tr>
<td>use Integrated VoIP or teleconferencing in a breakout session</td>
<td>Using Integrated VoIP or teleconferencing in breakout sessions on page 212</td>
</tr>
<tr>
<td>let more participants join the breakout session</td>
<td>Letting more participants join the breakout session on page 215</td>
</tr>
<tr>
<td>prevent more participants from joining a breakout session</td>
<td>Preventing more participants from joining a breakout session on page 216</td>
</tr>
<tr>
<td>specify a number of participants who can join a breakout session in progress</td>
<td>Specifying a number of participants who can join a breakout session in progress on page 216</td>
</tr>
<tr>
<td>pass the presenter role to another participant</td>
<td>Passing the presenter role to another participant on page 217</td>
</tr>
<tr>
<td>present information in a breakout session</td>
<td>Presenting information in a breakout session on page 217</td>
</tr>
<tr>
<td>grant remote control to a participant in a breakout session</td>
<td>Granting remote control to a participant in a breakout session on page 218</td>
</tr>
<tr>
<td>end your breakout session</td>
<td>Ending your breakout session on page 218</td>
</tr>
<tr>
<td>share content from your breakout session in the main session</td>
<td>Sharing content from your breakout session in the main session on page 219</td>
</tr>
</tbody>
</table>

About presenting a breakout session

Once you start a breakout session, you can begin sharing content. The Breakout Session window replaces the main Session window on your desktop. You conduct your breakout session using the options available in the Breakout Session window menus and the Sharing menu that appears on your screen.

As the presenter of the breakout session, you can:

- Use teleconferencing or an Integrated VoIP conference. For details, see Using Integrated VoIP or teleconferencing in breakout sessions on page 212.
- Let more participants join a breakout session. For details, see Letting more participants join the breakout session on page 215.
- Prevent more participants from joining a breakout session. For details, see Preventing more participants from joining a breakout session on page 216.
- Specify the number of participants who can join the session. For details, see Specifying a number of participants who can join a breakout session in progress on page 216.
Pass the presenter role to another participant. For details, see *Passing the presenter role to another participant* on page 217.

- Present information from your computer. For details, see *Presenting information in a breakout session* on page 217.

- Let another participant remotely control your application or desktop. For details, see *Granting remote control to a participant in a breakout session* on page 218.

- End the breakout session. For details, see *Ending your breakout session* on page 218.

- Share content from your breakout session in the main session (last presenters only). For details, see *Sharing content from your breakout session in the main session* on page 219.

### Creating a breakout session

Once the presenter allows breakout sessions, you can create your own session.

**To create a breakout session:**

1. Do either of the following:
   - On the Breakout menu, point to Create Breakout Session.
   - On the Breakout Session panel in the main Session window, click Create Session.

   The Create Breakout Session dialog box appears.
2 In the **Topic** box, type a topic name.

Optional for the host, presenter, and panelists only: To include yourself in the breakout session, select the **Include myself into this session** check box.

3 Under **Participants**, select the check box next to the participants that you would like to invite to the breakout session.

4 In the **Presenter** drop-down list, select **Myself** or the name of the participant whom you want to be the presenter for the session.

5 Optional. To allow participants to join the breakout session without an invitation, under **Participants**, select the check box next to **Let others join the breakout session without invitation**.

6 Optional. To limit the number of participants for the breakout session, under **Participants**, select the check box next to **Limit number of participants who can join this session**. Then, in the box, type or select a number of participants.

7 Click **Create**.

Your breakout session automatically starts, and each invitee receives an invitation to join. The invitee can choose **Yes** or **No**. For breakout session participants, the Breakout Session window appears, listing the names of the presenter and participants of the breakout session in the Breakout Sessions panel. It also displays a chat panel in which participants can chat with other participants. Your name appears in the Breakout Sessions pane in the main Session window.
Starting a breakout session that was created for you

The training session host, presenter, or panelist may create a breakout session by inviting participants and designate you as the presenter.

To start a breakout session that was created for you:
1. In the message box that you receive when someone else creates a breakout session for you, click Yes.
2. Optional. To start the breakout session later, click No. You can start the breakout session any time by selecting the name of the session or your name on the Breakout Session panel, and then clicking Start Session.

Joining a breakout session

The presenter determines whether a participant can join a breakout session, either by inviting participants, or by allowing participants to join without an invitation.

For details on Integrated VoIP or teleconferencing in a breakout session, see Using Integrated VoIP or teleconferencing in breakout sessions on page 212.

To join a breakout session, do one of the following:
- On the Breakout menu, choose Join Breakout Session and then the name of the breakout session that you wish to join.
- On the Breakout Session panel, highlight the name of the breakout session that you wish to join and then click Join Session.

Leaving a breakout session

If you are a participant in a breakout session, rather than the presenter, you can leave a session and return to it later.

To leave a breakout session, do one of the following:
- Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window.
- On the File menu, choose Leave Breakout Session.
- On the Breakout Session panel, click Return to Main Session.

Using Integrated VoIP or teleconferencing in breakout sessions

You can communicate with breakout session participants using Integrated VoIP or teleconferencing. If teleconferencing is set up in the main training session, when you start a breakout session, the call-in or call-back teleconference automatically starts for the breakout session. All the teleconferencing options or Integrated VoIP options that the host set up in the main session apply to the breakout sessions.
Chapter 18: Using Breakout Sessions

Note

- Participants in a breakout session cannot join a breakout session teleconference until the breakout session presenter joins the teleconference.

- When a participant who has already joined the main teleconference session (WebEx integrated call-in or call-back teleconference only) joins a breakout session, he or she is switched from the main session teleconference to the breakout session teleconference automatically. Participants cannot join a teleconference in the main session while connected to a breakout session teleconference.

- If teleconferencing is not available or has not been started for the main session before the breakout session is started, teleconferencing for breakout sessions is disabled also.

- When a participant who is in the breakout session teleconference leaves a breakout session, he or she disconnects from the breakout session teleconference automatically. The participant returns to the main session and can join the main teleconference by selecting Join Teleconference on the Communicate menu.

Starting an Integrated VoIP conference during a breakout session

To use an Integrated VoIP conference, your computer must meet the system requirements for Integrated VoIP. For details, see Starting an Integrated VoIP conference on page 40.

When you start an Integrated VoIP conference in a breakout session, all the Integrated VoIP options that the host set up in the main session apply to the breakout sessions.

To start an Integrated VoIP conference in a breakout session:

1. In the Breakout Session window, on the Communicate menu, point to Integrated VoIP, and then choose Start Conference.

2. Optional. To use the Volume dialog box to adjust the volume of your speakers or microphone or to mute or unmute your speakers or microphone, point to Integrated VoIP, and then choose Volume.

3. Optional. To use the Audio Setup Wizard to set up audio options, choose Audio Setup Wizard on the Communicate menu.

The following occur:

- The Volume dialog box appears, on which you can adjust the speaker or microphone volume.

- A microphone symbol appears to the left of your name in the participant list on the Breakout Sessions Manager panel.
Chapter 18: Using Breakout Sessions

Note The microphone symbol flashes to indicate which participant is speaking during the breakout session.

The Join Integrated VoIP Session message box automatically appears in the Session window for each participant in the breakout session whose computer has a supported sound card. Participants can then choose to participate in the Integrated VoIP conference.

Ending an Integrated VoIP conference in a breakout session

You can end an Integrated VoIP conference at any time during a breakout session.

To end an Integrated VoIP conference:
In the Breakout Session Manager window, on the Communicate menu, point to Integrated VoIP, and then choose End Conference.

Integrated VoIP is no longer available to participants during the breakout session.

For details on rejoining the main session Integrated VoIP conference, see Starting an Integrated VoIP conference on page 40.

Starting a teleconference during a breakout session

If you are in the main session teleconference when a breakout session starts, the following dialog box appears.

If you select Yes, you are switched to a breakout session teleconference.

If you select No, you will not join the breakout session teleconference at this time. However, you can join later by selecting Switch to Breakout Teleconference from the Communicate menu.

Ending a teleconference in a breakout session

When you leave a breakout session teleconference, you will rejoin the main teleconference automatically.
Letting more participants join the breakout session

You can choose to allow more participants to join the breakout session that is in progress.

**To let more participants join a breakout session in progress:**

1. In the Breakout Session Manager window, on the Participant menu, choose Limit Attendance.
   
   The Limit Attendance dialog box appears.

   ![Limit Attendance dialog box](image)

   2. Select the check box next to Let more participants join this session without invitation.

   3. Optional. To allow an unlimited number of participants to join the breakout session in progress, be sure to clear the check box next to Limit number of participants who can join this session.

   4. Click OK.

   Your breakout session becomes open for more participants to join.

**Note**

- If when starting the session, you specified a number of participants who can join the session, only that number of participants can join the session, even if the Let more participants join this session without invitation command is selected.

- You can prevent more participants from joining a breakout session, regardless of the limit, if any, that you specified when starting the session or during the session. For details, see Preventing more participants from joining a breakout session on page 216.

- You can limit the number of participants who can join a breakout session at any time after starting the session. For details, see Specifying a number of participants who can join a breakout session in progress on page 216.
Preventing more participants from joining a breakout session

As presenter in a breakout session, you can prevent more participants from joining your breakout session. No participants can join your session, regardless of the limit, if any, that you specified when starting the session or during the session.

**To prevent participants from joining a breakout session in progress:**

1. In the Breakout Session window, on the Participant menu, choose Limit Attendance. The Limit Attendance dialog box appears.
2. Clear the check box next to Let more participants join this session without invitation.
3. Click OK.

**Note** You can limit the number of participants who can join a breakout session at any time after starting the session. For details, see Specifying a number of participants who can join a breakout session in progress on page 216.

Specifying a number of participants who can join a breakout session in progress

You can limit the number of participants who can join your breakout session at any time after starting the session.

**To specify the number of participants who can join a breakout session in progress:**

1. In the Breakout Session window, on the Participant menu, choose Limit Attendance. The Limit Attendance dialog box appears.
2. Select the check box next to Let more participants join this session without invitation.
3. Select the check box next to Limit number of participants who can join this session. Then, in the box, type or select a number of participants.
4. Click OK.

**Note** At any time, you can prevent more participants from joining a breakout session, regardless of the limit, if any, that you specified when starting the session or during the session. For details, see Letting more participants join the breakout session on page 215.
Passing the presenter role to another participant

As the breakout session presenter, you can pass the presenter role to another breakout session participant. The presenter of the breakout session is responsible for conducting the breakout session.

To pass the presenter role:

1. On the Breakout Session panel, in the participant list, select the name of the participant to whom you want to pass the presenter role.

2. Do either of the following:
   ■ In the Breakout Session window, on the **Participant** menu, choose **Pass Presenter Role**.
   ■ On the Breakout Session panel, click **Make Presenter**.

The selected participant is now the presenter of the breakout session. The green presenter indicator appears to the right of the participant’s name.

**Note** You cannot pass the presenter role when sharing an application, your desktop, or a Web browser.

Presenting information in a breakout session

Presenting and sharing information in a breakout session works similarly to presenting information in the main session. The only difference is that you select what content or software that you want to share from the **Share** menu within the Breakout Session window. The **Share** menu in the Breakout Session window works the same way as the **Share** menu in the main Session window.

In a breakout session, you can choose to share

■ documents or presentations
■ a whiteboard in the Breakout Session window
■ a Web browser
■ your desktop
■ an application
■ UCF multimedia

For information on presenting information in a training session, see About sharing applications on page 120 and About sharing presentations, documents, and whiteboards on page 61.
Granting remote control to a participant in a breakout session

During a breakout session, you can allow another participant to remotely control your application. A participant who has remote control of shared software can interact with it completely.

Caution  A participant who has remote control of your desktop can run any programs and access any files on your computer that you have not protected with a password.

To grant remote control of a shared application to a breakout session participant:
1  On the title bar of the Breakout Session window or any shared window, click the Sharing button .
2  On the menu that appears, point to Allow to Control Remotely, and then choose the participant to whom you want to grant remote control.

Once the participant assumes control, your mouse pointer is no longer active.

Note
■ You can reassert control of a shared application at any time by clicking your mouse.
■ If a participant requests remote control, a request message appears next to your mouse pointer.
■ On the Allow to Control Remotely menu, a question mark appears to the left of the name of the participant who requested remote control.

Ending your breakout session

If you are the presenter in a breakout session, you can end your session for all participants.

To end a breakout session:
1  Do one of the following:
   ■ Close the Breakout Session Manager window by clicking the Close button in the upper-right corner of the window.
   ■ On the File menu in the Breakout session window, choose End Breakout session.
   ■ On the Breakout Sessions panel in the main Session window, click End Breakout Session.
2  In the dialog box that appears, click Yes.
Sharing content from your breakout session in the main session

If the training session presenter or host sends you a request, you can share content that you shared in a breakout session when you return to the main training session. To be able to share content in the main session, the training session presenter must have ended all the breakout sessions.

To share breakout session content in the main session:

1. If the training session presenter or host sends you a request to share breakout session content, the Share Breakout Session Content dialog box appears. The content that you shared in your breakout session appears in a list.

2. Select the content that you want to share in the main training session. Hold down the Shift key to select more than one choice.

3. Click OK.

Training Manager first opens the shared content, then displays it in your content viewer. Attendees can then view the shared content in their content viewers.

You can share the content in the main session the same way that you did in the breakout session.
Sending Video

### About sending live video

If a video camera is attached to your computer, you can send live video to training session participants. Live video lets other participants see you, an object under discussion, and so on. All participants can view live video that you send, without the need for video equipment installed on their computers.

**Note** Video features are not available on the Mac.

### Setting up video

To set up video, you must connect a video camera—also called a webcam—to your computer. Once you start or join a training session, Training Manager automatically detects your video camera.
Chapter 19: Sending Video

Generally, Training Manager is compatible with any video camera that connects to your computer's USB or parallel port. The quality of the video image can vary, depending on the quality of the video camera that you use. For a list of video cameras that are known to be compatible with your Training Manager software, refer to the Frequently Asked Questions (FAQ) page on your Training Center Web site. You can access this page from your site's Support page.

**Important** After you install your webcam software, check that your webcam is operating properly. Then close the software program you installed with your webcam before starting or joining a training session. WebEx does not need this software program running during training sessions and leaving this program running could interfere with the video features in your training session.

---

### Sending live video

If the single-point video option is turned on, only the presenter or another participant selected by the presenter can send live video.

If the multipoint video option is turned on, up to four participants whose computers have a video camera can send video.

**To send live video:**

In the Session window, open the Video panel.

Training Manager begins sending live video immediately.

To send live video, you must connect a video camera to your computer. For details, see Setting up video on page 221.

If you are sending video and at least one participant is viewing the video, you see an orange indicator on the video panel or floating icon tray (if you are sharing in full-screen).
Chapter 19: Sending Video

Specifying video camera options

While sending live video during a training session, you can specify:

■ Quality of the video image—that is, how “fast” images appear to participants
■ Resolution of the video image
■ Which video camera you want to use, if multiple cameras are attached to your computer

If more than one camera is attached to your computer, you can also select the video camera that you want to use.

To specify video camera options:

1 In the Session window, on the Video panel, click Options.
   The Video Options dialog box appears.
2 Specify the options that you want.
   For details about the options on the Video Options dialog box, see About video options on page 223.
3 Click OK.

About video options

You can change the quality of the video image by adjusting the number of frames per second and changing the video resolution. Use the Video Options dialog box to easily make changes.

To access the Video Options dialog box: In the Session window, open the Video panel, and then click Options.
### Session Options

<table>
<thead>
<tr>
<th>Note</th>
<th>These options appear only for presenters if the multipoint video option is turned on.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Congestion control</strong></td>
<td>Control the amount of video data that other participants’ video cameras can send during a training session. Move the slider up or down to adjust the following for all other participants’ video cameras:</td>
</tr>
</tbody>
</table>

| **Maximum resolution**—The resolution of the video image that participants’ cameras send. A higher resolution produces clearer video images, but uses more resources on the computers of participants who are sending video images, and uses more bandwidth for all participants’ Internet connections. |

| **Frames-per-second**—A higher frame rate produces faster video, but uses more resources on the computers of participants who are sending video images, and uses more bandwidth for all participants’ Internet connections. |

### Personal Options

| **Video frame rate** | Using the slider, adjust the number of video frames per second that your camera sends. Or type a number in the box. You can specify a rate of 0 to 30 frames per second. A higher frame rate produces faster video, but uses more resources on your computer and bandwidth for your Internet connection. |

| **Video resolution** | Select the resolution of the video image that your camera sends. A higher resolution produces clearer video images, but uses more resources on your computer and bandwidth for your Internet connection. |

| **Capture device** | If more than one video camera is attached to your computer, select which camera you want to use in the drop-down list. **Allow others to remotely control my cam**—Available only if your video camera has remote control capability. Specifies that the presenter can remotely control your video camera that is, move the camera left, right, up, or down. |

### Securing your privacy in a training session with live video

If your camera is sending video and you need to stop the transmission for any reason, you have two options: closing the View panel or freezing the video until you are ready to send video again.

**To close the View panel:**

1. On the icon tray above the panels, click **Panels**. The Select Panel menu displays.

2. On the Select Panel menu, click to remove the check mark next to the Video panel.
To reopen the View panel:

1. On the icon tray above the panels, click **Panels**.
   
The **Select Panel** menu displays.

2. On the **Select Panel** menu, choose **Video**.
   
The **Video** panel reopens.

To freeze live video:

- If you are viewing video on the **Video** panel or in a floating video window, click **Freeze**.
- If you are viewing video in a full-screen view, click anywhere in the video image. Then click **Freeze**.

The video image pauses on all participants' screens.

To resume sending live video:

- If you are viewing video on the **Video** panel or in a floating video window, click **Unfreeze**.
- If you are viewing video in a full-screen view, click anywhere in the video image.

The live video image resumes on all participants' screens.
Information Resources

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of available info</td>
<td>Obtaining more information and assistance on page 227</td>
</tr>
<tr>
<td>learn about features on the Support page</td>
<td>About the Support page on page 228</td>
</tr>
<tr>
<td>learn about features on the Training page</td>
<td>About the Training page on page 229</td>
</tr>
</tbody>
</table>

Obtaining more information and assistance

Your Training Center Web site provides numerous resources for learning about features, getting answers to questions, and contacting WebEx.

To get started, on the navigation bar on the left side of the page, click the icon next to Assistance to display the Assistance menu.
Accessing the Support page

To learn about the kinds of support offered, go to the Support page. From your Training Center Web site, on the left navigation bar, click Assistance > Support.

About the Support page

On the Support page, you’ll find many links to information about products, services, getting help, and contacting WebEx.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Use these tools...</th>
</tr>
</thead>
<tbody>
<tr>
<td>contact technical support</td>
<td>Under Contact Us:</td>
</tr>
<tr>
<td></td>
<td>▪ Click the email link to send a message to the Help desk</td>
</tr>
<tr>
<td></td>
<td>▪ Use the phone numbers listed to speak with a technical support representative</td>
</tr>
<tr>
<td>send a comment or feature request</td>
<td>Under Contact Us, click the Feedback Form link and complete form</td>
</tr>
<tr>
<td></td>
<td>Alternatively, you can send an email message to: <a href="mailto:feedback@webex.com">feedback@webex.com</a></td>
</tr>
<tr>
<td>learn about using WebEx products and services</td>
<td>Under Documentation:</td>
</tr>
<tr>
<td></td>
<td>▪ Click the links to view release notes and frequently asked questions</td>
</tr>
<tr>
<td></td>
<td>▪ Click a link for any document listed in this section. These documents are available in pdf format, so you can easily print them</td>
</tr>
<tr>
<td></td>
<td>▪ You’ll find short guides to help you get started as well as comprehensive user guides.</td>
</tr>
<tr>
<td>download products that help you run effective training sessions</td>
<td>Under Downloads:</td>
</tr>
<tr>
<td></td>
<td>Click any of the links to download tools, such as:</td>
</tr>
<tr>
<td></td>
<td>▪ Training Manager</td>
</tr>
<tr>
<td></td>
<td>▪ Access Anywhere</td>
</tr>
<tr>
<td></td>
<td>▪ WebEx Recorder, WebEx Player, and WebEx Recording Editor</td>
</tr>
<tr>
<td></td>
<td>▪ WebEx Universal Communications Toolkit</td>
</tr>
<tr>
<td></td>
<td>▪ My WebEx Integration to Outlook</td>
</tr>
</tbody>
</table>
Attending WebEx training

Go to the Training page to learn about training opportunities. From your Training Center Web site, on the left navigation bar, click Assistance > Training.

Click Training to learn about courses that are available or to contact the training team.

About the Training page

You can use our self-pace training, enroll in a training session, or work with a consultant to create personalized training for you or your group.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Use these tools...</th>
</tr>
</thead>
<tbody>
<tr>
<td>take part in a training course</td>
<td>Under Attend Training, click the link to the Online Training Registration page.</td>
</tr>
<tr>
<td></td>
<td>You will learn about self-paced and instructor-led courses. You can also print a</td>
</tr>
<tr>
<td></td>
<td>course catalog from the registration page.</td>
</tr>
<tr>
<td>learn about other training options, such as finding a consultant or specialized training</td>
<td>Under Take Advantage of all our Training Services, follow the links to learn about training courses and other services, such as:</td>
</tr>
<tr>
<td></td>
<td>■ WebEx University: A full suite of engaging, interactive classes</td>
</tr>
<tr>
<td></td>
<td>■ WebEx Assist Services: Working with a team to provide hands-on assistance and</td>
</tr>
<tr>
<td></td>
<td>production with any WebEx training session</td>
</tr>
<tr>
<td>contact the WebEx training team</td>
<td>Under Contact Us:</td>
</tr>
<tr>
<td></td>
<td>■ Click the email link to send a message to the training team.</td>
</tr>
<tr>
<td></td>
<td>■ Use the phone numbers listed to speak with someone about your training options</td>
</tr>
</tbody>
</table>

Providing feedback about WebEx documentation

If you have comments about WebEx documentation, please send an email message to docs@webex.com.

In your email message, please specify the section to which your comment applies. If you would like to receive a response to your comments, please include your name and contact information in your message.

We look forward to hearing from you.
Glossary

A

Access Anywhere
A service on your Training Center Web site that lets you access a computer from a remote location.

Access Anywhere Agent
Software that you can install on a computer, to allow you to remotely access the computer’s desktop or applications.

Access Anywhere Server
A server that supports an Access Anywhere session that is, the connection between a local computer and a remote computer.

ActiveTouch Document Loader
A printer driver that converts a document or presentation into a format that you can open in the content viewer in the Session window. When you share a document or presentation during a training session, the ActiveTouch Document Loader prints it to a file, and then displays it in the content viewer.

application sharing
The act of sharing an application on your computer during a training session. All participants can view the shared application, which appears in a sharing window on their screens. Participants can see all of your activity in the application.

annotation mode
During a training session, a mode that lets you use your mouse pointer to annotate the shared software.

attendee
A participant who primarily views information that a presenter shares in a training session. An attendee also can perform other tasks according to his or her privileges.

attendee ID
An identification (ID) number that Training Center assigns to you once you join a training session that includes an integrated teleconference. You must provide this ID when joining a call-in teleconference so the teleconferencing service can match your call with your name in the participant list.
attendee privileges

See privileges.

authorized user

A user who has an account on your Training Center Web site and uses his or her user name and password to log in to the service.

B

breakout session

A private application or desktop sharing session, away from the main training session, which allows participants to collaborate and interact with presenters or other students in smaller groups.

C

call-back teleconference

A telephone conference in which a participant provides his or her phone number when joining a training session. The teleconferencing service calls the participant back and instructs the participant on how to join the teleconference.

call-in teleconference

A telephone conference in which a participant calls a phone number when joining a training session. When a participant calls the phone number, a voice response system guides the participant through the process of entering the training session number and his or her caller ID to join the teleconference.

chat

A method of communication by which training session participants send real-time text messages to each other.

company address book

A list of contacts in your personal address book that your site administrator maintains for your organization.

contact group

In your personal address book, a list of two or more contacts for which you provide a common name. Contact groups allow you to quickly invite several contacts to a training session all at once.

content

A document, presentation, or other type of content that a presenter shares in the content viewer.
content viewer
The content area on the left side of the Session window. When a presenter shares a document, presentation, or whiteboard, it appears in the content viewer.

D
desktop sharing
The act of sharing your computer desktop during a training session. All participants can view the shared desktop, which appears in a sharing window on their screens. Participants can see all of your activity on your desktop.

Document Manager
An application that you can use outside a training session to view a document, presentation, or whiteboard that you saved in the Universal Communications Format (UCF). Double-clicking a UCF file opens the Document Manager on your computer.

document and presentation sharing
Refers to sharing any type of document or presentation in the content viewer during a training session.

dual-mode voice conference
A voice conference in which both a teleconference and an Integrated VoIP conference are in progress concurrently. To listen to audio, a participant can use either a phone or speakers attached to his or her computer. To speak, a participant can use either a phone or microphone attached to his or her computer.

E
emoticons
Icons that attendees can use to convey voice inflections, facial expressions, and other gestures.

F
Feedback
A feature of Training Center that allows presenters to obtain quick yes-or-no attendee responses to questions that they ask, or receive attendees’ feedback on the pace of their presentations.
floating icon tray
A small toolbar that appears when you share software. On the floating icon tray, icons represent minimized panels that you can open during the sharing session, without having to return to the main Session window.

G.723
An international standard for compressing audio data and defining the data format Available in WebEx Recorder.

Hands-on Lab
Sessions within a training session that simulate a physical computer lab, allowing participants to use computers remotely for hands-on learning and practice.

host
A participant who is primarily responsible for scheduling, starting, controlling access to, and ending a training session. A host must have a host account.

host indicator
The text (host), which appears in the participants list, to the right of the host’s name.

host key
A number that Training Center assigns to a training session host. If a host transfers the host role to an attendee, or otherwise loses control of a training session, the original host can use the host key to reclaim the host role.

icon tray
The area above the panels in the Session window. On the icon tray, icons represent minimized panels that you can open.

Info tab
A standard tab that appears by default in the content viewer. The Info tab contains basic information about a training session and its teleconference.
**instant training session**
An impromptu training session that you start immediately, without scheduling it first. Instant training sessions require fewer setup options than scheduled training sessions.

**integrated teleconference**
A teleconferencing service that is included with Training Center, rather than a third-party teleconferencing service. An integrated teleconference can be either a call-in or call-back teleconference.

**Integrated VoIP**
A type of voice conference that allows participants to communicate over the Internet using voice over IP (VoIP) and a computer with a sound card, speakers, and a microphone.

**L**

**local computer**
The computer that you use to access a remote computer during an Access Anywhere session.

**M**

**MediaTone**
Technologies that enhance the multimedia capabilities of Training Center. For example, MediaTone includes the Universal Communications Format (UCF), Access Anywhere, and multiple document sharing capabilities of Training Center.

**multipoint video**
A video mode in which the presenter and up to three other meeting participants can send video images simultaneously. In this mode, up to four video images can be displayed at once on the Video panel.

**My WebEx**
An area on your Training Center Web site in which you can access various user account features, such as your user profile, list of meetings, online address book, personal folders, One-Click Meetings, and so on.
One-Click Meeting
An online session that you can start at any time, as often as you want, by clicking a shortcut on your computer. You can set up a One-Click Meeting using the One-Click Meeting Wizard, which is available in the My WebEx area of your service Web site.

Panel
A group of controls that resides in an area of the Session window, to the right of the content viewer—for example, the Participants panel.

Panelist
An attendee who participates in a discussion to which other attendees listen, responds to chat messages, annotates shared documents, opens and closes polls, and views and answers attendees’ questions in Q & A sessions.

Participant
Refers collectively to all individuals in a training session, including the host, presenter, and attendees.

Participants List
The list of participants on the Participants panel in the Session window. Each name in the participant list represents a single computer connection to the training session.

PCM
Abbreviation for pulse-coded modulation. The audio format standard for CD-ROM. Available in WebEx Recorder.

Personal Address Book
An online address book that you maintain on your Training Center Web site. Your personal address book can contain a personal contacts list, contact groups, and a company address book.

Personal Contacts List
A list of individual contacts that you have added to your personal address book. If you have a Microsoft Outlook address book or contacts folder, you can import its contacts to this list of contacts.
personal folders
Storage space for your files on your Training Center Web site. If you store files in your folders, you can access them from any computer that is connected to the Internet. You can also share your folders so visitors to your Personal Meeting Room page can access the files in your folders.

Personal Meeting Room
A page on your Training Center Web site that lists only the training sessions for which you are the host. If you provide others with the personal URL for this page, they can obtain information about your scheduled training sessions, join your training sessions in progress, and share the files in your personal folders to which you provide access.

personal URL
The Web address for your Personal Meeting Room page.

Player
Software that plays back recordings that you make using the Recorder. Training Manager downloads and installs the Player on your computer the first time you record a meeting. If you have a user account, you can also download the Player from your Training Center Web site.

poll questionnaire
A list of questions or statements that a presenter prepares, to which attendees respond by selecting choices or typing answers.

presenter
A participant who provides information to other training session participants; can share documents, presentations, applications, desktops, Web browsers, and information on a whiteboard with others; or conduct a poll.

presenter indicator
A green symbol of a ball, which appears in the participants list, to the left of the name of the participant who is the current presenter.

privileges
A user's capabilities to use specific Training Center features. A host, presenter, and attendee each have different privileges in a training session.

question-and-answer (Q & A) sessions
A feature that allows participants in a training session to ask questions and receive answers from the host, presenter, or panelists.
Recorder
Software that records screen activity in any Windows application or in a training session. Training Manager includes an integrated version of the Recorder, which you can run during a training session.

Recording Editor
Software that allows you to edit any recording that was made using Recorder, that is, a Recording Format file. Using Recording Editor, you can add, delete, or rearrange recorded data; or dub audio.

recording file
See Recording Format.

Recording Format (WRF)
A file format that comprises audio and images of user actions on a computer screen. A user can create a WRF file using the Recorder and edit a WRF file using the Recording Editor. A WRF file has a .wrf extension.

remote computer
A computer on which you have installed the Access Anywhere Agent, allowing you to access the computer over the Internet, using a local computer.

remote control
Refers to a meeting participant's ability to control an application, desktop, or Web browser that a presenter is sharing on his or her computer.

SCORM
Sharable Courseware Object Reference Model. Set of technical standards allowing Web-based learning systems to find, import, share, reuse, and export learning content in a standardized way.

session number
A unique number that your Training Center assigns to a training session. For an unlisted session, participants must provide the session number to attend the session.

Session window
The main user interface with which participants interact during a training session. The Session window includes the content viewer, menus, toolbars, and panels.
shared content
A document, presentation, or other type of content that a presenter is sharing in the content viewer.

shared software
A general term that refers to the following types of software that a presenter can share in a training session: application, desktop, Web browser, and remote computer. Shared software appears in a sharing window on participants' screens.

sharing
During a training session, allowing attendees to view or control a document, presentation, whiteboard, application, desktop, or Web browser; or view a remote computer.

sharing window
A window that opens on participants' screens, in which a shared software appears.

single-point video
A video mode in which only the presenter, or a participant selected by the presenter, can send video images during a training session.

site administrator
An employee of a company who administers that company's Training Center Web site. A site administrator can add, modify, and remove user accounts; specify options; maintain a company address book for your Training Center service; and so on.

speaker indicator
A symbol of a phone or microphone, which appears in the participants list, to the left of the name of a participant who is connected in an integrated teleconference or Integrated VoIP conference.

streaming
A technology in which media is sent in a continuous stream over the Internet and displayed by a media player as it arrives on a user's computer. With streaming media, a user need not wait for his or her computer to download a large file before seeing or hearing the media.

third-party teleconferencing service
Any teleconferencing service other than the teleconferencing service that Training Center provides. You can use any third-party teleconferencing service for a training session.
thumbnail viewer
An area that a user can display on the left side of the Session window. The thumbnail viewer contains miniature images, or thumbnails, of each page in a shared document, presentation, or whiteboard.

training calendar
A calendar on your Training Center Web site that lists training sessions either in progress or scheduled. The calendar appears on the Live Sessions page.

Training Manager
Software that provides the Session window and sharing windows during a training session. Training Manager includes the Session window and sharing windows during a training session.

UCF
See Universal Communications Format (UCF).

UCF media file
A media file type that you can play in the content viewer during a training session or in the standalone Document Manager, including Recording Format (WRF), audio, video, Flash, and Web page files.

UCF media object
In a UCF multimedia presentation, an interface element that specifies the location of media file and includes controls for playing the file. You can insert media objects into a Microsoft PowerPoint presentation, using the Universal Communications Toolkit.

UCF multimedia presentation
A Microsoft PowerPoint presentation that contains UCF media files. You can share or view a UCF multimedia presentation in the content viewer or the standalone Document Manager, and play the media files in it.

UCF rich media
Refers to the following types of UCF media files: Recording Format (WRF), audio, video, and Flash.

Universal Communications Format (UCF)
A file type with the extension .ucf, which lets you do the following in a training session:

- Share multiple documents or presentations simultaneously.
- Display slide transitions and animations in Microsoft PowerPoint presentations.
Share and play UCF media files.

**Universal Communications Toolkit**
An add-in program for Microsoft PowerPoint that lets you insert rich media files into a PowerPoint presentation. You can then share the presentation and play the media files during a training session.

**unlisted training session**
A scheduled training session that does not appear on your Training Center Web site or on the host's Personal Meeting Room page. To join an unlisted training session, attendees must provide a training session number.

**user name**
A unique name that a user must provide, along with a password, to access a user account on your Training Center Web site.

**V**

**voice conference**
Collectively refers to any teleconference or Integrated VoIP conference that may be in progress during a training session.

**voice over IP (VoIP)**
A real-time voice communications technology by which computers send voice information in digital form over the Internet, rather than in the circuits of the traditional public telephone system.

**W**

**Web browser sharing**
The act of sharing your Web browser during a training session. All participants can view the shared Web browser, which appears in a sharing window on their screens. As you navigate to other Web pages in your browser, all participants “follow along” in their sharing windows.

**webcam**
A video camera attached to a computer that provides video images that a user can view on a Web site.

**WebEx Document Manager**
See Document Manager.
WebEx MediaTone Network (WMN)
A global network that provides secure, reliable, real-time communications services with predictable performance to your Training Center Web site. The network delivers optimal performance to Web sites by routing communications through the nearest WebEx hub.

WebEx Player
See Player.

WebEx Recorder
See Recorder.

WebEx Recording Editor
See Recording Editor.

WebEx Recording Format (WRF)
See Recording Format.

WebEx teleconferencing service
See teleconferencing service.

whiteboard
A workspace in the Session window that allows participants to draw and type simultaneously.
Index

Symbols

.atp files 168, 170
.csv files 186
.txt files 169, 170, 186
.ucf files
  converting documents automatically 116
  opening 90
  saving documents 90
  saving presentations 90
  saving whiteboards 90
.wrf files 99
  and PowerPoint presentations 97
  as standalone UCF media files 98
  overview 98
sharing in content viewer 97
  sharing standalone media files 99

A

adding
  pages to shared documents 76
  pointers to pages 86
  pointers to slides 86
  pointers to whiteboards 86
  slides to shared presentations 76
admitting participants
  to breakout sessions 215
alerts
  on panels 24
allowing, breakout sessions 204
animations
  in shared presentations 74
annotating
  using Highlighter tool 82
  using Text tool 83
  shared documents. See annotations, on shared documents
  shared presentations. See annotations, on shared documents
annotation color
  changing for shared document 83
  changing for shared presentation 83
  making visible on dark background 84
  making visible on light background 84
Annotation Color tool
  overview 64
annotation mode for shared software
  starting 142
  stopping 147
annotation tools
  for shared software, descriptions 143
  overview 11
annotation tools, for shared documents
  Annotation Color tool, overview 64
  Eraser tool, overview 64
  Highlighter tool, overview 64
  Line tool, overview 64
  Pointer tool, overview 64
  Rectangle tool, overview 64
  Text tool, overview 64
annotations, on shared documents
  clearing 84
  making 82
  making visible on dark background 84
  making visible on light background 84
  selecting color 83
  selecting font 84
annotations, on shared software
  changing color 145
  clearing 144
  letting attendees make 145
  making 142
  overview 142
  stopping 147
  stopping attendees from making 146
  taking screen capture 147
answering indicator
  answering in progress in Q & A 181
answering questions
  dismissing questions 182
  in Q & A 180
answering questions in Q & A
  overview 180
answering questions privately in Q & A 182
application sharing
  overview 120
  pausing and resuming 136
  starting 121
  stopping 123
See also application, shared application, shared
ensuring good imaging of color 151
showing multiple to attendees 122
showing to attendees 121
See also software, shared
archiving
Q & A sessions 185
asking to speak
in Integrated VoIP conference 56
in teleconference 48
assigning
questions 179
assigning questions
in Q & A 179
assistance
obtaining 227
overview 227
attendees
allowing to speak in Integrated VoIP conference 42
automatically letting control shared software automatically 149
inviting to teleconference 34
letting annotate shared software 145
letting control shared software 148
muting and unmuting microphones in Integrated VoIP conference 43
muting and unmuting microphones in teleconference 36
stopping from making annotations on shared software 146
stopping from remotely controlling shared software 149
audio
unable to hear in recorded UCF multimedia 114
audio files
sharing 97
sharing a Web content 156
sharing standalone UCF files 98, 99
Audio Setup Wizard for Integrated VoIP, using 53
audio, for Integrated VoIP
adjusting with Audio Setup Wizard 53
muting and unmuting 43
audio, for teleconference
muting and unmuting 36

B
backgrounds
annotating on dark 84
annotating on light 84
breakout session
request presenters share content 207
Breakout Session panel
overview 199
Breakout Session window
overview 198
breakout sessions
admitting more participants 215
allowing 204
asking participants to return from 207
Communicate menu 202
creating for another participant 206
Edit menu 200
ending 207, 218
ending Integrated VoIP conference 214
ending teleconference 214
File menu 200
granting privileges 203
leaving 212
letting participant control software 218
limiting number of participants 216
methods for starting 210
overview 197, 209
Participant menu 202
passing the presenter role to another participant 217
preventing participants from joining 216
removing a participant from 208
Share menu 201
sharing content in main session 219
starting Integrated VoIP conference 213
starting one created on your behalf 212
starting teleconference 214
using Integrated VoIP conferencing 212
using teleconferencing 212
View menu in 201
bringing application to front
on shared remote computer 135
browsers, Web
sharing 156

C
call-back teleconference
joining 46
managing, overview 33
starting 34
call-in numbers, global 46
call-in teleconference
joining 46
managing, overview 33
starting 34
chat
granting privileges 188
managing 187
chat messages
choosing sound alerts 30
checking system for UCF compatibility 5
clearing
all annotations on shared documents 84
all pointers on shared documents 87
annotations and pointers on shared software 144
feedback 195
selected annotations on shared documents 84
your annotations on shared documents 84
your pointers on shared documents 87
closing
panels 15
Q & A tabs 178
closing shared
documents 77
presentations 77
whiteboards 77
collapsing
panels 15
color in shared application, ensuring good imaging 151
color, annotation
changing on shared software 145
color, selecting for annotating
documents 83
presentations 83
whiteboards 83
Communicate menu
in breakout session 202
computer, setting up
Training Manager 3
contacting WebEx 228
control
content viewer
description 9
on Session window 9
resizing 18
synchronizing display for attendees 81
controlling
attendees’ views of shared software 136
full-screen view of shared software for attendees 138
controlling breakout sessions
overview 203
controlling full-screen view
shared documents 79
shared presentations 79
UCF media files 112
UCF Web pages 114
converting
documents to UCF 116
presentations to UCF 116
creating
breakout session for another participant 206
D
dark background,
anNOTATING on 84
deferring questions
in Q & A 183
desktop sharing
overview 125
pausing and resuming 136
starting 125
stopping 126
See also desktop, shared
desktop, shared
showing to attendees 125
See also software, shared
display, controlling full-screen view
shared pages 79
shared slides 79
shared whiteboards 79
displaying
hidden Q & A tab 178
document sharing
checking participant readiness 67
closing documents 69
navigating pages 72
starting 66
See also documents, shared
documents, shared
adding blank pages 76
advancing pages automatically 73
annotating 82
clearing pointers 87
closing in content viewer 77
controlling full-screen view 79
converting to UCF before meeting 116
displaying pages 72
navigating pages 72
overview 65
pasting images 76
playing back media files 97
printing pages 91
saving to file 90
synchronizing display for all attendees 81
types to share 65
using pointers 86
viewing thumbnails of pages 79
zooming in 78
zooming out 78

downloading
  Training Manager 1
  UCF media files to participants' computers 101
drawing annotations
  on shared documents 82
  on shared presentations 82

E

echo in phone
  during playback of UCF multimedia 114
Edit menu
  in breakout session 200
  editing
    properties of UCF media object 105
emoticons
  using in feedback 194
ending
  all breakout sessions 207
  breakout session 218
  Integrated VoIP conference 44
Eraser tool
  overview 64
erasing
  all annotations on shared documents 84
  all pointers on shared documents 87
  selected annotations on shared documents 84
  your annotations on shared documents 84
  your pointers on shared documents 87
exchanging files
  during training session 159
expanding
  panels 15
expelling
  participant from breakout session 208

F

fast forwarding
  UCF media file playback 110
feedback
  allowing participants to use 192
  clearing 195
  overview of 191
  providing 193
  using emoticons in 194
  viewing 193
File menu
  in breakout session 200
file size limits
  for sharing UCF media files 101
files
  .atp 168, 170
  .txt 169, 170
  .ucf (Universal Communications Format) for multimedia 90
  choosing sounds for alerts 30
  choosing sounds for participant actions 31
  exchanging during training session 159
  for poll questionnaire 168
  for poll questionnaires 170
  for poll results 169, 170
  stop publishing during training session 159
Flash files
  displaying Flash Player menu in 112
  guidelines for sharing 101
  in PowerPoint presentations 97
  sharing as standalone media files 98, 99
  sharing as Web content 156
Flash Player
  displaying menu when sharing Flash file 112
floating
  panels in full-screen view 20
font
  selecting for annotations 84
frame rate
  specifying for video 223
full-screen view
  and panels 19
  floating panels 20
  of shared software, controlling 138
  sharing 21
Full-Screen View tool
  overview 64
full-screen view, controlling for
  Flash files 112
  UCF recording 112
  video 112
full-screen view, controlling in
  shared document 79
  shared presentation 79
  shared whiteboard 79
  UCF Web pages 114

G

global call-in numbers 46
granting privileges
  to attendees 26
group results, for poll
  saving 169
H

hardware acceleration, turning off to record UCF multimedia 114
hidden Q & A tab
opening 178
hiding
contents of screen on shared remote computer 134
Highlighter tool
overview 64
high-resolution color in shared application ensuring good imaging 151
HTML document, sharing
embedded in presentation 97

I

images, pasting in shared documents 76
presentations 76
whiteboards 76
individual results, for poll saving 169
installer
for Training Manager 3
installing
Training Manager 3
Integrated VoIP conference
adjusting speaker and microphone volume 55
adjusting voice buffer length 55
asking to speak 56
Audio Setup Wizard, using 53
ending 44
ending in breakout sessions 214
joining 53
leaving 60
letting participants speak 42
managing, overview 39
microphone, using to speak 56
muting and unmuting participant’s microphone 43
muting and unmuting your microphone 55, 59
muting and unmuting your speakers 55
participating, overview 52
speaker queue, overview 42
starting 40
starting during breakout session 213
system requirements 52
inviting
participants to teleconference 34

J

joining
Integrated VoIP conference 53
teleconference 46

K

keyboard
disabling on shared remote computer 134
keyboard shortcuts
for full-screen playback of media file 112
keys, on keyboard
for full-screen playback of media file 112

L

leaving
breakout session 212
Integrated VoIP conference 60
teleconference 49
limiting participants
in breakout session 216
Line tool
overview 64
locking
shared remote computer 135

M

magnification, changing for shared pages 78
slides 78
whiteboards 78
managing
Integrated VoIP conference 39
teleconference 33
managing questions
overview 176
manual installer
Training Manager 3
media files, UCF
tips for sharing 102
media files, UCF, sharing troubleshooting 114
media players for UCF media files
checking if installed on computer 5
menu bar
overview 8
microphone
adjusting volume in Integrated VoIP conference 55
muting and unmuting for participant in Integrated VoIP conference 43
muting and unmuting for participant in teleconference 36
muting and unmuting your own in Integrated VoIP conference 55, 59
muting and unmuting your own in teleconference 47
passing to participant in Integrated VoIP conference 42
specifying setup for Integrated VoIP 53, 55
using Audio Setup Wizard to adjust for Integrated VoIP 53
using in Integrated VoIP conference 56
Microsoft PowerPoint presentations, shared
playing back media files 97
viewing slide titles 72
miniatures, viewing
of shared whiteboards 79
shared pages 79
shared slides 79
minimizing
panels 13
mouse
disableing on shared remote computer 134
moving to another location in a UCF media file 110
multimedia
sharing as Web content 156
muting
participant’s microphone in Integrated VoIP conference 43
participant’s microphone in teleconference 36
playback of UCF media files 111
speakers in Integrated VoIP conference 55
your microphone in Integrated VoIP conference 55, 59
your microphone in teleconference 47

N
navigating
shared pages 72
shared slides 72
shared whiteboards 72

O
opening
hidden Q & A tab 178
poll questionnaire file 170
poll results file 170
Q & A tabs 178
saved document 90

P
pages, of shared documents
adding new 76
adding pointers 86
annotating 82, 83
checking participant readiness 67
clearing annotations 84
clearing pointers 87
controlling full-screen view 79
displaying 72
navigating 72
pasting images 76
printing 91
selecting color for annotating 83
synchronizing display for all attendees 81
viewing miniatures (thumbnails) 79
zooming in 78
zooming out 78
panels
alerts 24
closing 15
collapsing 15
displaying in full-screen view 19
expanding 15
floating 20
in full-screen view 19
minimizing 13
minimizing all 14
overview 13
resetting 16
resizing 18
restoring 14
restoring all 14
setting options 16
participant actions
choosing sound alerts 31
Participant menu
in breakout session 202
participants
  allowing to speak in Integrated VoIP conference 42
  inviting to teleconference 34
muting and unmuting microphones in Integrated VoIP 43
muting and unmuting microphones in teleconference 36
Participants Ready indicator 67
pasting
  images in content viewer 76
pausing
  playback of UCF media files 108
  software sharing 136
performance, optimizing for UCF multimedia sharing 114
pictures, pasting in shared
  document 76
  presentation 76
  whiteboard 76
playback
  controlling UCF media files 107
  pausing UCF media files 108
Pointer tool
  overview 64
pointers
  clearing on shared software 144
pointers, adding to
  shared document 86
  shared presentation 86
  shared whiteboard 86
pointers, clearing from
  shared document 87
  shared presentation 87
  shared whiteboard 87
poll
  opening 166
poll questionnaire
  preparing 162
poll questionnaire and results
  save, open 168
poll questionnaires
  opening file for 170
  preparing 162
  presenting to attendees 166
  saving 168
poll results
  opening file for 170
  saving 169
  share with attendees 167
  sharing results with attendees 167
view 167
polls
  introduction to 161
  taking 166
  presentation sharing
    closing presentations 69
    navigating slides 72
    starting 66
    See also presentations, shared
presentations, shared
  adding blank slides 76
  annotating 82
  clearing pointers 87
  closing in content viewer 77
  controlling full-screen view 79
  converting to UCF before meeting 116
  displaying slides 72
  navigating slides 72
  pasting images 76
  playing back media files 97
  printing slides 91
  saving to file 90
  slide animations 65
  slide transitions 65
  synchronizing display for all attendees 81
  using animations 74
  using pointers 86
  using slide transitions 74
  viewing thumbnails of slides 79
  zooming in 78
  zooming out 78
printing
  pages in shared documents 91
  shared whiteboards 91
  slides in shared presentations 91
private answers
  sending in Q & A 182
privileges
  annotating shared documents 27
  chatting privately 27
  chatting with all attendees 27
  displaying thumbnails of pages 27
  granting for breakout sessions 203
  granting for training session 26
  joining breakout sessions 27
  printing shared documents 27
  recording the session 27
  saving shared documents 27
  sharing documents 27
  viewing any document 27
  viewing any page 27
  viewing attendee list 27
properties, viewing for UCF media object 105
publishing files
  for downloading during training session 159
Q & A

answering questions 180
answering questions privately 182
assigning questions 179
deferring questions 183
dismissing questions 182
in-progress indicator 181
Q & A file
saving changes to 186
Q & A option
turning off, disallowing 174
turning on, allowing 174
Q & A sessions
overview 173
saving, archiving 185
Q & A tabs
closing 178
opening 178
using, overview 177
questionnaire
changing type, editing, rearranging, deleting 164
compose, prepare 162
delete 165
questions
assigning 179
deferring 183
dismissing 182
overview of managing 176

R

Rectangle tool
overview 64
reducing view
of shared pages or slides 78
of shared whiteboards 78
remote computer sharing
overview 128
starting 129
stopping 131
remote computer, shared
bringing application to the front 135
disabling and enabling keyboard and mouse on 134
hiding contents of screen 134
locking and unlocking 135
logging in to and out from 135
managing, overview 132
reducing screen resolution 133
selecting additional applications 130
showing to attendees 129
remote control, of shared software
granting to an attendee 148
letting attendees perform automatically 149
overview of 148
stopping 149
remote control, of software
granting to participant in breakout session 218
removing
Training Manager 4
resetting
panels
  returning to default settings 16
resizing
content viewer 18
panels 18
resolution
adjusting video image 223
restoring
panels 14
results, for poll
  opening 170
  saving 169
resuming
software sharing 136
returning
to Session window while sharing software 140
rewinding a UCF media file during playback 110

S

saved Q & A files
opening 186
saved Q & A session
saving another copy 186
saving
annotations on shared software 147
documents to UCF 116
documents, shared 90
poll questionnaires 168
poll results 169
presentations to UCF 116
presentations, shared 90
Q & A sessions 185
shared documents 90
shared presentations 90
shared whiteboards 90
whiteboards, shared 90
saving changes
to saved Q & A file 186
saving copy
doing 186
screen capture
  taking of annotations on shared software 147
screen resolution
  reducing for shared remote computer 133
Session window
  content viewer 9
  displaying while sharing software 140
setting
  options for panels 16
  video options 223
setting up
  Training Manager 3
Share menu
  in breakout session 201
shared remote computer. See remote computer, shared.
sharing
  breakout session content in main session 219
  Flash files, as Web content 156
  in full-screen view 21
  poll results with attendees 167
  streaming audio, as Web content 156
  streaming video, as Web content 156
  tools in content viewer 9
  Web browsers 156
  Web content, overview 155
sharing a desktop. See desktop sharing.
sharing a remote computer. See remote computer sharing.
sharing a Web browser. See Web browser sharing.
sharing applications. See application sharing.
sharing desktops. See desktop sharing.
sharing window
  returning attendees to while sharing software 141
slide titles
  viewing while sharing 72
slides, in shared presentations
  adding 76
  adding pointers 86
  annotating 82, 83
  checking participant readiness 67
  clearing annotations 84
  clearing pointers 87
  controlling full-screen view 79
  displaying 72
  navigating 72
  pasting images 76
  playing back media files 97
  printing 91
  selecting annotation color 83
  synchronizing display for attendees 81
  viewing miniatures (thumbnails) 79
  viewing title 72
zooming in 78
zooming out 78
software sharing
  overview 119
  tips for improving performance 152
See also software, shared
software, shared
  allowing remote control 148, 149
  annotating 142
  changing annotation color 145
  clearing annotations and pointers 144
  controlling attendees' views 136
  controlling full-screen view 138
  enhancing performance for graphics-intensive applications 150
  ensuring good imaging of color 151
  improving performance 152
  letting attendees annotate 145
  pausing and resuming 136
  returning to from Session window 141
  specifying display mode 150
  stopping annotation mode 147
  stopping attendees from annotating 146
  stopping remote control 149
  using annotation tools 143
solving problems with UCF media files 114
sound alerts
  assigning to chat messages 30
  assigning to participant actions 31
  overview 29
sounds
  muting in shared UCF media files 111
  unmuting in shared UCF media 111
speaker queue, for Integrated VoIP conference 42
speaker, in teleconference
  determining 48
speakers
  adjusting volume in Integrated VoIP conference 55
  specifying setup for Integrated VoIP 53, 55
  using Audio Setup Wizard to adjust for Integrated VoIP 53
Standard View tool
  overview 64
starting
  annotation mode for shared software 142
  application sharing 121
  breakout sessions 210
  desktop sharing 125
  document sharing 66
  Integrated VoIP conference 40
  playback of UCF media files 108
  presentation sharing 66
  remote computer sharing 129
teleconference 34
Web browser sharing 127
whiteboard sharing 70
stopping
  annotation mode for shared software 147
  application sharing 123
breakout session 218
desktop sharing 126
playback of UCF media files 109
publishing files during training session 159
remote computer sharing 131
Web browser sharing 127
whiteboard sharing 71
streaming audio
  in shared UCF media files 101
  sharing as Web content 156
streaming video
  in shared UCF media files 101
  sharing as Web content 156
support
  obtaining 228
  overview 227
Support page
  accessing 228
  support, obtaining 227
Synchronize Displays for All tool
  overview 64
synchronizing
  attendees’ content viewers 81
  checking status for shared UCF media 104
system requirements
  Integrated VoIP 52
  Training Manager 2

T

technical support, obtaining 227
teleconference
  asking to speak 48
  determining who is speaking 48
  ending in breakout sessions 214
  inviting participants 34
  joining 46
  leaving 49
  managing, overview 33
  muting and unmuting participant’s microphone 36
  muting and unmuting your microphone 47
  participating, overview 45
  starting 34
  starting during breakout session 214
Text tool
  overview 64
typing annotations 83
thumbnails, viewing
  shared documents 79
  shared presentations 79
  shared whiteboards 79
timer
  display 165
tips
  for sharing software effectively 152
  for sharing UCF media files 102
titles of slides
  viewing while sharing 72
Tools panel
  for shared software, descriptions of tools 143
Training Manager
  setting up 1, 2, 3
  system requirements 2
  uninstalling 4
training service
  setting up Training Manager 2
  setting up Training Manager, overview 1
training sessions
  granting privileges 26
  transferring files
    during training session 159
  transitions
    in shared presentations 74
troubleshooting UCF
  audio echoes in earphones 114
  Flash file displays poorly 114
  recording shared UCF presentation fails 114
  recording video in UCF file fails 114
  volume stays muted 114
True Color mode, enabling for application sharing 151
two 51
typing annotations on shared
documents 83
presentations 83
whiteboards 83

U

UCF
  checking system compatibility 5
UCF media files
  converting documents before meeting 116
  converting presentations before meeting 116
determining participant readiness 103
determining synchronization status of participants for 104
full-screen playback 112
full-screen view 114
guidelines for sharing 101
moving to another location in 110
muting sound 111
not appearing in shared presentation 114
pausing playback 108
sharing in meetings 97, 99
sharing standalone 98
solving common problems 114
starting playback 108
stopping playback 109
tips for sharing 102
unmuting sounds 111
verifying that your computer can play 5
UCF media objects
  viewing properties of 105
UCF multimedia presentations
  media files not appearing in when shared 114
  overview 97
  tips for sharing 102
UCF problems
  audio echoes in earphones 114
  Flash file displays poorly 114
  participants cannot share UCF presentation 114
  recording shared UCF presentation fails 114
  recording video in UCF file fails 114
  synchronization among participants 114
  too long to download 114
  volume stays muted 114
UCF Web pages
  controlling full-screen display 114
  displaying new page while sharing 113
uninstalling
  Training Manager 4
Universal Communications Toolkit
  for creating UCF multimedia presentations 97
  using to set properties in UCF object 105
unlocking
  shared remote computer 135
unmuting
  participant’s microphone in Integrated VoIP conference 43
  participant’s microphone in teleconference 36
  playback of UCF media files 111
  speakers in Integrated VoIP conference 55
  your microphone in Integrated VoIP conference 55, 59
  your microphone in teleconference 47
using Q & A tabs
  overview 177

V

video

adjusting quality while sending 223
not appearing in recorded UCF multimedia 114
options, setting 223
overview 221
sending 221
setting up 221
specifying frame rate 223
specifying which camera to use 223
video camera
  connecting to computer 221
  supported models 221
video files
  sharing a Web content 156
  sharing in content viewer 98, 99
View menu
  in a breakout session 201
View Thumbnails tool
  overview 64
view tools
  Full-Screen View tool, overview 64
  Standard View tool, overview 64
  Synchronize Displays for All tool, overview 64
  View Thumbnails tool, overview 64
  Zoom In/Zoom Out tool, overview 64
viewing
  properties of shared UCF object 105
  viewing miniatures of shared documents 79
  presentations 79
  whiteboards 79
voice buffer length, adjusting for Integrated VoIP 55
volume
  adjusting for UCF playback 110
  muting for UCF files 111
  unmuting for UCF files 111

W

Web browser plug-in
  for training services 3
Web browser sharing
  differences to Web content sharing 156
  overview of 127
  pausing and resuming 136
  starting 127
  stopping 127
  See also Web browser, shared
Web browser, shared
  showing to attendees 127
  See also software, shared
Web content sharing
  overview 155
Web pages
  sharing in presentation 97
WebEx Document Manager 90
whiteboards, shared
  adding pointers 86
  clearing pointers 87
  closing 77
  controlling full-screen view 79
  displaying 72
  drawing annotations 82
  navigating 72
  pasting images 76
  printing 91
  saving to file 90
  synchronizing display for attendees 81
  viewing miniatures (thumbnails) 79

zooming in 78
zooming out 78

Z

Zoom In/Zoom Out tool
  overview 64
  zooming in, on shared
    pages 78
    slides 78
    whiteboards 78
  zooming out, on shared
    pages 78
    slides 78
    whiteboards 78